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Sun Identity Manager 8.1 Release Notes

These Release Notes contain important information that describes the new features and
enhancements provided in SunTM Identity Manager 8.1 (Identity Manager). Read this document
before you begin using Identity Manager 8.1.

These Release Notes do not describe the Identity Manager 8.0 release. See the Identity Manager
8.0 Release Notes on http://docs.sun.com/ for detailed information about supported
applications servers, databases, resources, and other features of that release.

Related Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related information.

Note – Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content, advertising,
products, or other materials that are available on or through such sites or resources. Sun will not
be responsible or liable for any actual or alleged damage or loss caused or alleged to be caused by
or in connection with use of or reliance on any such content, goods, or services that are available
on or through such sites or resources.

Documentation, Support, and Training
The Sun web site provides information about the following additional resources:

■ Documentation (http://www.sun.com/documentation/)
■ Support (http://www.sun.com/support/)
■ Training (http://www.sun.com/training/)

1C H A P T E R 1
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Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Feedback.

Sun Welcomes Your Comments
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Introduction

This section of the SunTM Identity Manager 8.1 Release Notes is organized as follows:

■ “Announcements” on page 9
■ “Supported Software and Environments” on page 9
■ “Upgrade Paths and Support Policies” on page 23
■ “Redistributable Files” on page 26
■ “How to Report Problems and Provide Feedback” on page 26

Announcements
■ The end-of-life for Sun JavaTM System Identity Manager 7.0, 7.1, and 7.1.1 will be May 15,

2010. The last ship date will be May 15, 2009.
For more information, see “End of Service Life for Software Support” on page 25.

Supported Software and Environments
This section lists software and environments that are compatible with Identity product
software:

■ “Operating Systems” on page 10
■ “Java Support” on page 10
■ “System Virtualization Support” on page 10
■ “Application Servers” on page 11
■ “Repository Database Servers” on page 12
■ “Sun Identity Manager Gateway” on page 13
■ “Supported Resources” on page 13
■ “Browsers” on page 17
■ “Deprecated Identity Manager Features” on page 18
■ “Discontinued Software” on page 19

2C H A P T E R 2
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■ “API Support” on page 22
■ “Deprecated APIs” on page 23

Note – Because software product developers frequently ship new versions, updates, and fixes to
their software, the information published here changes often. Review the release notes for
updates before proceeding with installation.

Operating Systems
This release of Identity Manager supports the following operating systems:

■ AIX 5.2, 5L v5.3
■ HP-UX 11i v1, 11i v2
■ Microsoft Windows 2000 SP3, 2000 SP4
■ Microsoft Windows Server 2003, 2008

Note – If you are running a 64–bit version of Windows 2008, you must use JDKTM Version 6
Update 12 and later.

■ OpenSolarisTM 2008.5, 2008.11
■ SolarisTM 9, 10 SPARC and x86
■ Red Hat Linux Advanced Server 2.1
■ Red Hat Linux Enterprise Server 3.x, 4.x, 5
■ Novell SuSE Linux Enterprise Server 9 SP1, 10

Java Support
Identity Manager requires Java Platform, Standard Edition (SE) 5 or higher.

System Virtualization Support
System virtualization is a technology that enables multiple operating system (OS) instances to
execute independently on shared hardware. Functionally, software deployed to an OS hosted in
a virtualized environment is generally unaware that the underlying platform has been
virtualized. Sun performs testing of its Sun Java System products on select system virtualization
and OS combinations to help validate that the Sun Java System products continue to function
on properly sized and configured virtualized environments as they do on non-virtualized

Supported Software and Environments
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systems. For information about Sun support for Sun products in virtualized environments, see
“System Virtualization Support in Sun Java System Products.”

Caution – Do not host the Identity Manager repository on a virtual system because performance
(transactions per second) will be hindered significantly.

Application Servers
The application server you use with Identity Manager must be Servlet 2.2-compliant and
installed with the included Java platform (unless noted as follows). Identity Manager requires
Java SE Development Kit (JDK) 5 or 6 on the following application servers, if the application
server supports these versions.

■ Apache Tomcat 5.5.x, 6.0.x
■ BEA WebLogic Server 9.1, 9.2, 10
■ IBM WebSphere 6.1
■ JBoss Application Server 4.2
■ Oracle® Application Server Enterprise Edition 10g Release 3 (10.1.3)
■ Oracle Application Server Standard Edition 10g Release 3 (10.1.3)
■ Sun JavaTM System Application Server 9.1 (GlassFishTM v2 UR1, v2 UR2, v2.1 32-bit and

64-bit)
■ Sun Java System Application Server Platform Edition 8.1, 8.2, 9.0
■ Sun Java System Application Server Enterprise Edition 8.1, 8.2
■ Sun Java System Application Server Standard Edition 8.2

Note –

■ If your current application server does not support JDK 5, please check with your vendor to
examine the implications of upgrading to one that does before installing Identity Manager.

■ Identity Manager requires a JDK that correctly handles the 2007 adjustments to U.S.
Daylight Savings Time (DST). You must install any relevant DST patches for the JDK
version you are using. For Sun JDK 5, Update 15 contains the necessary DST fixes. All
versions of Sun JDK 6 contain the necessary DST fixes.

■ You can run Identity Manager on BEA WebLogic application servers with all
WebLogic-supported 5 JDKs.

Supported Software and Environments
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Repository Database Servers
Identity Manager supports the following repository database servers:

■ IBM DB2 Universal Database for Linux, UNIX®, and Windows (Version 8.1, 8.2, 9.1 using a
type 4 driver, 9.5 using a type 4 driver)

■ Microsoft SQL Server 2005, 2008
■ MySQL EnterpriseTM Server 5.0.60 SP1, 5.1.30

Note –

■ If you use MySQL Enterprise Server 5.1.30 as your Identity Manager repository, you
might need to change to your my.cnf file. Due to recent changes in MySQL's InnoDB
code, the default binary logging format is now STATEMENT. Identity Manager uses a
READ-COMMITTED transaction isolation level, so binary logging in STATEMENT mode
produces an error similar to the following: (ID-20460).

com.waveset.util.IOException:

java.sql.SQLException: Binary logging not possible. Message: Transaction level

’READ-COMMITTED’ in InnoDB is not safe for binlog mode ’STATEMENT’

If you enable binary logging, set the mode to MIXED by adding the following line to your
my.cnf file:

binlog_format=mixed

With this configuration change, you can use 5.1.30 as your repository without the binary
logging exception. For more details, see MySQL bug #40360.

■ Identity Manager supports MySQL Enterprise Server 5.0.60 SP1 and 5.1.30 as a
repository database in both development and production deployments. All other
MySQL versions are only supported in a development deployment.

■ Identity Manager only supports SQL Server 2008 using SQL Server 2005 JDBC drivers.
SQL Server 2008 does not work with SQL Server 2000 drivers, and the SQL Server 2008
JDBC drivers are currently not released.

■ Microsoft JDBC Version 1.2 drivers have Java assertions in the methods that connect to
different database servers. These drivers assert Java when connecting to SQL Server 2000
if you enable Java assertions in the com.microsoft.sqlserver.jdbc package.

■ Oracle Database 9i, 10g Release 1, 10g Release 2, and 11g

Supported Software and Environments
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Note – Oracle RAC (Real Application Cluster) is supported in a two-node active-passive
configuration. That is, a configuration where the active_instance_count parameter is set
to 1. Used in conjunction with connection failover for the JDBCTM driver, this configuration
provides failover capability for the repository. (Refer to the Oracle documentation for
instructions about how to configure this database server in your environment)

Oracle RAC is not currently supported in any other configuration.

Caution – If you are using an Oracle repository, the Identity Manager 8.0 repository DDL uses
data types that are not properly handled by older Oracle JDBC drivers. The JDBC drivers in
ojdbc14.jar do not properly read all of the columns in the log table.

You must upgrade to the Oracle JDBC drivers for JDK 5 drivers for Identity Manager to
work properly.

Sun Identity Manager Gateway
If you plan to set up Windows Active Directory, Novell NetWare, Remedy, Lotus Notes
(Domino) or RSA ACE/Server resources, you must install the Sun Identity Manager Gateway.

Supported Resources
Identity Manager software supports these resources:

■ “Customer Relationship Management (CRM)” on page 13
■ “Databases” on page 14
■ “Directories” on page 14
■ “Enterprise Resource Planning (ERP)” on page 15
■ “Help Desk” on page 15
■ “Message Platforms” on page 15
■ “Miscellaneous” on page 16
■ “Operating Systems” on page 16
■ “Role Management System” on page 17
■ “Security Managers” on page 17
■ “Web Access Control” on page 17

Customer Relationship Management (CRM)
■ Siebel version 7.0.4, 7.7, 7.8, 8.0 CRM software

Supported Software and Environments
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Databases
■ Generic database table
■ IBM DB2 Universal Database for Linux, UNIX, and Windows 8.1, 8.2, 9.1 using a type 4

driver, 9.5 using a type 4 driver
■ Microsoft Identity Integration Server (MIIS) 2003
■ Microsoft SQL Server 2000, 2005, 2008

Note –

■ Identity Manager only supports SQL Server 2008 using SQL Server 2005 JDBC drivers.
SQL Server 2008 does not work with SQL Server 2000 drivers.

■ Microsoft JDBC Version 1.2 drivers have Java assertions in the methods that connect to
different database servers. These drivers assert Java when connecting to SQL Server 2000
if you enable Java assertions in the com.microsoft.sqlserver.jdbc package.

■ MySQLTM 4.x, 5.0, 5.1

Note – Identity Manager supports MySQL as a development and production database.

■ Oracle Database 9i, 10g Release 1, 10g Release 2, 11g
■ Sybase Adaptive Server 12.x
■ Scripted JDBC (manages resources using JDBC 3.0 drivers or later)

Directories
■ LDAP v3
■ RACF LDAP
■ Microsoft® Active Directory® 2000, 2003, 2008
■ Microsoft Active Directory Application Mode (ADAM) Windows 2003 SP1 and later
■ Novell® eDirectory 8.7.1, 8.8
■ Novell NetWare® 6.5
■ Open LDAP
■ Sun ONE Directory Server 4.x
■ Sun Java System Directory Server 5 (2004Q2, 2005Q1), 6.3

Supported Software and Environments
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Note –

■ While Identity Manager is tested on Open LDAP and Sun Java System Directory Server,
LDAP servers that are v3-compliant may work without any changes to the resource adapter.

■ Sun Java System Directory Server 5 2005Q1 requires a patch to the Directory Server retro
changelog plugin if you are using Active Sync. This patch is required for “regular”
replication only (not for MMR replication).

Enterprise Resource Planning (ERP)
■ MySAP ERP 2005 (ECC 6.0) Kernel version 7.00
■ Oracle E-Business Suite on Oracle Applications 11.5.9, 11.5.10, 12
■ Peoplesoft PeopleTools 8.1 through 8.4.2
■ Peoplesoft PeopleTools HRMS 8.0 through 8.8, 9.0
■ SAP R/3 Enterprise 4.7 (SAP BASIS 6.20)
■ SAP NetWeaver Enterprise Portal 2004 (SAP BASIS 6.40), 2004s (SAP BASIS 7.00)
■ SAP Governance, Risk, and Compliance (GRC) Access Enforcer 5.1, 5.2

Help Desk
■ BMC Remedy Action Request System Server 6.0, 6.3, 7.0
■ BMC Remedy Service Desk Application 7.0
■ Remedy Help Desk 6.0

Note – Many substantial differences between Help Desk 6.0 and Service Desk 7.0 exist in terms of
their sample data, defaults, and out-of-the-box configuration. For example, the name of the
“ticket” schema in Help Desk 6.0 is HPD:HelpDesk, while in Service Desk 7.0 it has been
changed to HPD:Help Desk. Developers should consult the Remedy product documentation for
details when upgrading.

Message Platforms
■ Sun Java System Messaging and Calender Service Java Enterprise System 2005Q1 and later
■ Lotus Notes (Domino) 6.5, 7.0, 8.0
■ Microsoft Exchange 2000, 2003, 2007

Supported Software and Environments

Chapter 2 • Introduction 15



Note –

■ Microsoft Exchange 2000, 2003, and 2007 are managed through the Active Directory
resource adapter.

■ Microsoft Exchange 2007 is supported on Windows 2003 only.

■ Novell GroupWise 7.0 (using the Novell NDS adapter)

Miscellaneous
■ Flat files
■ JMS Message Queue Listener (manages any JMS 1.0b or later compliant queue)
■ Generic UNIX Shell Script

Note – The Generic UNIX Shell Script adapter runs scripts in supported shell types on
supported UNIX operating systems.

■ Generic Windows Script Adapter

Note – The Generic Windows Script adapter runs scripts in the cmd shell on supported
Windows operating systems that host the Sun Identity Manager Gateway.

■ Microsoft Identity Integration Server (MIIS) 2003

Operating Systems
■ HP OpenVMS 7.2, 8.3
■ HP-UX 11.0, 11i v1, 11i v2
■ IBM AIX 4.3.3, 5.2, 5L, 5.3
■ IBM OS/400 V4r3, V4r5, V5r1, V5r2, V5r3, V5r4
■ Microsoft Windows 2000, 2003, 2008
■ Red Hat Linux 9.0
■ Red Hat Linux Advanced Server 2.1
■ Red Hat Linux Enterprise Server 3.0, 4.0, 5
■ Sun SolarisTM 9, 10

Supported Software and Environments
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Note – If you manage NIS accounts on Solaris, install patch 126632-01 on the resource to
improve the performance of the logins command and the Solaris adapter.

■ OpenSolaris 2008.5, 2008.11
■ SuSE Enterprise 9, 10

Role Management System
■ BridgeStream SmartRoles 2.7

Security Managers
■ eTrust CA-ACF2 Security
■ eTrust CA-Top Secret Security
■ IBM RACF
■ INISafe Nexess 1.1.5
■ RSA ClearTrust 5.5.2, 5.5.3
■ RSA SecurID 5.0, 6.0, 6.1.2
■ RSA SecurID for UNIX 5.1, 6.0, 6.1.2
■ Scripted Host

Web Access Control
■ IBM Tivoli Access Manager 4.x, 5.1, 6.0.0 FP09, 6.1
■ Netegrity Siteminder 5.5, 6.0
■ RSA ClearTrust, 5.5.2, 5.5.3
■ Sun ONE Identity Server 6.1, 6.2
■ Sun Java System Identity Server 2004Q2
■ Sun Java System Access Manager 6 2005Q1, 7 2005Q4 (Realms supported as of 2005Q4), 7.1
■ Sun OpenSSO Enterprise 8.0 using Sun Access Manager Realm resource adapter

Browsers
Identity Manager supports the following browsers:

■ Microsoft Internet Explorer 6.x, 7.x
■ Safari 2.0 and later for Mac OS X 10.3.3 and later, 3.0.x
■ Firefox 1.04, 1.05, 1.06, 1.5, 2.0.0.4, 3.0
■ MozillaTM 1.78s

Supported Software and Environments
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Deprecated Identity Manager Features
The following Identity Manager features are deprecated. Support for these features will
continue until the next major release of Identity Manager. Please contact your Customer Care
representative or Customer Support if you have questions.

■ Business Process Editor (BPE) is deprecated, and will be removed in the next major release
of Identity Manager. Please use the Sun Identity Manager Integrated Development
Environment(Identity Manager IDE) instead. (ID-17693)

■ MetaView has been removed from new installations of Identity Manager. Customers who
are using MetaView in a pre-8.0 version of Identity Manager will be able to continue using it.
Please contact your Customer Care representative or Customer Support if you have
questions. (ID-17244)

■ Request Resource type is deprecated, in favor of External Resources. You can no longer
create new connections using the Request adapter. Use the External Resource adapter
instead. For information about using the new External Resources feature, see
“Understanding and Managing External Resources” in Sun Identity Manager 8.1 Business
Administrator’s Guide. (ID-20080)

■ SAPResourceAdapter built with JC0 2.1.8 is deprecated with this Identity Manager Version
8.1 release. SAP announced a new SAP Java Connector, (SAP JCo), API, JCo 3.0.

Note – See SAP note 1077727: SAP JCo 3.0 release and support strategy.
(Note date: 2008/11/18). Reason and Prerequisites: SAP JCo 3.0 is replacing SAP JCo 2.0
and SAP JCo 2.1 and is released for Java 5. Note that SAP JCo 3.0 is incompatible with
former versions of SAP JCo. For details and migration instructions read the SAP JCo 3.0
documentation.

The JCo 3.0 adapter is incompatible with former versions of SAP JCo and requires a
minimum JVM version of 1.5. JCo 2.1.8 is only supported for use with JVM 1.4.2, and SAP
has not officially announced support for JCo 2.1.8/JVM 1.5. Due to this constraint, the
default SAPResourceAdapter that was built using JCo 2.1.8, is deprecated with this Identity
Manager Version 8.1 release.

A new default SAPResourceAdapter is planned for the Identity Manager Version 9.0 release.
This new adapter will be built against SAP JCo 3.0 or higher and will adhere to Identity
Manager's minimum JVM requirements, such as JVM 1.5. In addition, this new SAP JCo 3.0
adapter will be added to upcoming patch releases for both Identity Manager 8.0 and Identity
Manager 8.1. Identity Manager 8.0 and Identity Manager 8.1 patches will continue to ship
the default SAP JCo 2.1.8 adapter (SAPResourceAdapter).

Supported Software and Environments
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Discontinued Software
Identity Manager operating systems, application servers, database repositories and managed
resources included in the following tables are deprecated.

Next Major Identity Manager Release
Identity Manager will continue support of deprecated software in the following table until the
next major Identity Manager release. Please contact your Customer Care representative or
Customer Support if you have questions about moving to newer versions of these software
packages.

TABLE 2–1 Deprecated Software and Environments

Software Category Software Package

Operating Systems ■ Red Hat Linux Advanced Server 2.1, 3.0
■ Red Hat Linux Enterprise Server
■ Solaris 8
■ Windows 2000 SP3, 2000 SP4

Application Servers ■ JBoss Application Server 4.0.x
■ Sun Java System Application Server Platform Edition 8.0

Repository Database Servers ■ Oracle 9i

Supported Software and Environments
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TABLE 2–1 Deprecated Software and Environments (Continued)
Software Category Software Package

Resources ■ BridgeStream SmartRoles
■ HP OpenVMS 7.2
■ IBM AIX 4.3.3
■ IBM Tivoli Access Manager 4.x
■ INISafe Nexess
■ Microsoft Active Directory 2000
■ Microsoft Exchange 2000
■ Microsoft SQL Server 2000
■ Microsoft Windows Server 2000
■ MySQL 4.x
■ Lotus Notes 6.5
■ Oracle 9i
■ Red Hat Linux Enterprise Server
■ SAP Governance, Risk and Compliance Access Enforcer 5.1
■ SAPResourceAdapter built with SAP JCo 2.1.8
■ SecurID 5.0, 5.1
■ Siebel 7.0.4
■ Solaris 8
■ Sun Access Manager 6 (2005Q1)
■ Sun Java System Identity Server 2004Q2
■ Sun ONE Identity Server 6.1, 6.2
■ Sun ONE Directory Server 4.x
■ Windows 2000 SP3, 2000 SP4

Browsers ■ Firefox 1.0.x
■ Mozilla

Identity Manager 8.1
Identity Manager 8.1 does not support the following discontinued software packages:

TABLE 2–2 Software and Environments Discontinued in Identity Manager 8.1

Software Category Software Package

Operating Systems ■ IBM AIX 4.3.3
■ Solaris 7

Supported Software and Environments
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TABLE 2–2 Software and Environments Discontinued in Identity Manager 8.1 (Continued)
Software Category Software Package

Application Servers ■ Apache Tomcat 4.1.x, 5.0.x
■ BEA Weblogic Express 7, 8.1
■ BEA Weblogic Server 7, 8.1
■ IBM Websphere Application Server - Express Version 5.1.1
■ IBM Websphere 4, 4.5, 5, 6.0
■ iPlanet 6.5
■ Sun ONE Application Server 7

Repository Database Servers ■ IBM DB2 Universal Database for Linux, UNIX, and Windows 7.x
■ Microsoft SQL 2000
■ MySQL 4.1
■ Oracle 8i
■ SQL Server 2000

Resources ■ ActivCard 5.0

■ Blackberry RIM Enterprise Server 4+ (uses generic Windows script
adapter) and Blackberry Enterprise Server scripts

■ IBM DB2 7.x

■ Lotus Notes (Domino) 5.0, 6.0.x

■ Microsoft Exchange 5.5

■ Microsoft Windows NT 4.0

■ MySQL 4.1

■ Natural

■ Novell GroupWise 5.x, 6.0, 6.5

■ Novell eDirectory on Novell NetWare 5.1, 6.0

■ Oracle 8i (through the Oracle resource adapter)

■ Red Hat Linux 8.0

■ Remedy Help Desk 4.5, 5.0

■ SAP R/3 v4.5, v4.6

■ Siebel 6.2

■ Sun Identity Manager Gateway running on Microsoft Windows NT 4.0

■ Sun ONE Identity Server 6.0

Browsers ■ Internet Explorer 5.x
■ Safari 1.2.1+

Supported Software and Environments
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API Support
The Identity Manager 8.1 Application Programming Interface (API) includes any public class
(and any public or protected method or field of a public class) listed in the following table.

Note – The com.waveset.object.RepositoryProxy is intended for internal use only.

API Type Class Names

Session com.waveset.msgcat.*

com.waveset.util.*

com.waveset.object.*

com.waveset.exception.*

com.waveset.expression.*

com.waveset.config.*

com.waveset.session.SessionUtil

com.waveset.session.ScriptSession

com.waveset.session.SessionFactory

com.waveset.session.Session

com.waveset.session.UserViewConstants

Adapter com.waveset.adapter.*

com.waveset.util.Trace

Policy com.waveset.policy.PolicyImplementation

com.waveset.policy.StringQualityPolicy

Report com.waveset.report.BaseReportTask

Task com.waveset.task.Executor

com.waveset.task.TaskContext

UI com.waveset.ui.FormUtil

com.waveset.ui.util.RequestState

com.waveset.ui.util.html.*

Supported Software and Environments

Sun Identity Manager 8.1 Release Notes •22



API Type Class Names

Workflow com.waveset.provision.WorkflowServices

com.waveset.session.WorkflowServices

com.waveset.workflow.WorkflowApplication

com.waveset.workflow.WorkflowContext

Sun Identity Manager Service Provider additionally includes the public classes listed in the
following table.

API Type Class Names

SPE com.sun.idm.idmx.api.*

com.sun.idm.idmx.txn.TransactionPersistentStore

com.sun.idm.idmx.txn.TransactionQuery

com.sun.idm.idmx.txn.TransactionSummary

These classes are the only classes that are officially supported. If you are using classes that do not
appear in these tables, contact Customer Support to determine whether you will be required to
migrate to a supported class.

Deprecated APIs
The Chapter 6, “Deprecated APIs,” section in these Release Notes lists all Identity Manager
Application Programming Interfaces (APIs) deprecated in this release and their replacements
(if available).

Upgrade Paths and Support Policies
This section provides information about the upgrade paths you should follow when upgrading
Identity Manager, and describes Identity Manager’s End of Service Life (EOSL) policy for the
products software support.

Identity Manager Upgrade Paths
Use the following to determine the upgrade path you must follow when upgrading to a newer
version of Identity Manager.

Upgrade Paths and Support Policies
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Note – Upgrading to the latest version of Identity Manager is recommended. When you upgrade
to the latest software release, you get the latest new features, bug fixes, and supported resource
versions.

Current Identity Manager Version

Target Identity Manager Version

7.0 7.1 7.1 Update 1 8.0 8.1

2005Q4M3 (6.0) 7.0 7.1 7.1 > 7.1 Update 1 7.1 > 8.0 7.1 > 8.1

Identity Manager 7.0 7.1 7.1 > 7.1 Update 1 8.0 8.1

Identity Manager 7.1 7.1 Update 1 8.0 8.1

Identity Manager 7.1.1 8.0 8.1

Identity Manager 8.0 8.1

Note –

■ When upgrading Identity Manager, you do not have to install Updates (formerly called
Service Packs or SPs) within a major release to upgrade to the next major release. For
example, when upgrading from Identity Manager 5.0 to 6.0, you do not have to install any of
the 5.0 Service Packs.

■ Updates for a major release are cumulative. After upgrading to the major release, you can
install the latest Update without having to install all of the Updates (or Service Packs) for
that release. For example, if you upgraded to Identity Manager 5.0, installing SP6 gives you
all of the functionality provided in SP1 through SP5.

■ Identity Manager Installation Pack 2005Q4M3 (version 6.0) was a major release. If you are
upgrading from a pre-6.0 version of Identity Manager, Identity Auditor, or Identity
ManagerService Provider, you must upgrade to Identity Manager Installation Pack
2005Q4M3 before advancing to later releases.

Updates to the Identity Manager documentation are provided as follows:

■ For Every release (including Service Packs): Release Notes are provided to describe bug
fixes, product enhancements, new functionality, and other important information.

■ For Major releases (x.0): The complete Identity Manager documentation set is updated and
republished.

■ For Minor releases and updates: Individual publications are updated and republished or
Documentation Addendum are provided.

Upgrade Paths and Support Policies
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End of Service Life for Software Support
During the End of Service Life (EOSL) period, Identity Manager software support is offered in
two phases:

■ Phase 1: Full Support
■ Phase 2: Limited Support

Note – The length of the Full Support Phase varies by product.

Full Support Phase
During the Full Support Phase (Phase 1), Sun Microsystems, Inc. provides software support in
accordance with the customer’s support contract with Sun (including the applicable Service
Listing) as set forth at:

http://www.sun.com/service/servicelist/

However, when a software product’s EOL date is announced, customers will no longer have
access to software updates and upgrades for that software product.

Limited Support Phase
During the Limited Support Phase (Phase 2), Sun Microsystems, Inc. provides software support
in accordance with the customer’s support contract with Sun (including the applicable Service
Listing) as set forth at:

http://www.sun.com/service/servicelist/

However, customers are not entitled to submit bugs or to receive new patches from Sun
Microsystems, Inc. As with Full Support Phase, after the software product’s announced EOL
date, customers will no longer have access to software updates and upgrades for that software
product.

The following table provides information about the Phase 1 and Phase 2 (EOSL) end dates for
older versions of Identity Manager.

Product Name Product Status Last Ship Date

Phase 1
(Full Support)
End Date

Phase 2
(Limited Support)
End Date EOL Announcement

Sun Java System Identity
Manager 7.1.1

Post RR May 15, 2009 May 15, 2010 May 2014 Nov. 11, 2008

Sun Java System Identity
Manager 7.1

Post RR May 15, 2009 May 15, 2010 May 2014 Nov. 11, 2008

Upgrade Paths and Support Policies
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Product Name Product Status Last Ship Date

Phase 1
(Full Support)
End Date

Phase 2
(Limited Support)
End Date EOL Announcement

Sun Java System Identity
Manager 7.0

Post RR May 15, 2009 May 15, 2010 May 2014 Nov. 11, 2008

Sun Java System Identity
Manager 6.0 2005Q4

EOL May 25, 2007 May 25, 2008 May 2012 Nov. 20, 2006

Sun Java System Identity Auditor
1.0 2005Q1

EOL Feb. 2, 2007 Feb. 2008 Feb. 2012 Aug. 1, 2006

Sun Java System Identity
Manager Service Provider
Edition 1.0 2005Q3

EOL Feb. 2, 2007 Feb. 2008 Feb. 2012 Aug. 1, 2006

Sun Java System Identity
Manager 5.0 2004Q3

EOL Aug. 11, 2006 Aug. 2007 Aug. 2011 Feb. 7, 2006

Sun Java System Identity
Manager 5.0 SPx 2004Q3

EOL Aug. 11, 2006 Aug. 2007 Aug. 2011 Feb. 7, 2006

Sun Java System Identity
Manager 5.5

EOL Aug. 11, 2006 Aug. 2007 Aug. 2011 Feb. 7, 2006

Waveset Lighthouse 4.1 March 2006 March 2010

Identity Manager Deprecation Policy
See “Identity Manager Deprecation Policy” in Sun Identity Manager 8.1 Upgrade for a complete
description of the Identity Manager deprecation policy for removing interfaces or changing
behaviors.

Redistributable Files
Sun Identity Manager 8.1 does not contain any files that you can redistribute.

How to Report Problems and Provide Feedback
If you have problems with Sun Identity Manager, contact Sun customer support using one of
the following mechanisms:

■ Sun Software Support services online at http://www.sun.com/support
(http://www.sun.com/support)
This site has links to the Knowledge Base, Online Support Center, and ProductTracker, as
well as to maintenance programs and support contact numbers.

Redistributable Files
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■ The telephone dispatch number associated with your maintenance contract

So that we can best assist you in resolving problems, please have the following information
available when you contact support:

■ Description of the problem, including the situation where the problem occurs and its
impact on your operation

■ Machine type, operating system version, and product version, including any patches and
other software that might be affecting the problem

■ Detailed steps on the methods you have used to reproduce the problem
■ Any error logs or core dumps

You must also collect the information described in the following table:

Information to Collect How to Get this Information

Product version, including
■ A list of all installed patches, hotfixes, and e-fixes
■ A list of customizations

Use the following commands from the Identity
ManagerConsole:
■ installed

■ inventory

Identity Manager topography, including:
■ How your Identity Manager cluster is configured

■ Environment localization of the issue and any
extra information about your environment

■ A list of servers

The information
■ Must be manually determined

■ Must be manually determined

■ Can be obtained by selecting Configure → Servers
from the Identity Manager Administrator
interface on a running Identity Manager server

Recent changes to your environment Must be manually determined

Java version and type Use the following Java command:

java -version

Application server version and type Depends on the Application Server being used, but
must be manually determined

Operating system level and information Must be manually determined

Default XML output, which is a list of all repository
objects

Use the export default.xml default command
from the Console

Task instance data, including
■ A list of all running tasks
■ The size of all current task instances

Use the following commands from the Console:
■ listTasks

■ showSizes TaskInstance

How to Report Problems and Provide Feedback
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Information to Collect How to Get this Information

System Logs Note – You might be asked to provide additional
system logs based on the type of issue you are
reporting.

How to Report Problems and Provide Feedback
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Identity Manager 8.1 Features

This section of the Identity Manager 8.1 Release Notes provides information about

■ “What's New in This Release” on page 29
■ “Bugs Fixed in this Release” on page 41

What's New in This Release
This section provides additional information about the new features provided in Identity
Manager 8.1, and the information is organized into the following sections:

■ “Sun's Patch Process” on page 30
■ “Major Features” on page 30
■ “Administrator and User Interfaces” on page 32
■ “Bulk Operations” on page 33
■ “Delegations” on page 33
■ “Documentation” on page 34
■ “Installation and Upgrade” on page 35
■ “Password Synchronization” on page 35
■ “Performance” on page 36
■ “Policy” on page 36
■ “Reports” on page 36
■ “Repository” on page 36
■ “Resource Adapters” on page 37
■ “Roles” on page 40
■ “Security” on page 40
■ “Service Provider” on page 41
■ “Tasks” on page 41

3C H A P T E R 3
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Sun's Patch Process
Beginning with the release of Identity Manager 7.1 Update 1, updates containing major and
critical customer-reported bug fixes are now delivered through a patch process, which replaces
the older hot-fix process.

Patches are developed, tested, and released in six-week intervals. These patches have a GUI
installer as well as a manual installation option, and they update the files in /WEB-INF/lib .
Instructions for installing the patch will be included in the patch Release Notes, which are
distributed in PDF format. Any fixes to the Gateway or to Password Sync will be described in
the Release Notes and will require updating with the installation of the patch.

Identity Manager patches are cumulative, so you can expect fewer problems with unique fixes.
You should plan to update to the latest patch level when installing or upgrading to a major or
minor release. For example, if patch 3 is available when you install or upgrade to 8.1, you should
apply patch 3 after installing or upgrading to 8.1. You would not be required to install patches 1
and 2 because patch 3 contains all the functionality in the previous patches.

The patch process also makes it easier for you to track a fix by its actual bug number. However,
it is still possible that a fix made against an older version may not yet be available in a newer
version. Regardless of which process your current version of Identity Manager follows, you
must confirm that the new, target Identity Manager version contains all of the bug fixes that you
need.

When a new patch is released, an announcement is sent to all of customer support. Patches are
available through customer support. Please contact Sun customer support at
http://www.sun.com/service/online/us for the latest patch available.

Major Features
Identity Manager 8.1 provides the following major new features:
■ “External Resource Management” on page 30
■ “Connectors” on page 31
■ “Sun Role Manager Integration” on page 31
■ “Java Management Extensions (JMX)” on page 31
■ “Pluggable Security (AES) Support” on page 32
■ “XML Digital Signature (XML-DSig)” on page 32
■ “SPML” on page 32

External Resource Management
This feature provides Identity Manager with the functionality to manage provisioning and
auditing for applications in the enterprise that are not directly connected to Identity Manager
through a resource adapter. This includes non-digital external resources such as laptops, cell

What's New in This Release
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phones, and security badges. Provisioning external resources via Identity Manager will result in
one or more provisioners being notified via email or through Remedy Help Desk 6.3
notifications.

Connectors
The Connector Framework provides a new way to connect Identity Manager to target
applications through the use of a connector. Identity Connectors and the Framework are part of
an open source initiative that offers a generic and consistent way to provision resources with
Identity Manager. Connectors have been decoupled from the core Identity Manager server,
enabling them to be released independently of Identity Manager builds. In addition to the open
source project website where additional connectors will be available for download, Identity
Manager comes with the following supported connectors:

■ Microsoft Active Directory 2003 and 2008
■ SPML 2.0

See the open-source project website, https://identityconnectors.dev.java.net/ for more
information.

Additional connectors will be added in the near future.

Sun Role Manager Integration
This integration focuses on Sun Role Manager versions 4.1.3 and higher. Identity Manager
forms can now directly invoke Role Manager web services to notify and invoke roles operations
on users. The Identity Manager Data Exporter already allows Role Manager to retrieve Identity
Manager's users and roles; the latest 8.1 data exporter now provides:

■ Capabilities information that will enable better user mining.
■ Resource schema which will be leveraged in future Sun Role Manager versions.

Java Management Extensions (JMX)
Identity Manager uses JMX MBeans to provide performance data for the List, Create, Get,
Modify, Delete and Authenticate operations. The following data are collected:

■ Count of operation
■ Moving Average time per operation
■ Minimum time per operation
■ Maximum time per operation
■ Collection start time
■ Resource Adapter class and version

What's New in This Release
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Pluggable Security (AES) Support
Identity Manager supports Advanced Encryption Standard. AES is a symmetric key encryption
technique that can be used instead of Data Encryption Standard (DES). AES is commonly used
by government application to protect data.

XML Digital Signature (XML-DSig)
This feature offers a standard non-repudiation mechanism using the W3C XML Signature
Syntax and Processing (XMLDSig). This enhancement provides the ability to create, store and
display work item approvals in an XMLDSig format. This format also optionally allows the
inclusion of RFC 3161–compliant time stamps.

SPML
Support for SPML2.0 has been enhanced. Identity Manager supports the search capability. In
addition, audit logging is now supported.

Administrator and User Interfaces
■ Updated the Checkbox, Label, Radio, Select, Text, TextArea, and Container user interface

components to properly render custom CSS styles. Previously, only the Button element
would display custom styles. (ID-15025)

■ You can now configure custom classes on the debug trace page. (ID-15490)
■ Selecting one or more users and then going to the next page, no longer causes you to lose

those selections when performing a multiple user action. (ID-15529)
■ The Login page does not remove spaces from password input boxes when you specify

noTrim=’true’ in the AuthnProperty name=’password’ XML element. You can apply
noTrim=’true’ on any other AuthnProperty. (ID-16434)

■ The size of the guidance help image can now be configured in the customStyle.css
stylesheet. (ID-17360)

■ The version information that is displayed in the administrator interface by hovering over
the Help button can be disabled by adding a new custom message catalog key UI_VERSION.
Set the value to an empty string in a custom message catalog. (ID-17507)

■ The end user dashboard (home) page now displays the user's full name rather than the
accountId. This can be modified by customizing the End User Dashboard form rather than
changing a JSP. (ID-19006)

■ You can now set a list of IDs called saveNoValidateAllowedFormsAndWorkflows in the
security attribute in the System Configuration object. When present, Identity Manager
allows only forms and workflows in the list to be processed as a SaveNoValidate action. All
other forms and workflows will be processed as a Save. If the list is not present, the behavior
remains the same (that is, all forms and workflows can be processed as SaveNoValidate).
(ID-19115)
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Bulk Operations
■ Bulk operations can now provision for users with multiple accounts on a resource.

(ID-13160)
■ Added the ability to unassign or unlink an account (using bulk operations) from a resource

that had been configured as “read-only” (all resource features allowing update of accounts
are disabled). Note that this is only possible using bulk operations. Previously, an attempt to
unassign/unlink an account from a read-only resource would return an error indicating the
resource does not exist. (ID–19048)

Delegations
■ Added the option to page approval workitems to avoid page timeouts. (ID-18544) The

approval.jsp page now accepts the following properties:
■ Paging. If present, enables paging.
■ MaxRows. The number of rows to display on each page
■ orderBy. A sorting parameter

Modify the WorkItemList form by adding the following fields:

<Field name=’PagingButtons’>

<Display class=’ButtonRow’>

<Property name=’align’ value=’right’/>

</Display>

<Disable>

<not>

<ref>viewOptions.Paging</ref>

</not>

</Disable>

<Field name=’action’>

<Display class=’Button’>

<Property name=’command’ value=’Recalculate’/>

<Property name=’label’ value=’&lt;&lt;’/>

<Property name=’value’ value=’first’/>

</Display>

</Field>

<Field name=’action’>

<Display class=’Button’>

<Property name=’command’ value=’Recalculate’/>

<Property name=’label’ value=’&lt;’/>

<Property name=’value’ value=’previous’/>

</Display>

</Field>

<Field name=’action’>

<Display class=’Button’>
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<Property name=’command’ value=’Recalculate’/>

<Property name=’label’ value=’&gt;’/>

<Property name=’value’ value=’next’/>

</Display>

</Field>

<Field name=’action’>

<Display class=’Button’>

<Property name=’command’ value=’Recalculate’/>

<Property name=’label’ value=’&gt;&gt;’/>

<Property name=’value’ value=’last’/>

</Display>

</Field>

</Field>

■ The Multi Approval workflow process has been enhanced to support automatic conversion
of a list of approvers to a list of approverObjects used for generating of approval work
items. (ID-19238)

Documentation
■ The Sun Identity Manager documentation set has been reorganized. The following major

changes have been made:
■ The Administration book has been reorganized into two new books: a Business

Administrator's Guide and a System Administrator's Guide
■ The contents of the Tuning, Troubleshooting, and Error Messages book have been moved

to the new System Administrator's Guide
■ The SPML chapters in the Deployment Tools book are now located in the new Web

Services Guide, and the Deployment Tools book has been dropped from the
documentation set

■ The Technical Deployment Overview book is now named the Deployment Guide
■ The Workflows, Forms, and Views book is now named the Deployment Reference
■ The documentation set includes a new title: Sun Identity Manager Overview

See the Related Books section of the Preface for a complete list of Sun Identity Manager
titles.

■ Corrections and updates to Sun Identity Manager publications are now posted to the
Identity Manager Documentation Updates website:
http://blogs.sun.com/idmdocupdates/

An RSS feed reader can be used to periodically check the website and notify you when
updates are available. To subscribe, download a feed reader and click a link under Feeds on
the right side of the page. Starting with version 8.0, separate feeds are available for each
major release.

What's New in This Release

Sun Identity Manager 8.1 Release Notes •34

http://blogs.sun.com/idmdocupdates/


Installation and Upgrade
■ The database upgrade scripts add an index to the ownerId column of the accounts table. An

upgrade of an installation with many accounts will take significant time to process the
database upgrade script due to the creation of a new index on a large table. (ID-19314)

■ A problem with out-of-memory exceptions during upgrades has been fixed. Previously
during upgrades, the Java VM maximum heap size was hardcoded to 256 MB. This
hardcoded value has been removed. (ID-19407)

Now it is possible to set the JAVA_OPTS environment variable to a custom value. If no value is
provided, a default value of 1024 MB is used.

To define the maximum heap size value, set the JAVA_OPTS environment variable using the
form —XmxHeapSize where HeapSize is a value, such as 512m. An example is -Xmx512m.

Password Synchronization
■ Email notifications sent from PasswordSync now use UTF-8 encoding for the sender name,

the subject, and the body of the email. All other header parts are encoded using plain ASCII
as required by the email RFCs. (ID-14120)

Note that email notifications that use non-ASCII characters might not display correctly in
all mail clients or on all operating systems.

■ Passwords containing spaces are encrypted and decrypted correctly now . (ID-17670)

If you are upgrading from 8.0 through 8.0.0.2 or 7.1.1 through 7.1.1.7 or prior to 7.1, you
must re-install all instances of Password Sync and gateways.

■ PasswordSync now supports Windows Server 2008 (32 and 64-bit versions). (ID-18342)
■ Two new settings have been added to the Windows registry and the installer GUI to allow

configuration of certificate behavior in PasswordSync. These settings replace the deprecated
registry settings clientSecurityFlags and clientConnectionFlags. (ID-19140)

securityIgnoreCertRevoke. If set to 1, ignore certificate revocation errors.

securityAllowInvalidCert. If set to 1, allow certificates that fail safety checks.
■ PasswordSync's internal checks have been extended to guard against illegal values passed in

as part of a password change that could cause a crash. (ID-19291)
■ The PasswordSync installer has been enhanced to allow for recording configuration

parameters to a file during an install. Future installations can reference the file and replay
the configuration settings. This allows all subsequent PasswordSync installations to be
installed and configured silently. (ID-19311)
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Performance
■ Deadlocks no longer occur over access to the authenticate cache. (ID-16926)
■ Improved the performance on the Create and Edit User pages. (ID-17066)

Identity Manager no longer by default checks all the users in an organization before
determining whether an administrator has the rights and permissions to delegate a work
item to a user. To revert to the previous default behavior, add the following statement to the
account/modify.jsp file.

req.setOption(DelegateWorkItemsViewer.OP_CALL_DELEGATORS_AVAILABLE_USERS,"true");

If OP_CALL_DELEGATORS_AVAILABLE_USERS is set to true in the DelegateWorkItemsViewer,
then Identity Manager searches through users to check whether the administrator has the
permission to see users.

■ For a user with a dynamically rule-assigned admin role, the user's context is now passed as
an argument during login. (ID-17964)

■ Performance has improved during logins to the Identity Manager User Interface when
assigned resources have a display name attribute other than accountId defined. (ID-18885)

Policy
■ Added the Next password policy. In this policy, if the user answers incorrectly, Identity

Manager displays the next question until the user answers an authentication question
correctly and logs in, or is locked out based on the specified failure attempts limit.
(ID-17307)

Reports
■ The contents of the Violation State of Violation Summary Report can now be localized.

(ID-17011, 17042)
■ Reports can now be generated in landscape orientation as well as the default portrait

orientation. In addition, the page size can be specified as legal as well as the default letter.
(ID-17649)

Repository
■ Identity Manager now supports MySQL 5.0.60 SP1 Enterprise Server as a production

repository. (ID-17735, ID-19703)
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■ You can now use MySQL 5.1.30 Enterprise Server as your Identity Manager production
repository, but you might need to change to your my.cnf file. Due to recent changes in
MySQL's InnoDB code, the default binary logging format is now STATEMENT. Identity
Manager uses a READ-COMMITTED transaction isolation level, so binary logging in STATEMENT

mode produces an error similar to the following: (ID-20460).

com.waveset.util.IOException:

java.sql.SQLException: Binary logging not possible. Message: Transaction level

’READ-COMMITTED’ in InnoDB is not safe for binlog mode ’STATEMENT’

If you enable binary logging, set the mode to MIXED by adding the following line to your
my.cnf file:

binlog_format=mixed

With this configuration change, you can use 5.1.30 as your repository without the binary
logging exception. For more details, see MySQL bug #40360.

■ The Identity Manager Repository has been changed to work around MySQL defect 9021.
The Repository's MysqlDataStore now generates a separate, named JOIN for each attribute
condition. (Previously, the MysqlDataStore in some cases used SUBSELECTs and the
EXISTS predicate.) (ID-15636)

■ The usage output for the setRepo command has been updated. The usage now lists -o as an
option and explains that -o causes setRepo not to perform an initialization check on the
new repository location. The usage also now shows the -U and -P flags in examples of direct
JDBC connections. (ID-19475)

Resource Adapters
■ Netegrity SiteMinder 6.0 is now supported. Proper configuration of the PolicyServer and

WebAgent for SiteMinder are necessary for the adapter to function correctly. (ID-6478)
■ The Active Directory resource adapter now provides a Home Directory Rights resource

attribute that controls permission inheritance and the level of permission for the home
directory. The default value is 0. A value of 0 indicates that it will not inherit and the user's
permission will be FULL control. A value of 1 indicates that the permissions will be
inherited and the user's permission will be FULL control. A value of 2 indicates that the
permissions will not be inherited and the user's permission will be MODIFY control. A
value of 3 indicates that the permissions will be inherited and the user's permission will be
MODIFY control. MODIFY control consists of the rights: FILE_GENERIC_WRITE,
FILE_GENERIC_READ, FILE_EXECUTE and DELETE. (ID-12881, 19706)

■ The database table resource adapter can now process a database column that is mapped to
the accountId attribute and has a data type of integer. (ID-13362)

■ The LDAP resource adapter now synchronizes entries only under the predefined base
contexts. (ID-15389)
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■ Added the "Respect resource password policy change-after-reset" resource parameter to the
LDAP resource adapter. When this option is enabled, and this resource is specified in a
Login Module, and the resource's password policy is configured for change-after-reset, a
user whose resource account password has been administratively reset will be required to
change that password after successfully authenticating. (ID-16255)
In this release, this behavior is available only for those LDAP servers that return the
"Netscape Password Expired" (unsolicited) response control (OID 2.16.840.1.113730.3.4.4)
with the response to a successful bind operation. The combination of the successful bind
attempt and the control is interpreted to mean the user's password has been administratively
reset and must be changed. An LDAP server implementing the password policy
change-after-reset feature will allow a user with a reset password that has successfully
authenticated only to change the password; any other operation is rejected.
Furthermore, because Identity Manager performs all LDAP resource operations other than
pass-through-authentication using an LDAP resource administrator account, certain LDAP
servers will consider any user's password modification attempt as an administrative reset
and never clear that status from the user's account. Such LDAP servers include:
■ Sun Java Systems Directory Server 5.x configured to use rootDN (typically cn=directory

manager) as the resource adapter connection account
■ Sun Java Systems Directory Server 5.2 with passwordNonRootMayResetUserpwd:on.
■ Sun Java Systems Directory Server 6.0 and later (including OpenDS)

■ The Domino resource adapter now supports the group provisioning ObjectType,
implementing the ObjectFeatures create, delete, list, rename, saveas and update. (ID-16422)

■ The SecurId resource adapter supports account renames. (ID-16517)
■ The SAP resource adapter has been updated to handle CUA in a more robust manner. With

the new forms and code changes, Identity Manager users can change CUA child systems as
well as roles and profiles for those child systems on a SAP user basis. (ID-16819)
The characteristics of the profiles and activityGroups account attributes have changed.
Both of these attributes now have a data type of complex. The profiles attribute now maps to
the PROFILES resource user attribute, while the activityGroups attribute now maps to the
ACTIVITYGROUPS resource user attribute.
Load the $WSHOME/web/sample/updateSAPforCUA.xml file to update these changes on your
SAP resource adapters. New SAP resources contain these attributes, unless you create the
resource by copying an existing resource that has not been updated.

■ Identity Manager now detects and traps Domino denial-of-service errors. (ID-16911)
■ The WRQ Attachmate 3270 Mainframe Adapter for Sun is supported. Refer to the Resource

Reference for details on setting up this product. (ID-17031)
■ Linux resources support using sudo to manage the /usr/bin/chage command. (ID-17119)
■ Added support for Lotus Notes/Domino 8.0. (ID-17213)
■ The Scripted Gateway adapter now supports password synchronization. (ID-17813)
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■ The Oracle ERP resource adapter now allows EMPLOYEE_NUMBER to contain both
alphabetic and numeric characters. (ID-18239)

■ The OS400 resource adapter now supports special characters in passwords. (ID-18412)
■ Added the RACF Case Insensitive Excluded Resource Accounts and RACF_LDAP Case

Insensitive Excluded Resource Accounts sample exclusion rules. These are defined in the
sample/wfresource.xml file.

■ The MySQL resource adapter has been updated to inherit from the JdbcResourceAdapter.
Existing MySQL resource attributes will be updated automatically. (ID-18835)

■ The Windows NT resource adapter is supported again. It is no longer deprecated.
(ID-19170)

■ The LDAP resource adapter has a new Use Paged Result Control configuration
parameter. When you enable this parameter, which is disabled by default, Identity Manager
uses Paged Result Control instead of VLV Control for the Account Iterator in
Reconciliation. Using the Use Paged Result Control configuration parameter improves
performance as long as your LDAP resource adapter supports simple paging control.
(ID-19231)

■ Added the Objecttypes to read from SAP HR resource parameter to the SAP HR adapter
to allow processing of the organization IDOCs from SAP HR. This is a multi-valued
attribute which currently supports the values of "P", "CP", "S", "C" and "O". (ID-19286)

■ The OracleERP resource adapter now supports an option that suppresses Identity
Manager.s ability to prepend the administrator user's schema identifier (such as APPS) to the
names of Oracle EBS administrative tables (such as FND_USER, FND_VIEWS, and so forth).
This option is provided through a new resource attribute with the Do Not Use Schema
Identifier display name, and the default value is FALSE. If you change this value to TRUE, the
adapter can no longer prepend the schema identifier to administrative table names.
(ID-19352)

■ The Active Directory adapter now supports the inetOrgPerson object class and other object
classes derived from the user object class. (ID-19399)

■ Added the Maintain LDAP Group Membership parameter to the LDAP adapter to control
whether Identity Manager or the LDAP resource is responsible for maintaining LDAP
group membership when a user is renamed or deleted. (ID-19463)

■ Added the resource parameter ERROR_CODE_LIMIT to the Shell Script resource adapter.
This parameter allows you determine which return code is an error. (ID-19858)

■ The SecurId adapters now support the following features: (ID-18665, 18671, 18672, 18673,
18676, 18677, 19726)
■ Edit the user's first name, last name, and default shell.
■ Fetch all valid ACE groups from the ACE server
■ Search on an ACE group and return all users in that group.
■ Fetch a list of all defined ACE agents from the ACE Server.
■ Show all the groups that are activated on an ACE agent.
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■ Fetch all the Administrators and their Admin Level.
■ The gateway now supports the AES cipher in 128-bit, 192-bit and 256-bit keys for

communication with the Identity Manager server. (ID-19738)

Roles
■ Identity Manager now recognizes the assignment of a UserForm through an Admin role

when the Admin role is controlling a dynamic organization and the user is edited through
the Find User page. (ID-18028)

■ The optional noroleconfigurationupdate argument to RoleUpdater can be specified
during upgrades to bypass modifying the RoleConfiguration object to indicate if pre-8.0
roles will be allowed to be directly assignable to users. Setting this value to "true" will bypass
the test to see if this change is necessary. (ID-18483)

■ All RoleAttribute logic is now case-insensitive. (ID-18766)
■ Report results now are available to a subject's organization and admin roles. (ID-19736)

Security
■ IDM 8.1 supports several new encryption options. (ID-16979, 17789)

■ For encryption of server encryption keys, added support for PBE with AES (ECB mode)
using a 256-bit key. This new option is similar to the existing PBE with DES mechanism
but uses AES as the underlying cipher.

■ For both data in the repository and for gateway communications, added support for AES
with 128-, 192-, and 256-bit keys (ECB mode).

■ Changed the "Manage Server Encryption" task as well to accommodate this new
functionality.

Some of these new options require additional install and/or configuration steps as detailed
in the Administrator's Guide.

■ Added a new "Login Recovery" authentication alternative to the "Forgot Password" security
questions based login. (ID-18052)

■ Identity Manager now supports XMLDSIG format signed approvals. Previously, signed
approvals were stored in the Identity Manager audit log in a proprietary format. This
enhancement allows such approval records to be stored in an XMLDSIG standards
compliant format thus offering better interoperability. Also supported is the ability to
include an RFC 3161 compliant digital time stamp retrieved from an external time stamp
authority. (ID-19011)

■ When pass through authentication is enabled, the change password functionality works
correctly when a user's resource password has expired and the Identity Manager account ID
and resource account ID are different. (ID-19218)
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■ Fixed multiple cross-site request forgery (CSRF) vulnerabilities. (ID-19280, 19659, 19660,
19661, 19683, 20072) Any customizations to the includes/headStartUser.jsp and
user/userHeader.jsp files must be manually updated.

■ Improved performance for dynamic organizations. The Waveset.properties file now
contains several properties that define how Rule-Driven Members lists cached. (ID-19586)

Service Provider
■ You can configure the Service Provider end-user pages to force your servers to always

process page requests using HTTPS. (ID-18509)

Tasks
■ The SourceAdapterTask can now be run by an administrator other than Configurator.

(ID-15299) To specify a different administrator, add the following to the system
configuration object:

<Attribute name=’sources’>

<Object>

<Attribute name=’hosts’/> <!-- any host is the default -->

<Attribute name=’subject’ value=’Configurator’/>

</Object>

</Attribute>

Bugs Fixed in this Release
This section describes the bugs fixed in Identity Manager 8.1, and the information is organized
as follows:
■ “Administrator and User Interfaces” on page 42
■ “Auditing” on page 43
■ “Capabilities” on page 43
■ “Forms” on page 43
■ “Delegation” on page 44
■ “Identity Manager IDE” on page 44
■ “Gateway” on page 44
■ “Logging” on page 44
■ “Password Synchronization” on page 45
■ “Policy” on page 45
■ “Provisioning” on page 45
■ “Reports” on page 46
■ “Repository” on page 47
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■ “Resource Adapters” on page 47
■ “Roles” on page 49
■ “Service Provider” on page 50
■ “Session API” on page 50
■ “Synchronization” on page 50
■ “Views” on page 51
■ “Additional Bugs Fixed” on page 51

Administrator and User Interfaces
■ Added the tabindex property to the DatePicker class. (ID-15244)
■ Removed an extraneous Search button on the page that displays after clicking the ...

button on the Forward Remediations page. (ID-17236)
■ An error is no longer returned when you edit or update a user and try to assign an

idmManager that does not yet exist or is missing, (ID-17339)
■ Removed a duplicate “Indicates a required field” from the Create Access Scan page.

(ID-17417)
■ Click-to-focus and select issues with the MultiSelect display component have been fixed in

the Mac OS X JRE. (ID-17938)
■ A user who can log in to multiple interfaces is no longer logged into the wrong interface

when the same user credentials are being used to log into another interface at the same time.
(ID-18204, 18506)

■ Deprovisioning a user with multiple accounts from the Administrator Interface now
completes successfully. (ID-18314)

■ On the Awaiting Approval page and other pages that contain tables of work items, if you
click an action button, such as Approve or Reject without selecting a work item, an error
message is now displayed. (ID-18472)

■ The administrator interface was not enforcing the challenge option when administrators
used the Change My Password screen to change their password. The problem has been
fixed. (ID-18578)

■ Changing a user password through the administrative interface no longer unnecessarily
generates the "The password may not be empty" error. (ID-18579)

■ Corrected a problem in the Identity/Lighthouse login module where the Forgot Password
option returned the following error: Missing value for required field "User ID", when user
provided User ID. (ID-18939)

■ Fixed the ability to query with user roles via the Find User form. (ID-18986)
■ Fixed UI containers so that nested fields properly inherit the required property and the

noNewRow property. (ID-19040)
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■ Identity Manager now refers to the MaximumNumberOfChildrenPerNode (default is 100)
attribute in ResourceUIConfig object to display node levels. If the number of child nodes
exceeds this value, Identity Manager displays only the first 100 nodes that are returned.
(ID-19434)

■ Corrected an unrecoverable error that occurred when editing a user in a dynamic
organization. (ID-19519)

■ Previously, when you removed a user's Modify rights for task permissions, the user could no
longer select a task, even when that user still had Delete rights and needed to select tasks for
deletion. Now, the checkbox column is shown in the tasks list user interface even after the
Modify permission has been removed. (ID-19718)

■ Images now render in the user interface when you enable relative URLs. (ID-19771, 19868)
■ Fixed the query creator so that it handlse all logical ANDs correctly in the Find User tab.

(ID-19898)
■ Pending work items can be viewed in the results page on the end user interface by enabling

the endableEndUserProcessDiagrams flag in the System Configuration object.(ID-19919)

Auditing
■ Audit log event reports now correctly indicate the interface that was used to respond to an

attestation. (ID-16950)
■ When you set the xpress.traceFileOnly option to true in the Waveset.properties file, all

XPRESS statement evaluations will generate trace messages to a file specified by
xpress.traceFile. When the xpress.traceFile has a value, all trace messages will be
redirected to both the Console and a file. (ID-19748)

Capabilities
■ Import/Export Administrators are no longer able to see administration pages and tabs they

were not supposed to. (ID-19389)
■ The System Configuration Object is now blocked from being modified by unauthorized

users. (ID-20224)

Forms
■ If you set the sortColumn value in a form that is invoked by a workflow, that value is no

longer ignored. (ID-17781)
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Delegation
■ If an administrator has current Organization Approval, Role Approval, or Resource

Approval delegation for an organization, role, or resource and loses control of that object,
the Delegations page in the user UI no longer displays an error message. (ID-18951)

Identity Manager IDE
■ The Identity Manager IDE no longer modifies a role's primaryobjectclass when th

eIdentity Manager IDE does not know about custom role types. (ID-19672)
■ Performing Display Schema operations for custom role types no longer returns a

NullPointerException on thedebug pages. (ID-19686)

Gateway
■ Registry key exchanges between the gateway and the Identity Manager server will no longer

fail if the machine running the gateway does not have a registry for the gateway. (ID-17137)
■ A spurious error reported during the gateway shutdown has been resolved. As a side effect,

the messages written during startup and shutdown are now written to the gateway trace logs
if tracing is turned on, or to the console if tracing is not on. (ID-19310)

Logging
■ The system now logs the IP address of a client instead of the IP address of a load balancer

that sends a request. (ID-17774)
■ Identity Manager trace logging now fills the maximum configured number of trace log files

before beginning to overwrite existing log files. (ID-19102)
■ Activity Report pages now use the Message field to display any additional information about

audit events. (ID-19257)
■ In previous releases, tasks that encountered resource account provisioning failures were

sometimes logged as successes in activity reports. This problem is now corrected.
(ID-19283)

■ An error message is now displayed when a delete is attempted on a Log or SysLog object,
except when running the System Log Maintenance Task or the AuditLog Maintenance Task.
(Those tasks use a different method to delete objects of these types.) (ID-19356)

■ The Resource Account Change Password and Resource Account Reset Password operations
are now audit logged with the Change Password or Reset Password audit action. In addition,
the "Change Resource Account Password" workflow is now changed so that the "Audit"
activity is only called when a failure occurs before the call to the
changeResourceAccountPassword workflow service. (ID-19359)

Bugs Fixed in this Release

Sun Identity Manager 8.1 Release Notes •44



■ Fixed an issue where the results of an access review were not audited correctly. (ID-19548)
■ Operations on the Server object are now audited. (ID-19606)
■ Resource Group modifications (Create, Update, Delete) are now audited. The Resource

Group object is also known as an Application object, so the ApplicationViewer is used to
operate on an Application object. Therefore, the Application viewer is where the auditing
occurs. (ID-19607)

■ An audit log record with a failure status is now published when a delete user operation fails.
(ID-19722)

Password Synchronization
■ PasswordSync can now correctly send administrators e-mails when user e-mails have been

disabled. (ID 18110)
■ A possible crash caused by a NULL reference in PasswordSync was fixed. (ID-19042)
■ Test connections using valid certificates and self-signed certificates now work correctly.

(ID-19216)
■ Corrected two potential buffer overruns. In both cases, buffers of fixed length could be

overrun by content that was larger than the buffer. These buffers are now dynamically
allocated to ensure they are large enough. (ID-19358)

■ Password synchronization for computer accounts has been disabled. (ID-19366)
■ The default install directory for Password Sync files has been changed to match the product

name. (ID-20276) By default, the application will now be installed in C:\Program

Files\Sun Microsystems\Sun Identity Manager PasswordSync. The default directory
on the 64–bit version of Windows is C:\Program Files (x86)\Sun Microsystems\Sun

Identity Manager PasswordSync\

Policy
■ Password policy now correctly validates any extended ASCII characters that are entered for

the "must not contain words" condition. This condition also now differentiates between a
complete word match and a string attribute match when displaying a Policy Violation
message. (ID-19384)

Provisioning
■ A NullPointerException no longer occurs during a retry task when a reprovision with

retry fails on a secondary operation. (ID-19826)
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Reports
■ Older versions of Risk Analysis reports produced a TaskResult object that contained XML

that was not valid per the waveset.dtd. Consequently, these TaskResult objects could not
be re-imported into Identity Manager. New executions of the Risk Analysis reports produce
valid XML that can be re-imported. (ID-14419)
Use the following procedure to update and import old TaskResult objects:
1. Export the TaskRef to a file, such as object.xml
2. Run the following command from a UNIX shell. A corrected version of the file is written

to object-fixed.xml.

cat object.xml | sed -e s/’&#xA;’//g | sed -e s/’&#xA; ’//g | sed -e

s/’&#xA; ’//g | sed -e s/’&#xA; ’//g > object-fixed.xml

3. Import the object-fixed.xml file into Identity Manager
■ By default Audit records are placed in the same ObjectGroup that the Object the record

refers to is in. The ApproverReportTask is in the All ObjectGroup, so the audit record
indicating the report was run is also placed in the All ObjectGroup. (ID-16363)
This means the audit record is visible to all administrators. If this is not desirable, then either
change the MemberObjectGroup of the ApproverReportTask TaskInstance to a more
appropriate ObjectGroup, or add the following XML to the AuditReport Task:

<Field name=’excludeAll’>

<Display class=’Hidden’>

<Property name=’value’ value=’true’/>

</Display>

</Field>

■ The "Interface" and "Attribute Changes" options for the X-Axis and Y-Axis for reports of
type Usage Report are now mapped to valid queryable values, and a NullPointerException
will not occur. "Attribute Changes" now maps to Attribute.ACCT_ATTR_CHANGES.
"Interface" maps to the newly created Attribute.INTERFACE, which is a synonym for
Attribute.CLIENT. (ID-16769)

■ The Account Index Report can now be generated properly for a user who doesn't control the
Top organization. (ID-16643)

■ The Resource User report displays administrator names correctly. (ID-17650)
■ If an error occurs while generating a report in PDF format, an error message is now

displayed correctly. (ID-17979)
■ Cloning a report now works correctly. (ID-18187)
■ Identity Manager no longer returns a NullPointerException when a User Report includes

Extended User Attributes as its search options. (ID-19567)
■ Fixed an Access Denied error that occured when a user that has been assigned more than

one AdminRole tried to create a report. (ID-20067)
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■ Task reports now display column names correctly. (ID–20131)

Repository
■ The MySQL error "Column 'id' in field list is ambiguous" no longer occurs when a user

clicks an audit policy link in the "All Compliance Violation" report. The repository now
generates DML that qualifies this column name. (ID-19900)

Resource Adapters
■ The name of a Change Resource Password task is now displayed correctly. (ID-6947)
■ A problem has been corrected with the Sybase adapter that caused the adapter to attempt to

reconcile with the default Sybase system database when the database defined in the resource
adapter was not available. (ID-15867)

■ Tabs (\u0009) now work as field delimiters for Flat File Active Sync resources. (ID-16780)
■ Enhanced tracing capabilities in the Scripted JDBC resource adapter. (ID16900)
■ The gateway no longer overwrites the ServerKeyFileName value in the Domino Server's

notes.ini file when Domino Server and the Lotus Notes client are installed on the same
machine. (ID-17216)

■ Creating a new user with the force_change flag explicitly set to false now works correctly
with Solaris resources. (ID-17401)

■ The Gateway service now re-establishes its database connection to SecurID in the event that
SecureID is restarted. (ID-17443)

■ Corrected a problem where the gateway encryption key was not being updated when
ScriptedGateway was the only gateway resource. (ID-17556)

■ Two error situations while creating a user in Active Directory now show the correct and
readable error: the account already exist and the account ID has an improper format.
(ID-17587)

■ The SecurId ACE Server UNIX adapter now tests whether pooled connections are viable.
(ID-17673)

■ Identity Manager now ignores the use of Lotus Domino group name aliases and does not
cause invalid object errors if they are used natively. (ID-17739)

■ The Domino adapter deletes script files that are created during create and post update
actions.(ID-18136)

■ The Active Directory resource adapter now correctly processes non-zero exit codes from
delete before actions. (ID-18241)

■ A Lotus Domino resource now returns connections to the connection pool properly.
(ID-18417)
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■ The Name account attribute for the Exchange 2007 adapter is a create only attribute.
Modification of the attribute causes undefined side effects and could leave the user
unmanageable from Identity Manager and is therefore no longer supported. (ID-18606)

■ Gateway resource adapters no longer overwrite read-only account attributes. (ID-18932)
■ The OracleERP resource adapter no longer returns a no data found error when looking up

responsibilities that have not yet been provisioned to users. (ID-19056)
■ The OracleERP resource adapter no longer returns an error when looking up a

responsibility that has a non-unique name. (ID-19057)
■ The LDAP resource adapter no longer requests a uniqueMember attribute when testing a

group membership. (ID-19134)
■ Fixed a memory leak in the Domino Gateway adapter. (ID-19139)
■ The gateway no longer crashes when a "get info" message is sent to a Scripted Gateway

resource (ID-19249).
■ The Manage Server Encryption task no longer corrupts objects of the type

GatewayEncryptionKey when it stores a time stamped copy of the key. (ID-19250)
■ Corrected a problem where the SAP resource adapter could not unlock users who were

locked after too many wrong logins. (ID-19252)
■ The deprecated DominoActiveSyncAdapter is no longer delivered. The Domino resource

adapter now contains this functionality. (ID-19281)
■ The gateway no longer crashes when running a reconcile on a Windows NT resource.

(ID-19295)
■ The NDS gateway no longer sends a false warning message about the User class when

processing non-user NDS objects. (ID-19362)
■ Legacy Exchange 2000/2003-enabled mail users are now reported as AD-only users

(RecipientType equals User) when Exchange 2007 support on the adapter is turned on.
Exchange 2000/2003 users can be distinguished from AD-only users by the
legacyExchangeDN and other Exchange 2000/2003 attributes. (ID-19393)

■ Now the Uid is not unique error is thrown when changing a user ID to the same value as
another user ID in the Red Hat Linux resource. (ID-19395)

■ Identity Manager now correctly passes SAP Access Enforcer custom attributes to Access
Enforcer. (ID-19427)

■ LDAP groups with multiple objectClasses are now stored correctly. (ID-19436)
■ The Solaris, HPUX, AIX, and Linux adapters running NIS now prevent you from creating

an account with a uid in use or changing the uid to that of an account that already exists.
(ID-19465)

■ The gateway now returns Exchange 2007 attributes correctly if they are requested as part of
the getAllObjects() call on an Active Directory adapter. (ID-19492)

■ The AIX adapter no longer deletes all group members when updated with invalid users.
(ID-19516)
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■ Fixed an issue the occurred when deleting a user's primary group on Red Hat and AIX. If the
resource threw an exception and failed to delete the group, the Administrator Interface
would report a success. The error is now reported correctly. (ID-19520)

■ Identity Manager now correctly interprets the error code returned from Red Hat Enterprise
Linux 5 when a user is assigned to a nonexistent group. (ID-19523)

■ Using non-root access through SSH from the shell script adapter now works correctly.
(ID-19583)

■ Using the ExcludedAccountsRule for operation updates no longer yields a null accountID.
(ID-19585)

■ Using LDAP reserved characters, such as an asterisk (*), for LDAP authentication no longer
locks out all LDAP users. (ID-19588)

■ The AIX resource adapter updates secondary group list correctly. (ID-19628)
■ The Oracle resource adapter now allows you to use the question mark (?) and braces ({ })

characters in an account password. (ID-19653)
■ The SecurId ACE Server for Windows adapter has been enhanced to so that the adapter now

confirms that both the gateway and the backing SecurId environment are responding to
queries for work. (ID-19667)

■ Full reconciliation now correctly alters account disabled status. The LDAP resource adapter
now checks disabled status during reconciliation. (ID-19708)

■ Now, when you create or modify a user with an invalid login shell for NIS resources, an
error occurs. (ID-19755)

■ Identity Manager no longer loses updates in Active Directory while running
synchronization. (ID-19905)

■ A disabled user's SiteminderLDAP account status will now be displayed correctly on the
Edit User page using Tabbed User Form. (ID-19931)

■ The Windows NT resource adapter no longer supports groupType resource objects.
(ID-19791)

■ The SecurId UNIX resource adapter processes comma-separated group values correctly.
(ID-20152)

■ An administrator can assign more than one group and client to a user in the SecurId
Windows adapter. (ID-20153).

■ The control characters (0x00-0x1f, 0x7f) in a user password will throw error for Linux, AIX,
Solaris, HPUX, and ShellScript resource adapters. (ID-20174)

Roles
■ A contained role now must be removed from the role(s) to which it has been assigned before

it can be deleted. (ID-18981)
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■ A problem that prevented system deployers from saving and importing roles in the Identity
Manager IDE has been fixed. (ID-19036)

■ Fixed a problem that caused Identity Manager running on JDK 1.6 to fail to assign roles
assigned to a Business Role. A symptom of the problem included Identity Manager
identifying a Business Role as an IT Role after the Business Role was assigned. This problem
was limited to JDK 1.6. (ID-19086)

■ Corrected a problem where the SPML viewer threw a ClassCastException when setting a
ResourceAttribute value to a String value while modifying a role. (ID-19177)

■ A problem that prevented roles from being assigned to users by way of custom user forms
has been fixed. The problem occurred when roles were assigned using non-refreshable UI
components, such as the text box. (ID-19241)

■ The following functions now work correctly for users with dynamic admin roles:
(ID-19456)
■ Canceling approvals
■ Viewing the history of a work item
■ Running a report

■ RoleAttribute list values now perform correctly. (ID-19981)

Service Provider
■ An issue has been corrected that occurred when Identity Manager Service Provider is

configured to use the organization attribute. An Identity Manager administrator that does
not control Top was unable to update Service Provider end-users and received the following
error: "User must have a value for the 'org' attribute." (ID-18329)

Session API
■ The EmailUtil API call and sendEmailToAddress() method now handle a null HTTP

Request sent as arguments to the call. The method now checks for the null case when
determining the locale from the HTTP Request and defaults correctly to the appropriate
locale without a NullPointerException. (ID-17755)

Synchronization
■ When a server running Active Sync for a resource with startup type "Automatic with

Failover" is not able to connect to the Identity Manager repository, the task will not poll the
resource for changes. If the Active Sync task can establish a connection with the repository
at a later scheduled polling time, it will exit if another Active Sync task for that resource has
already been started on another Identity Manager server in the cluster. (ID-19452)
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Views
■ When the SystemConfiguration attribute named

ProvisioningDisabledUserShouldThrow is set to true, any attempt to provision a disabled
user to a resource will be prevented and will produce an error. When the attribute is not set
to true, then the provisioning will still be prevented, but it will NOT produce an error.
(ID-19433)

Additional Bugs Fixed
17055, 18242, 19019, 19065, 19244, 19288, 19651, 20352

Bugs Fixed in this Release
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Known Issues

This section of the Release Notes lists known issues and workarounds for Identity Manager 8.1.

This information is organized into the following sections:

■ “General” on page 53
■ “Auditing” on page 56
■ “Data Exporter” on page 58
■ “Identity Manager Service Provider” on page 58
■ “Localization” on page 59
■ “Login Configuration” on page 59
■ “Organizations” on page 60
■ “PasswordSync” on page 60
■ “Policies and Capabilities” on page 60
■ “Reconcile and Import Users” on page 61
■ “Reports” on page 61
■ “Resources” on page 62
■ “Roles ” on page 66
■ “SPML” on page 66
■ “Sun Identity Manager Gateway” on page 66
■ “Tasks” on page 66
■ “Workflows, Forms, Rules, and XPRESS” on page 66

General
■ No checking is done on organization name, administrator name, account name, user

attribute name (left hand side of schema map), or task names for invalid characters
(ID-1145, 1206, 1679, 1734, 1767, 2413, 3331). You cannot use a dollar ($), a comma (,), a
period (.), an apostrophe (’), an ampersand (&), a left bracket ([), a right bracket (]), or a
colon (:) in the name for these types of objects.

■ The calendar object is not fully viewable if the browser is using large fonts. (ID-2120).
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■ The Select All checkbox on the Find Results page and the List Task page does not become
un-selected if one of the items in the list is un-selected (ID-5090). The selectAll checkbox is
ignored during the resulting action if not all of the members in the list have their checkbox
selected.

■ If you make a change to a custom message catalog, it is necessary to restart the server in
order to see your changes. (ID-6792)

■ The current mechanism for detecting a failed Server assumes that all the systems in an
Identity Manager cluster are synchronized with respect to time. (ID-7064) With the default
failure interval of five minutes, if one server is five minutes out of sync with another, the
server that is ahead will declare the server that is behind to be dead, causing unpredictable
results.
Workaround: Maintain better time synchronization or increase the failover interval.

■ On Windows, if you are logging in as a user whose name contains double-byte characters
and the default encoding for the machine only supports single-byte characters, you must set
the USER_JPI_PROFILE environment variable to an existing directory whose name
contains only single byte characters. (ID-8540)

■ If you extract a resource to an XML file using the File Format as XML option, and then select
CSV File Format from the drop-down list, the following message dialog is displayed:
(ID-10847)

The form has already been submitted.

Workaround: To avoid this message, click Accounts → Extract to File → Choose a
Resource → Choose CSV File Format. Click Download to download the resource account
details in .csv file format.

■ If an expanded node contains less than one page of data and you insert a new child of that
node (for example, if you are creating a User in the organization) before the first record on
the page, Identity Manager will insert a page with one item before the current page on the
subsequent refresh. (ID-12151)
Workaround: To realign the pages, click the First Page button.

■ If you modify a Role form to change the showSuperAndSubRoles variable from 0 to 1, and
then import a super role object definition file containing existing subroles from the
Configure tab, those subroles will not be modified to include the <SuperRoles> section.
However, if you use the Identity Manager graphic user interface to create a super role, the
subroles referenced by that super role will be updated. (ID-15053)
This issue can occur with roles created outside Identity Manager that have references to
existing roles (either subroles or super roles) already in the system.
When importing these roles, the roles that already exist in the system are not updated to
reflect the new relationships; for example, referential integrity is not maintained. Use the
RoleUpdater to check and correct the referential integrity if roles are imported in this way.

General
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Workaround: You can update roles outside the upgrade process by importing a new
RoleUpdater.xml file found in sample/forms/RoleUpdater.xml. By default, Identity
Manager adds the subrole links during upgrade or when you import RoleUpdater.xml.
To disable this new functionality, set the RoleUpdater attribute nofixsubrolelinks to
true. For example,

<MapEntry key=’nofixsubrolelinks’ value=’true’ />

■ If you modify settings (such as adding additional column attributes) on an existing
changelog, these modifications might not appear in a pre-existing changelog CSV file.
(ID-15973)

■ The Repository Configuration object has an attribute named maxAttrValLength. The value
of this attribute is ignored, and is always 255. (ID-16261)

■ While in a localized Identity Manager session, users might encounter partial localization (a
mix of English and the selected language) in Process Diagram applets. (ID-16139)

■ Direct-mode password synchronization requires SimpleRpcHandler to be configured in the
web.xml file. By default, this handler is not provided as a handler for the rpcrouter2 servlet.
(ID-16469) To use direct-mode password synchronization, set the handlers initialization
parameter in the following way:

<init-param>

<param-name>handlers</param-name>

<param-value>com.waveset.rpc.SimpleRpcHandler,

com.waveset.rpc.PasswordSyncHandler</param-value>

</init-param>

Note that SimpleRpcHandler is known to interfere with certain RemoteSession calls. If you
plan on using RemoteSession as well as direct-mode password synchronization, configure a
separate servlet for handling RemoteSession calls.

■ Accounts > Extract to File saves XML and CSV file formats as .dat extensions, rather than
the expected .xml and .csv extensions. (ID-17521)
Workaround: The saved files can be manually renamed with the appropriate file extensions.

■ The String Quality Policy page displays text in vertical lines. (ID-18551)
■ Role type delegations will override role approval delegations made for a specific role.

(ID-18559)
For example, if future role work item types for one or more specific roles are delegated to
user one, while all future business role work items are delegated to user two, the specific
roles from the first delegation will be delegated to user two rather than user one.

The scenario delegation summary follows:
■ Delegate role approval for business role 1 to user one
■ Delegate business role approval to user two
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In all requests where a user was assigned a business role approval, the business role will be
delegated to user two.

■ Enabling a role does not give the user an option to update assigned roles. (ID-18647)

Workarounds: Manually update the assigned users, or update the assigned users from the
List/Find Roles pages.

■ Roles contained by other roles can now be conditionally assigned to users when their parent
role is assigned. A condition can be specified on the association between the parent and
contained role when editing the parent role. A condition can be created or can reference a
rule. If a rule is specified, all user view attributes required for the evaluation of the rule must
be specified via rule argument. (ID-18734)

■ Upgrading from Identity Manager 7.x to Identity Manager 8.0 will fail if the repository is
MySQL and the 7.x installation has configured role objects. This problem occurs when the
upgradeto80from71.mysql script executes. When this script executes, the columns in the old
object table, which contain the 7.x roles, and the new role table are in a different order.
(ID-18874)

■ The data warehouse message catalog, WICMessages.properties, is loaded based on the
server location instead of the user's location. For example, if an application server is running
in a Japanese locale, the query attributes will be displayed in Japanese, even if the user's
interface is normally in English. (ID-18898)

Workaround: Restart the application server in a locale with a UTF-8 variant that
corresponds to the browser's language setting.

■ Identity Manager 8.0 added a new queryable attribute, assignedRoles, which references all
direct and indirect roles assigned to a user. (ID-18921) Prior releases contain the still
available queryable attribute, role, which only contains roles directly assigned to users. The
upgrade process only automatically refreshes users with indirect roles to enable population
of assignedRoles. A report for users Assigned a Role will not return all users assigned to a
role in an upgraded environment until all users have been refreshed.

Workarounds:
■ Refresh all users.
■ Create a report for users with directly assigned roles.

■ The Sort by Repetition option does not work on the Scheduled Tasks table. (ID-20377)

Auditing
■ During a scan, there is no support for retrying user accounts that could not be fetched from

resources, or where other failures occur. These failures are reported when the scan is
complete, but there is no automated way to rescan the accounts. (ID-9112)

Auditing

Sun Identity Manager 8.1 Release Notes •56



■ Identity Auditor attempts to keep users in compliance between policy scans by enforcing
policy whenever the user is edited. If editing a user that has assigned audit policies and also
is in violation of a policy, you cannot save changes to the user, even if the change is as simple
as moving a user to another organization. (ID-9504)
Workaround: Use the right-click move (or find then move) functionality on the user applet,
or temporarily disable the audit policy checks.
To disable the auditor policy checks, edit the system configuration and remove
userViewValidators property. This property which has a value of a List of strings is added
during the import of init.xml or upgrade.xml.

■ In the AuditPolicy, Resource and Organization Violation History reports, implementing
logarithmic scaling for a STACK chart type may result in unusual display behavior.
(ID-9522)

■ Currently, the Auditor Access Scan Report administrator cannot schedule an Audit Policy
Scan. An error, Error message: Create access denied to Subject auditadmin on

type TaskSchedule is displayed. To schedule any task, administrators must have create
privileges for the TaskSchedule authType. (ID-14713)
Workaround: Edit the administrator to assign the create privilege for the TaskSchedule,
or specify a user with at least the Auditor Administrator or Waveset Adminsistrator
capabilities.

■ When running Audit Scans that produce multiple violations, Auditor might create a
remediation workflow to manage processing of the violations. The default MySQL setting
for max_allowed_packet (1M) is too small for a workflow with dozens of violations. If this
limit is reached, Auditor will not start the remediation workflow. (ID-15830)
Workaround: For heavy use of Auditor, this value should be much larger. To address this
issue, add max_allowed_packet = 32M to the MySQL configuration file (my.cnf) and restart
the database server.

■ Changing severity and priority values for Compliance Violation remediations can be
misleading. The initial values in the form are not the current values of the Compliance
Violations. They are the last values set when making a change. It is important that you know
what severity/priority value you want while still viewing the list view, because you cannot
determine the current values when on the page that lets you change the values. (ID-16040)

■ Audit policy names cannot contain these characters: ’ (apostrophe), . (period), | (line), [ (left
bracket), ] (right bracket), , (comma), : (colon), $ (dollar sign), " (double quote), = (equals
sign). (ID-16078)
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Chapter 4 • Known Issues 57



Data Exporter
■ The Data Exporter can be configured to run as any Identity Manager administrator with the

appropriate capabilities. The export task runs as a daemon, and is started and monitored by
the Identity Manager scheduler. Audit records created by the Data Exporter will show the
subject of the Identity Manager scheduler (Scheduler:IDMServer), rather than the subject
the task is configured to use. (ID-18055)

■ Forensic query does not support Edit/Modify actions against role types. (ID-18769)
■ Users of Data Exporter must be aware of the following performance issues: After warehouse

model configuration has been written, Data Exporter will not re-examine warehouse
interface code. If you modify the warehouse interface code to add extended user attributes,
these new attributes do not appear in the Configure → Warehouse → Warehouse Model
Configuration (Model → Attributes tab), and consequently do not appear for use within the
Forensic Query interface. (ID-18975)
You will see this problem when you configure your warehouse and afterward try to add
custom attributes for export. The initial warehouse configuration looks at the WIC code and
writes the Configuration → Data Warehouse Configuration object. Subsequently, Data
Exporter does not re-examine the WIC code.
Subsequent warehouse upgrades with new versions of Identity Manager also experience this
problem.

Identity Manager Service Provider
■ Identity Manager Service Provider and Sun JavaTM System Portal Server may not be

compatible; there is a problem related to the encrypted libraries. (ID-10744)
This problem may be corrected by setting the following values in Portal Server’s
/etc/opt/SUNWam/config/AMConfig.properties file, and then restarting the web
container:

com.iplanet.security.encryptor=com.iplanet.services.util.JCEEncryption

com.iplanet.security.SSLSocketFactoryImpl=netscape.ldap.factory.

JSSESocketFactory

com.iplanet.security.SecureRandomFactoryImpl=com.iplanet.am.util.

SecureRandomFactoryImpl

■ Some configuration options that appear in the Identity Manager Administrator interface are
not used with Identity Manager Service Provider. (ID-10843).

Among these are:
■ Resource options: exclude accounts rule, approvers, and the organization that the

resource is assigned to.
■ Role attributes

Data Exporter
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■ The default Service Provider login module group expects the Service Provider resource to be
named ’SPE End-User Directory’. If the name of the resource is different, then the Service
Provider end-user login page will not function properly. The page will not show the login
related fields. (ID-14891)
Workaround: Update the resource name in the UI_LOGIN_MOD_GRP_DEFAULT_SPE_PWD
LoginModGroup object to reference the correct resource name.

Localization
■ Identity Manager does not provide a mechanism to customize encoding of a CSV file that

has been generated as a result of a bulk action. When you use Excel to open a UTF-8
encoded CSV file, the contents are displayed as garbage because Excel expects native
encoding in CSV file. (For example, for Japanese, iShift_JIS) (ID-19901)
Workaround: Use an editor that supports UTF-8 encoding.

■ In PasswordSync Notification email, the multibyte characters in the $cn field are not
displayed properly. (ID-19934)

■ In the Tomcat web container, the multibyte characters for column names are displayed as
"???" in the SOD report with compact display mode. (ID-20040)

■ For a Solaris resource, Identity Manager displays a garbled message in the Roles field. If the
OpenSolaris is used as a resource, then this is not an issue. (ID-20046)
Workaround: In /etc/default/init file, set LANG=C and reboot Solaris. Then assign a Solaris
resource to the user. The Roles field is empty, which is the expected behavior.

■ Identity Manager garbles apostrophes and multibyte characters on MultiSelect Java applets
for the following browser configurations: Internet Explorer 7 with Java 1.6.0_07 and
1.6.0_11 (when UTF-8 encoding is set) Firefox 3 with Java 1.6.0_07 on Windows XP
Professional (ID-20106)

■ The string “Check Alignment of PHs” and misplaced html tags are shown on some German
online help files. (ID-20345)

Login Configuration
■ If an Administrator logs in and selects Change My Password, and then selects another tab,

their account is locked until the lock expires. (ID-3705)
If another Administrator attempts to edit that locked Administrator, the following message
displays:

com.waveset.util.WavesetException:

Unable to access account #ID#Configurator at this time

Please try again later.

Login Configuration
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If that Administrator clicks OK, the workflow process diagram from the last action is
displayed.

Organizations
■ Renaming an organization when there are provisioning requests pending that have users

belonging to the organization will cause the provision request to fail (ID-564).
Workaround: Ensure there are no outstanding requests before renaming an organization.

■ When creating a new organization, if the User Member Rules option is selected before
specifying an org name, when the page is refreshed, an organization ID will appear in the
Organization name field (ID-6302). The name can still be set prior to saving the new
organization.

PasswordSync
■ The PasswordSync installation and configuration application can read an XML file to

populate the registry keys used by the DLL. The XML file used should always be based on the
file generated by the “-writexml” option of the configuration application taken from a
working PasswordSync installation. (ID-20375)
Workaround: You can change the file if you keep in mind these restrictions: keynames are
case-sensitive; Identity Manager does not check values; keys that Identity Manager does not
recognize will not generate errors or warnings, and are silently ignored.

Policies and Capabilities
■ The Identity Manager account policy attribute Reset Notification Option has a value option

of “administrator” that has no effect (ID-944). The only viable options are “immediate” and
“user.”

■ The minimum number of questions a user must answer can be set to a value greater than the
number of defined questions (ID-1834). If this situation occurs, the user will not be able to
log in using the “Forgot My Password” option.

■ The Default Lighthouse Account Policy cannot be cloned by editing the policy, changing the
name, and selecting to create a new object (ID-5147).
Workaround: Create a new account policy.

■ Audit scan has an option in the Task Launch form to send an email to a specified email
address with a violation report. This email will not be sent if no violations are found.
(ID-18773)

Organizations
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Reconcile and Import Users
■ When a full reconciliation is canceled, the error message displays: (ID-14554)

Canceled the incremental reconciliation of [resource] running on [server]

The message should read:

Canceled the full reconciliation of [resource] running on [server]

■ When executing Load From Resource, and the resource supports
ACCOUNT_CASE_INSENSITIVE_IDS, if the user's accountId differs in case from the accountId
stored in Identity Manager's ResourceInfo user object, a second ResourceInfo will be
added to the user object with the accountId in the same case as reported by the resource.
(ID-17377)

Workaround: Ensure that the accountId in the Identity Manager ResourceInfo object in the
user object is the same case as that reported by the resource.

■ If you disabled the MultiSelect display component applet (and are using the HTML version
instead), and edit the reconciliation policy of a particular resource instance, you can get an
error when you uncheck the Inherit resource type policy checkbox. (ID-18964)

Workaround: Re-enable the MultiSelect applets.

Reports
■ Numbers display in the Priority and Severity columns of the Violation Summary Report

instead of text descriptions. (ID-16932)
■ The Violation Summary Report does not include fixed violations. The report only includes

violations that are currently active (new or recurring) or mitigated. (ID-16933)
■ When several conditions are specified to generate a usage report, the graph displays

correctly on the Report Result page, but the fixed line width will truncate the conditional
text. (ID-17224)

■ All Inactive Account Scan reports do not display their results on the View Risk Analysis
page. To view the result from these reports, go to the Server Tasks page. (ID-17255)

■ The User Question report does not display the report title when Question Policy is not
configured. (ID-17415)

■ The Resource User report lists Reset Administrator as a user, but Reset Administrator is a
hidden user that should not be displayed. (ID-17650)

■ Identity Manager does not display the "Last Login Date" label on the Risk Analysis Report
results table. (ID-20269)
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■ The Download CSV report sends email notification when the email report check box is
selected. This email notification should happen only when the report is run (by clicking Run
button). (ID-20346)

Resources
■ Resource test button does not test all fields. (ID-51)
■ The error message when a resource account password or username is not correct on a

PeopleSoft resource is not clear (ID-2235). The error message states:

bea.jolt.ApplicationException: TPESVCFAIL - application level service failure

■ Windows Active Directory resource actions that use the %DISPLAY_INFO_CODE% exit status
cause the action to fail with errors (ID-2827).

■ Setting a user’s primary group ID on Active Directory cannot be done when creating the
user (ID-3221).
Workaround: Create the user without setting the primary group ID, then edit the user and
set the value. The primary group ID is also set by number and not by the distinguished name
(DN) of the group.

■ Resource IP addresses are cached in the JVM after the hostname is resolved to an IP address.
If a resource IP address is changed, the application server must be restarted for Identity
Manager to detect the change (ID-3635). This is a setting in the Sun JDK (version 1.3 and
higher) and can be controlled with the sun.net.inetaddr.ttl property, which is typically
set in jre/lib/security/java.security.

■ You cannot create multiple accounts for a single user on Oracle resources (ID-3832).
■ If a user is moved from or to a sub-container within the Active Directory organization, the

Active Sync adapter will detect the change, but when you view the user on the edit page, (or
make a change and view the confirmation page) the user’s accountId is still displayed as the
original DN (distinguished name) (ID-4950). Because we use GUID to modify the user, this
will not cause any operational problems. Running a reconcile against the resource will fix
the problem.

■ If a user is moved from an Organization (OU) to a sub-organization, the LDAP ChangeLog
adapter will not recognize the change and assumes the user has been deleted. The user object
is then locked in Identity Manager (if that is the current setting), and a new account is not
created for the moved account (ID-4953).

■ The pooled connections used by the UNIX resource adapters can be left in an undetermined
state if an error occurs while executing a command or script (ID-5406).

■ On NDS, if you edit a field (such Grace Login Limit) on the initial provision, and do not
provide values for the boolean fields, all the Boolean fields are set to false (ID-6770). This
prevents you from setting the other fields on the restriction tab which require certain check
box values to be true. To avoid this, always ensure all your Boolean fields are true when you
expect them to be, so they are properly pushed when editing other fields.
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■ When updating users by selecting update from an Identity Manager organization, users with
a Sun One ID Server account will get an error if those users were created natively and loaded
into Identity Manager (ID-7094). The work around is to update those users individually.

■ Identity Manager still contains the following deprecated classes:
■ com.waveset.object.IAPI
■ com.waveset.object.IAPIProcess
■ com.waveset.object.IAPIUser

Custom adapter classes should no longer refer to these classes, and should instead refer
to the corresponding classes in package com.waveset.adapter.iapi. (ID-8246)

■ If you leave the New Resource Object wizard without clicking the Save or Cancel button, the
abandoned form may not be destroyed and may interfere with the creation of subsequent
new resource objects. (ID-11033) This leads to an error that says

No resource form id found in options or view.

Workaround: Always use the Cancel button to abandon the New Resource Object wizard.
■ If you edit a user while you are also running Active Sync as a different administrator, an

Active Sync exception occurs. Because the user is locked by another administrator, Active
Sync cannot retry the process. (ID-11255)
Workaround: To enable Active Sync retry for a resource, update the resource XML to
include these two additional resource attributes, in the following format:

<ResourceAttribute name=’syncRetryCountLimit’ type=’string’

multi=’false’facets=’activesync’ value=’180’/>

<ResourceAttribute name=’syncRetryInterval’ type=’string’ multi=’false’

facets=’activesync’ value=’10000’/>

Where:
■ syncRetryCountLimit is the number of times to retry the update.
■ syncRetryInterval is the number of milliseconds to wait between retries.

Subsequently, these values will appear as custom resource settings when you configure
Active Sync. Specifying a displayName is advisable; using a custom catalog key if
localization is necessary.

■ If a password for a user on all systems that are part of the CUA landscape is not in sync,
changing the password might fail on child systems that are out-of-sync. This will occur only
when the administrator sets a productive, not expired, password for the user, or the user
changes the password himself. Under all other circumstances, the password change will
succeed even if the systems are out-of-sync. (ID-13396)
Workaround:First, set an expired password and then, through a second change, set the
productive password for the user.
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■ There are two known issues with the Remedy Integration template editor. (ID-14729)
■ The default Remedy Schema value "HPD:HelpDesk" is not appropriate for later versions

of BMC Remedy. Later versions do contain a schema "HPE:Help Desk".
■ The Choices columns is not displayed for some fields. This does not affect the ability to

use Remedy templates.
■ A regression causes Identity Manager password synchronization to fail when used with Sun

Java SystemDirectory Server Enterprise Edition 6.0, 6.1, and 6.2. The failure will be
corrected in the Directory Server 6.3 release. If versions 6.0, 6.1, or 6.2 are required to work
with Identity Manager, please request a Directory Server hotfix from Support, referencing
Directory Server bug 6604342. (ID-14895)

■ When you expand the resource objects of a Sun Java System Access Manager 7.0 resource
from the Resources tab, you might see the following error: (ID-15525)

Error listing objects. ==> com.waveset.util.WavesetException:

Error trying to get attribute value for attribute ’guid’.

==> java.lang.IllegalAccessError: tried to access method

com.sun.identity.idm.AMIdentity.getUniversalId()Ljava/lang/String; from

class com.waveset.adapter.SunAccessManagerRealmResourceAdapter

This error occurs on Access Manager 7.0 resources that have not had any patches applied.
To fix this problem, you must apply at least Patch 1 of Access Manager, and then rebuild and
redeploy the Access Manager client SDK.

■ NDS/Groupwise users created by Identity Manager that possess the Access and AccountID
fields can appear to not have their corresponding values saved when inspected by certain
viewers within the NDS Console 1 application (for example, by selecting user’s properties
and then selecting the Groupwise tab). (ID-16330)

However, if the user’s Groupwise Diagnostic → Display Object "viewer" is used instead, the
field are then seen. Updates made by Identity Manager to the aforementioned fields do not
seem to be affected by this "viewer" bug.

■ WRQ looks though the classpath to discover its own entry. From that entry, WRQ computes
the directory where the JAR is stored, and then uses that directory to read the .JAW
(licensing file). However, both BEA and WebSphere use non-standard protocol names
(BEA uses zip, and WebSphere uses wsjar) rather than the standard JAR, which is the
protocol the WRQ code assumes exists. (ID-16709, 17319)

Workarounds:
■ For BEA, add the following option to the java command in the startWeblogic.sh file:

-Dcom.wrq.profile.dir="DirectoryContainingLibraries"

■ For WebSphere, add the com.wrq.profile.dir=DirectoryContainingLibraries
property to the WebSphere/AppServer/configuration/config.ini file.
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■ Before creating a new resource, be sure to enable the resource type in the list of configured
types. Otherwise, the newly created resource object may not have all the required fields.
(ID-17324)

■ The default value for the Make Directory resource attribute is inconsistent among the
different UNIX OS resource adapters. For AIX, user creates always result in the home
directory being created, and consequently this value is not present. For the Linux adapters,
this value is set to “true” by default. For Solaris and HP-UX adapters, the default is set to
“false”. (ID-18301)

■ If an external resource assignment is pending provisioning, and you rename the user to
whom that work item was escalated, the provisioning task will finish without escalating to
the renamed user. (ID-19897)

■ When pass-through authentication is configured between Identity Manager and OpenSSO
server (Sun Access Manager Realm Resource adapter), authentication may fail if you use the
'%' character in passwords. For more information on this issue, see
https://opensso.dev.java.net/issues/show_bug.cgi?id=4122. (ID-20011)

■ The Domino gateway resource object create and update forms do not recognize non-default
group category values (that is, values other than “Administration” and “None”. The
Domino gateway resource object update form will display an error when editing a group
that uses non-default category values. (ID-20212)

■ The Active Directory connector does not display localized messages if the browser language
is set to a value without cntry, such as ja. (ID-20255)
Workaround: Select a language with a cntry value, such as ja-JP on the browser or specify
cntry=JP as a URL parameter when you log into Identity Manager. For example,
http://host:port/idm/login.jsp?lang&cntry=ja=JP

■ If you are migrating an Active Directory adapter-based resource to an Active Directory
connector-based resource, you must edit any associated resource actions to include the
execMode attribute. Valid values for this attribute are connector and resource, but for
Active Directory, if you are using the SHELL action type, resource is the only valid value.
(ID-20534)
For example, where previous implementations of a resource action would have this line: <
<ResTypeAction restype=’Windows Active Directory’ actionType=’SHELL’>

you must add the following line if you are using the Active Directory connector:
<ResTypeAction restype=’Windows Active Directory’ actionType=’SHELL’

execMode=’resource’>

Resources

Chapter 4 • Known Issues 65



Roles
■ Role status is not updated immediately on Role List page. (ID-20259)

Workaround: Reload the page or click Clear.

SPML
■ SPML2 search responses that include iterators may include inconsistent result items if the

search request uses the Substrings filter item. (ID-20328)

Sun Identity Manager Gateway
■ The gateway occasionally will not stop when using net stop “Sun Identity Manager

Gateway“ (ID-2337).
■ Under some circumstances, the gateway does not stop cleanly when stopped from the

Services Console on Windows (any supported Windows version). In response, Identity
Manager displays a dialog box with a message that indicates that the gateway did not
respond in a timely fashion. If you dismiss the dialog box, Identity Manager indicates that
the gateway has stopped. If you use the command-line equivalent, net stop <service
name>, Identity Manager indicates that an exception has occurred. Note that in both cases,
the gateway has stopped. (ID-20296)
Workaround: Use the command line gateway -k to stop the gateway service.

Tasks
■ The Find Task page does not display the number of tasks matching the search criteria

(ID-5152).
■ Delegated administrators who do not control Top can schedule tasks and view the task

results, but cannot view the task after it has been created (ID-6659). The scheduled task was
placed in Top and the delegated administrator does not have rights to view the object.

Workflows, Forms, Rules, and XPRESS
■ You cannot use the XPRESS <eq> function to compare Boolean values to TRUE or FALSE

strings or to the integers 1 or 2 (ID-3904).
Workaround: Use the following

<cond>

<isTrue><ref>Boolean_variable</ref></isTrue>

Roles
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<s>True action</s>

<s>False action</s>

</cond>

■ Path expressions do not work when iterating a list of generic objects via a dolist (ID-4920).

<dolist name=’genericObj’>
<ref>listOfGenericObjects</ref>

<ref>genericObj.name</ref>

</dolist>

Workaround: Use <get> / <set> as shown:

<dolist name=’genericObj’>
<ref>listOfGenericObjects</ref>

<get><ref>genericObject</ref><s>name</s>

</dolist>

■ If you use global.attrname variables for fields in your user form, and the attribute is shared
among more than one resource, you should also define a Derivation rule (ID-5074).
Otherwise, if the attribute has been changed natively on one of the resources, the attribute
may or may not be picked up and propagated to the other resources.

■ You cannot use special strings beginning with “&” in HTML components of forms. For
example, &nbsp; will no longer appear as a space. This issue was introduced because of a
change to support special characters (&<>’) in Select lists. (ID-5548)

■ Form, workflow and rule comments contained in <Comment> tags have &#xA; strings in
them representing the line feed character (ID-6243). These characters are seen only when
viewing the XML for these objects; the Identity Manager server will process these characters
properly.

■ If you use the Resource Table User Form for editing users, when editing a user’s resource,
the resource attributes are not fetched when the form first appears.
Workaround: Click the Refresh button, which will fetch the attribute data. (ID-10551)

■ If Identity Manager is protected by a Sun Java System Access Manager Policy Agent,
workflow process diagrams might render incompletely. (ID-18304)

Workflows, Forms, Rules, and XPRESS
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Installation and Upgrade Notes

This section provides information related to installing or updating Identity Manager. The
information is organized as follows:
■ “Installation Notes” on page 69
■ “Upgrade Notes” on page 70

Installation Notes

Note – Refer to Sun Identity Manager 8.1 Installation for detailed product installation
instructions.

■ When installing Identity Manager do not mix JDKs from different vendors . For example, if
you are running Identity Manager using the IBM JDK on WebSphere, use the IBM JDK to
install Identity Manager. Do not use JDKs from different vendors because data encrypted
under one JDK cannot be read by a JDK from another vendor. (ID-17800)

■ The Identity Manager installer may not run with a 64-bit JDK. (ID-18534)
Workarounds:
■ Install manually.
■ Use a 32-bit version JDK to run the installer.
■ Set os.arch=ppc by setting JAVA_OPTS (used by the install script) to get through the

install. For example,

export JAVA_OPTS="-Dos.arch=ppc"
install

■ Or, if JAVA_OPTS already contains needed options:

export JAVA_OPTS="$JAVA_OPTS -Dos.arch=ppc"
install

5C H A P T E R 5
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Upgrade Notes
This section contains information and known issues related to upgrading Identity Manager
from versions 6.0, 7.0, 7.1, 7.1.1, or 8.0 to version 8.1.

The information in this section is organized as follows:

■ “Before You Begin” on page 70
■ “Upgrade Notes if You are Upgrading From Version 6.0” on page 71
■ “Upgrade Notes if You are Upgrading From Version 7.0” on page 71
■ “Upgrade Notes if You are Upgrading From Version 7.1” on page 72
■ “Upgrade Notes if You are Upgrading From Version 7.1.1” on page 74
■ “Upgrade Notes if You are Upgrading From Version 8.0” on page 76

Before You Begin
Be aware of the following information before starting the upgrade process:

■ See Sun Identity Manager 8.1 Upgrade for comprehensive upgrade instructions.
■ If you upgrade your JDK or JRE, you must use a JDK or JRE supplied by the same vendor as

your previous JDK. For example, do not install a Sun JDK if previously you were using a JDK
from IBM. If you mix JDKs from different vendors, data encrypted under a previous JDK
cannot be read by a JDK from another vendor. (ID-17800)

■ Upgrade Identity Manager in the following order:
1. Upgrade all Identity Manager server instances and Gateway instances
2. Upgrade all PasswordSync instances

The 8.1 version of Identity Manager server provides limited, temporary support for older
versions of PasswordSync. This support is provided so that Identity Manager can continue
to run while you upgrade your PasswordSync instances. All instances of PasswordSync
should be updated to the same version as the Identity Manager server as soon as possible.

■ When uninstalling PasswordSync, use the add/modify programs feature from the Windows
Control Panel to ensure correct removal. You must reboot after uninstalling.
When installing PasswordSync, use the appropriate binary file for the operating system on
which you are installing. The binary for 32-bit Windows is called IdmPwSync_x86.msi and
the binary for 64-bit Windows is called IdmPwSync_x64.msi. After each PasswordSync
installation you must reboot.

■ Be sure to use only one Identity Manager server to import update.xml.
■ During an upgrade, only one Identity Manager server should be running. If you start any

other Identity Manager servers during the upgrade, you must stop and restart those servers
before making them available. Note that changes to RepositoryConfiguration do not
affect an Identity Manager server until you restart that server.

Upgrade Notes
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■ If the upgrade process fails to log in with the default configurator account and password, the
log file logs the error, but does not log anything after the error. (ID-18929)
The update.xml file is imported during the upgrade process. The import attempts to log in
as configurator with the default password. If the login fails, an error is displayed, and the
upgrade program prompts you for the correct login information. If you provide the correct
information, the upgrade continues. When looking through the log file for the upgrade
process, you can see the error message when the default log in fails, but you do not see any
further information about the upgrade in the log file. This issue does not affect the upgrade,
only the log file.

■ If your current Identity Manager installation has a large amount of custom work, consider
contacting Sun Professional Services for assistance with planning and executing your
upgrade.

Upgrade Notes if You are Upgrading From Version 6.0
If planning a skip-level upgrade, be sure to also review the upgrade notes in the following
sections. Upgrade notes for subsequent versions of Identity Manager also apply to your
upgrade.

■ If you are upgrading from an Identity Manager version 6.x installation and you want to start
using the new Identity Manager end-user pages, you must manually change the system
configuration ui.web.user.showMenu to true for the horizontal navigation bar to display.
(ID-14901)
Also, if you want the new end-user dashboard to display on the end-user home page, you
must manually change the end-user form mapping for Form Type endUserMenu. Go to
Configure > Form and Process Mapping > for Form Type ’endUserMenu’. Change the Form
Name Mapped To to be End User Dashboard.
You should also update the mapping for Form Type endUserWorkItemListExt. Change the
Form Name Mapped To to be End User Approvals List.

■ If you are upgrading from version 6.0 and using LocalFiles, you must export all of your
data before upgrading and then re-import the data after doing a clean installation of 8.1.
(ID-15366)

Upgrade Notes if You are Upgrading From Version 7.0
If planning a skip-level upgrade, be sure to also review the upgrade notes in the following
sections. Upgrade notes for subsequent versions of Identity Manager also apply to your
upgrade.

■ If you are upgrading from version 7.0 and using LocalFiles, you must export all of your
data before upgrading and then re-import the data after doing a clean installation of 8.1.
(ID-15366)

Upgrade Notes

Chapter 5 • Installation and Upgrade Notes 71



■ There may be ItemNotFound Exceptions in the upgrade log due to Identity Manager Service
Provider Edition (SPE) objects being renamed to Identity Manager Service Provider.
(ID-18860)

■ If your installation contains a Remedy resource, you must place Remedy API libraries in the
directory where the Gateway is installed. These libraries can be found on the Remedy server.

TABLE 5–1 Remedy API Libraries

Remedy 4.x and 5.x Remedy 6.3 Remedy 7.0

■ arapiXX.dll

■ arrpcXX.dll

■ arutlXX.dll
where XX matches the version of
Remedy. For example, arapi45.dll
on Remedy 4.5.

■ arapi63.dll

■ arrpc63.dll

■ arutl63.dll

■ icudt20.dll

■ icuin20.dll

■ icuuc20.dll

■ arapi70.dll

■ arrpc70.dll

■ arutl70.dll

■ icudt32.dll

■ icuin32.dll

■ icuuc32.dll

Upgrade Notes if You are Upgrading From Version 7.1
If planning a skip-level upgrade, be sure to also review the upgrade notes in the following
sections. Upgrade notes for subsequent versions of Identity Manager also apply to your
upgrade.

■ As of version 7.1.1, Identity Manager User Extended Attributes fully support multi-valued
attributes. (ID-14863)

Note – You can add a multi-valued user extended attribute to the accounts list table, and it
will render the list without error. However, attempting to sort on that column will yield the
following error:

java.lang.ClassCastException: java.util.ArrayList

An attribute condition that refers to a multi-valued extended attribute will evaluate
correctly for a user object only after that user object has been re-serialized. If you want such
an attribute condition to evaluate correctly for all user objects, then you must re-serialize all
user objects. See Refreshing User Objects in the following section for instructions.

Refreshing User Objects
Certain types of changes require an administrator to refresh all User objects. For example, you
must refresh all User objects when you change the inline attributes for Type.USER in
RepositoryConfiguration. Whenever you mark an attribute as queryable or summary in the

Upgrade Notes
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IDMSchemaConfiguration object, you must refresh all User objects for the change to affect
older, unmodified objects. The same logic applies when a new version of Identity Manager adds
a new attribute, or when a new version of Identity Manager changes the values of an existing
attribute— the upgrade process or an administrator must refresh all User objects for the change
to affect older, unmodified objects.

There are three ways to reserialize existing users:

■ Modify an individual User object during normal operations.

For example, opening a user account through the user interface and saving it with or
without modifications.

Disadvantage: This method is time-consuming, and the administrator must be meticulous
to ensure all existing users are reserialized.

■ Use the lh refreshType utility to reserialize all users. The refreshType utility’s output is a
refreshed list of users.

lh console

refreshType User

Disadvantage: Because the refreshType utility runs in the foreground and not the
background, this process can be time-consuming. If you have a lot of users, reserializing
them all takes a long time.

■ Use the Deferred Task Scanner.

Note – Before running the Deferred Task Scanner process, you must edit the System
Configuration object using the Sun Identity Manager Integrated Development
Environment (IDE) or some other method.

Search for ’refreshOfType’ and remove the attributes for
’2005Q4M3refreshOfTypeUserIsComplete’ and
’2005Q4M3refreshOfTypeUserUpperBound’.

After editing the System Configuration object, you must import that object to repository
for your changes to be present.

Disadvantage: This method causes the next Deferred Task Scanner run to take a long time
because it examines and rewrites almost every User object. However, subsequent Deferred
Task Scanner runs should execute at normal speed and duration.

Upgrade Notes
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Upgrade Notes if You are Upgrading From Version
7.1.1
If planning a skip-level upgrade, be sure to also review the upgrade notes in the following
sections. Upgrade notes for subsequent versions of Identity Manager also apply to your
upgrade.

■ If you are using an Oracle repository, the Identity Manager 8.0 and 8.1 repository DDL uses
data types that are not properly handled by older Oracle JDBC drivers. The JDBC drivers in
ojdbc14.jar do not properly read all of the columns in the log table.
You must upgrade to the ojdbc5.jar for JDK 5 drivers for Identity Manager to work
properly.

■ Upgrading automatically converts the User Extended Attributes object and
QueryableAttrNames and SummaryAttrNames elements of the UserUIConfig object into the
IDM Schema Configuration object. (ID-17784)
The sample update.xml script contains an import command that invokes
IDMSchemaConfigurationUpdater to convert legacy user schema configuration objects.
Successful conversion of legacy user schema configuration objects performs the following:
■ Creates within IDM Schema Configuration an IDMObjectClassAttribute element for

each extended attribute name from User Extended Attributes.
■ Flags as ”summary’ any IDMObjectClassAttribute that corresponds to each value from

the SummaryAttrNames element within UserUIConfig.
■ Flags as ”queryable’ any IDMObjectClassAttribute that corresponds to each value from

the QueryableAttrNames element within UserUIConfig.
■ Empties the SummaryAttrNames element within UserUIConfig.
■ Empties the QueryableAttrNames element within UserUIConfig.
■ Renames any extended attribute named objectClass to spml2ObjectClass. Starting in

version 8.0, legacy attributes named objectClass conflict with a core attribute in the
Identity Manager schema.

■ Identity Manager 8.0 dedicated some new tables for Roles objects. You must use the sample
scripts provided in the db_scripts directory to make the schema changes, create the new
table structures, and move your existing data.

Tip –

■ Before updating the repository database table definitions, make a full backup of your
repository tables.

■ Refer to the db_scripts/upgradeto8.0from71.DBMSName script for more
information.

Upgrade Notes
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■ Be careful when you edit the super role field in the Role form because the super role itself
may be a nested role. The super roles and subroles fields indicate a nesting of roles and their
associated resources or resource groups. When applied to a user, the super role includes the
resources associated with any designated subrole. The super role field is displayed to
indicate the roles that include the displayed role.

■ During the upgrade process, Identity Manager analyzes all roles on the system and then
updates any missing subroles and super roles links using the RoleUpdater class.

To check and upgrade roles outside of the upgrade process, you can import the new
RoleUpdater configuration object that is provided in sample/forms/RoleUpdater.xml.

For example:

<?xml version=’1.0’ encoding=’UTF-8’?>

<!DOCTYPE Waveset PUBLIC ’waveset.dtd’ ’waveset.dtd’>

<Waveset>

<ImportCommand class=’com.waveset.session.RoleUpdater’ >

<Map>

<MapEntry key=’verbose’ value=’true’ />

<MapEntry key=’noupdate’ value=’false’ />

<MapEntry key=’nofixsubrolelinks’ value=’false’ />

</Map>

</ImportCommand>

</Waveset>

Where:
■ verbose: Provides verbose output when updating roles. Specify false to enable a silent

update of roles.
■ noupdate: Determines whether the roles are updated. Specify false to get a report that

only lists which roles will be updated.
■ nofixsubrolelinks: Determines whether super roles are updated with missing subrole

links. This value is set to false by default and links will be repaired.
■ Administrators who need to view or edit the Identity Manager schema for Users or Roles

must be in the IDM Schema Configuration AdminGroup and must have the IDM Schema
Configuration capability.

■ The SPML 2.0 implementation in Identity Manager changed in Sun Identity Manager 8.0. In
previous releases, the SPML objectclass attribute used in SPML messages was mapped
directly to the objectclass attribute of Identity Manager User objects. The objectclass
attribute is now mapped internally to the spml2ObjectClass attribute and is used internally
for other purposes.
During the upgrade process the objectclass attribute value is automatically renamed for
existing users. If your SPML 2.0 configuration contains forms that reference the
objectclass attribute, you must manually change those references to spml2ObjectClass.
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Identity Manager does not replace the sample spml2.xml configuration file during an
upgrade. If you used the spml2.xml configuration file as a starting point, be aware that this
file contains a form with references to objectclass that you must change to
spml2ObjectClass. Change the objectclass attribute in forms (where it is used
internally), but do not change the objectclass attribute in the target schema (where the
attribute is exposed externally).

■ When you upgrade Identity Manager, any custom code that calls
UserUIConfig#getRepoIndexAttributes() must be removed or changed to call
Type.USER#getInlineAttributeNames(). (ID-18051)
Importing update.xml converts the values from the UserUIConfig RepoIndexAttrs into
values of XML attributes on the TypeDataStore element for Type.USER within the
RepositoryConfiguration object. The update.xml file includes the
UserUIConfigUpdater.xml file, which contains an import command that invokes
UserUIConfigUpdater to convert RepoIndexAttrs. Conversion also sets a flag in
SystemConfiguration that inhibits reconversion.
Any future changes to the inline attributes for Type.USER should be made by editing the
RepositoryConfiguration object. If you change the inline attributes for Type.USER, you
generally must refresh all Type.USER objects.

Note – Changes to RepositoryConfiguration do not affect an Identity Manager server until
you restart that server.

Upgrade Notes if You are Upgrading From Version 8.0
■ Sun Identity Manager 8.0 changed the display method of charts and graphs in reports.

Reports created prior to version 8.0 display as expected in the version 8.0 release. These
reports, however, will not display properly in Sun Identity Manager 8.1. A deprecation
notice regarding this issue appeared in the Sun Identity Manager Release Notes, Version 8.0
May 2008. (ID-17636)

■ Forms and workflows that use the SaveNoValidate action will need to be added to the new
saveNoValidateAllowedFormsAndWorkflows list. (ID-19115)
Whitelist functionality added in Sun Identity Manager 8.1 checks forms and workflows that
use the SaveNoValidate action against a list of IDs of form names. The
saveNoValidateAllowedFormsAndWorkflows list is located in the security attribute in the
System Configuration object. With this update, if the form name or owner ID is on the
whitelist, the form or workflow can use the SaveNoValidate action. If the form name or the
owner ID is not on the list, the form or workflow is processed using a Save action.
To obtain the IDs or form names for forms and workflows that use the SaveNoValidate
action, check the system log or turn on trace level 4 for
com.waveset.ui.util.GenericEditForm and submit any custom forms or workflows that
use SaveNoValidate. A warning including the ID will be logged.
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Note – If you add a form name to the whitelist, be sure that the name attribute for the form is
set, otherwise you will see the following error message:

SaveNoValidate on null processed as Save because it is not

in the saveNoValidateAllowedFormsAndWorkflows list.
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Deprecated APIs

This section lists all Identity Manager Application Programming Interfaces (APIs) deprecated
since Identity Manager 6.0 2005Q4M3 and their replacements (if available).

This information is organized into the following sections:

■ “Deprecated Java Classes, Methods, and Fields” on page 79
■ “Deprecated JSP Files and URLs” on page 103
■ “Deprecated Configuration Objects” on page 103
■ “Deprecated Views and Path Expressions” on page 103

Note –

■ MultiSelect and TreeTable applet support will be discontinued in the next major Identity
Manager release; however, similar functionality will be maintained. (ID-18785)

■ Identity Manager release 2005Q4M3 deprecated the com.waveset.util.Trace and
com.waveset.util.ITrace classes (in favor of the com.sun.idm.logging.Trace and
com.sun.idm.logging.TraceManager classes). Many undeprecated classes still refer to
these deprecated classes to preserve backward compatibility with any custom code that
extends the undeprecated classes and may rely on an inherited reference to one of the
deprecated classes. You should remove any references to either of these deprecated classes
from your custom code. A future release will remove the deprecated classes. (ID-11878)

Deprecated Java Classes, Methods, and Fields
The following table lists deprecated classes, methods, and fields and their replacements, when
available. The table is sorted by class name, and all classes, methods, and fields are listed using
JavaDoc syntax.
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Deprecated Replacement

com.sun.idm.idmx.IDMXContext com.waveset.object.LighthouseContext

com.sun.idm.idmx.IDMXContextFactory com.waveset.session.SessionFactory

com.sun.idm.idmx.sync.util.CaseInsensitiveStringComparator java.lang.String.CASE_INSENSITIVE_ORDER

com.waveset.adapter.AccessManagerResourceAdapter
#handlePDException(Exception)

com.waveset.adapter.AccessManagerResourceAdapter
#handlePDException(PDException)

com.waveset.adapter.ACF2ResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.ActivCardResourceAdapter

com.waveset.adapter.ActiveDirectoryActiveSyncAdapter com.waveset.adapter.ADSIResourceAdapter

com.waveset.adapter.ActiveSync#RA
_PARAMETERIZED_INPUT_FORM

com.waveset.adapter.ActiveSync
#RA_SYNC_CONFIG_MODE

com.waveset.adapter.ActiveSync
#RA_SYNC_POST_PROCESS_FORM

com.waveset.adapter.ActiveSync
#RA_UPDATE_IF_DELETE

com.waveset.adapter.ActiveSync
#RA_USE_INPUT_FORM

com.waveset.adapter.ActiveSyncUtil
#getLogFileFullPath()

com.waveset.adapter.AD_LDAPResourceAdapter com.waveset.adapter.LDAPResourceAdapter

com.waveset.adapter.ADSIResourceAdapte
r#buildEvent(UpdateRow)

com.waveset.adapter.iapi.IAPIFactory#getIAPI
(Map,Map,ResourceAdapterBase)

com.waveset.adapter.ADSIResourceAdapter
#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapter#getBaseContexts()

com.waveset.adapter.ADSIResourceAdapter
#RA_UPDATE_IF_DELETE

com.waveset.adapter.ActiveSync#RA_DELETE_RULE

com.waveset.adapter.AgentResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.AIXResourceAdapter.BlockAcctIter References to this class should be replaced with an AccountIterator
based on the Supplier model. For example
BufferedAccountQueue(new AIXAccountSupplier).
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Deprecated Replacement

com.waveset.adapter.AuthSSOResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.BlackberryResourceAdapter com.waveset.adapter.ScriptedGatewayResourceAdapter

com.waveset.adapter.ClearTrustResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.ConfirmedSync References to this class should be replaced with an AccountIterator
based on the Supplier model. For example
BufferedAccountQueue(new LinuxAccountSupplier).

com.waveset.adapter.DatabaseTableResourceAdapter
#RA_PROCESS_NAME

com.waveset.adapter.ActiveSync#RA_PROCESS_RULE

com.waveset.adapter.DblBufIterator com.waveset.util.BufferedIterator

com.waveset.util.BlockIterator

com.waveset.adapter.AccountIteratorWrapper

com.waveset.adapter.DB2ResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.DominoActiveSyncAdapter com.waveset.adapter.DominoResourceAdapter

com.waveset.adapter.DominoResourceAdapter
#buildEvent(UpdateRow)

com.waveset.adapter.iapi.IAPIFactory#getIAPI
(Map,Map,ResourceAdapterBase)

com.waveset.adapter.DominoResourceAdapter
#RA_UPDATE_IF_DELETE

com.waveset.adapter.ActiveSync#RA_DELETE_RULE

com.waveset.adapter.DominoResourceAdapter
#USER_DEPARTMENY

USER_DEPARTMENT

com.waveset.adapter.Exchange55ResourceAdapter

com.waveset.adapter.ExampleTableResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.GenericScriptResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.GetAccessResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.HostConnectionPool
#getConnectionHostAccessLogin)

com.waveset.adapter.HostConnPool#getAffinity
Connection(HostAccessLogin)

com.waveset.adapter.HostConnectionPool
#releaseConnection(HostAccess)

com.waveset.adapter.HostConnPool#releaseConnection
(HostAccess)
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Deprecated Replacement

com.waveset.adapter.HostConnectionPool
#releaseConnection(IHostAccess)

com.waveset.adapter.HostConnPool#release
Connection(IHostAccess)

com.waveset.adapter.HostConnPool
#getConnection(HostAccessLogin)

com.waveset.adapter.HostConnPool#getAffinity
Connection(HostAccessLogin)

com.waveset.adapter.HostConnPool#putFree()

com.waveset.adapter.iapi.IAPIFactory.AbstractFactory
.getIAPIProcess(Map, Map, String, Resource)

As of Identity Manager 5.0SP1, use IAPIProcess(Map, Map, String,
ResourceAdapter) or you will not have the LighthouseContext
initialization. For backward compatibility, this factory supplies its
default LighthouseContext to the constructed IAPIProcess.

com.waveset.adapter.iapi.IAPIFactory.AbstractFactory
.getIAPIUser(Map, Map, String, Map)

getIAPIUser(Map, Map, String, ResourceAdapter,
LighthouseContext)

com.waveset.adapter.iapi.IAPIFactory.AbstractFactory
.getIAPIUser(Map, Map, String, Resource)

getIAPIUser(Map, Map, String, ResourceAdapter,
LighthouseContext)

com.waveset.adapter.iapi.IAPIFactory.getIAPIProcess
(Map, Map, String, Resource)

As of Identity Manager 5.0SP1, use IAPIProcess(Map, Map, String,
ResourceAdapter) or you will not have the LighthouseContext
initialization. For backward compatibility, this factory supplies its
default LighthouseContext to the constructed IAPIProcess.

com.waveset.adapter.iapi.IAPIFactory.getIAPIUser
(Map, Map, String, Map)

As of Identity Manager 5.0SP1, use getIAPIUser(Map, Map,
String, ResourceAdapter) or you will not have the
LighthouseContext initialization. For backward compatibility, this
factory supplies its default LighthouseContext to the constructed
IAPIProcess.

com.waveset.adapter.iapi.IAPIFactory.getIAPIUser
(Map, Map, String, Resource)

As of Identity Manager 5.0SP1, use getIAPIUser(Map, Map,
String, ResourceAdapter) or you will not have the
LighthouseContext initialization. For backward compatibility, this
factory supplies its default LighthouseContext to the constructed
IAPIProcess.

com.waveset.adapter.HostConnPool#putFree(IHostAccess) com.waveset.adapter.HostConnPool#putAffinityFree

com.waveset.adapter.iapi.IAPIFactory#getIAPIProcess
(Map,Map,String,Resource)

com.waveset.adapter.iapi.IAPIFactory#getIAPI
(Map,Map,String,ResourceAdapterBase)

com.waveset.adapter.iapi.IAPIFactory#getIAPIProcess
(Element)

com.waveset.adapter.iapi.IAPIFactory#getIAPIUser
(Element)

com.waveset.adapter.iapi.IAPIFactory#getIAPIUser
(Map,Map,String,Map)

com.waveset.adapter.iapi.IAPIFactory#getIAPI
(Map, Map, String, ResourceAdapterBase)
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Deprecated Replacement

com.waveset.adapter.iapi.IAPIFactory#getIAPIUser
(Map,Map,String,Resource)

com.waveset.adapter.iapi.IAPIFactory#getIAPI
(Map,Map,String,ResourceAdapterBase)

com.waveset.adapter.IDMResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.INISafeNexessResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.LDAPChangeLogActiveSyncAdapter com.waveset.adapter.LDAPResourceAdapter

com.waveset.adapter.LDAPListenerActiveSyncAdapter com.waveset.adapter.LDAPChangeLogActiveSyncAdapter

com.waveset.adapter.LDAPResourceAdapterBase
#addUserToGroup(LDAPObject,String,String)

com.waveset.adapter.LDAPResourceAdapterBase
#addUserToGroup(String,String,String)

com.waveset.adapter.LDAPResourceAdapterBase
#buildBaseUrl()

com.waveset.adapter.LDAPResourceAdapterBase
#buildBaseUrl(String)

com.waveset.adapter.LDAPResourceAdapterBase
#buildEvent(UpdateRow)

com.waveset.adapter.LDAPResourceAdapterBase
#getAccountAttributes(String)

com.waveset.adapter.LDAPResourceAdapterBase
#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapter#getBaseContexts()

com.waveset.adapter.LDAPResourceAdapterBase
#getGroups(Name,String,Vector,Vector)

com.waveset.adapter.LDAPResourceAdapterBase
#getGroups(String,String,Vector,Vector)

com.waveset.adapter.LDAPResourceAdapterBase
#getLDAPAttributes(String,DirContext[],String)

com.waveset.adapter.LDAPResourceAdapterBase
#getLDAPAttributes(String,DirContext,String,String[])

com.waveset.adapter.LDAPResourceAdapterBase
#getLDAPAttributes(String,DirContext[])

com.waveset.adapter.LDAPResourceAdapterBase
#getLDAPAttributes(String,DirContext,String,String[])

com.waveset.adapter.LDAPResourceAdapterBase
#RA_PROCESS_NAME

com.waveset.adapter.ActiveSync
#RA_PROCESS_RULE

com.waveset.adapter.LDAPResourceAdapterBase
#removeNameFromAttribute(DirContext,Name,Attribute)

com.waveset.adapter.LDAPResourceAdapterBase
#removeNameFromAttribute(DirContext,String,boolean,
Attribute)

com.waveset.adapter.LDAPResourceAdapterBase
#removeUserFromAllGroups
(Name,String,WavesetResult)

com.waveset.adapter.LDAPResourceAdapterBase
#removeUserFromAllGroups(String,boolean,
String,WavesetResult)
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com.waveset.adapter.LDAPResourceAdapterBase
#removeUserFromGroup(DirContext,Name,
String,String,Attributes)

com.waveset.adapter.LDAPResourceAdapterBase
#removeUserFromGroup(DirContext,String,
boolean,String,String,Attributes)

com.waveset.adapter.LDAPResourceAdapterBase
#removeUserFromGroups(Name,Vector,String,
WavesetResult)

com.waveset.adapter.LDAPResourceAdapterBase
#removeUserFromGroups(String,
boolean,Vector,String,WavesetResult)

com.waveset.adapter.LinuxResourceAdapter.
BlockAcctIter

com.waveset.adapter.MySQLResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.NaturalResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.NaturalResourceAdapter.getUser() com.waveset.adapter.NaturalResourceAdapter#affinity

com.waveset.adapter.NaturalResourceAdapter.login
(IHostAccess)

com.waveset.adapter.NaturalResourceAdapter
#login(IHostAccess,ServerAffinity)

com.waveset.adapter.NDSActiveSyncAdapter com.waveset.adapter.NDSResourceAdapter

com.waveset.adapter.NDSResourceAdapter
#buildEvent(UpdateRow)

com.waveset.adapter.NDSResourceAdapter
#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapter#getBaseContexts()

com.waveset.adapter.NISResourceAdapter

com.waveset.adapter.NTResourceAdapter

com.waveset.adapter.ONTDirectorySmartResource
Adapter#getAccountAttributes(String)

com.waveset.adapter.OS400ResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#DEFAULT_AUDIT_STAMP_FORMAT

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#DEFAULT_AUDIT_STAMP_START_DATE

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#getAccountAttributes(String)

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#getUpdateRows(UpdateRow)

com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#getUpdateRows(UpdateRow)
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com.waveset.adapter.PeopleSoftComponentActiveSync
Adapter#RA_AUDIT_STAMP_FORMAT

com.waveset.adapter.PeopleSoftResourceAdapter

com.waveset.adapter.RACFResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.RASecureConnection
#ExchangeAuth(boolean)

com.waveset.adapter.RASecureConnection
#ExchangeAuth(boolean,byte[])

com.waveset.adapter.RASecureConnection
(InetAddress, int, byte[])

#RASecureConnection(InetAddress, int, Map)

com.waveset.adapter.RASecureConnection.
ResetEncryption(byte[])

#resetEncryption(String, byte[])

com.waveset.adapter.RASecureConnection.
SendConnectionKey(byte[])

#SendConnectionKey(EncryptionKey)

SendConnectionKey sends a new encryption key to the remote
end. With a successful result, the session key changes to this new
key.

com.waveset.adapter.RASecureConnection
(Socket, byte[])

#RASecureConnection(Socket, Map)

com.waveset.adapter.RASecureConnection
(String, int, byte[])

#RASecureConnection(String, int, Map)

com.waveset.adapter.RemedyActiveSyncResourceAdapter com.waveset.adapter.RemedyResourceAdapter

com.waveset.adapter.RequestResourceAdapter ExternalResourceAdapter

com.waveset.adapter.RequestResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.ResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.ResourceAdapter
#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapter#getBaseContexts()

com.waveset.adapter.ResourceAdapterBase
#getAccountAttributes(String)

com.waveset.adapter.ResourceAdapterBase
#getAdapter(Resource,LighthouseContext)

com.waveset.adapter.ResourceAdapterBase
#getAdapterProxy(Resource,LighthouseContext)

com.waveset.adapter.ResourceAdapterBase
#getAdapter(Resource,ObjectCache,WSUser)

com.waveset.adapter.ResourceAdapterBase
#getAdapterProxy(Resource,ObjectCache)

com.waveset.adapter.ResourceAdapterBase
#getAdapter(Resource,ObjectCache)
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com.waveset.adapter.ResourceAdapterBase
#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapterBase
#getBaseContexts()

com.waveset.adapter.ResourceAdapterBase
#isExcludedAccount(String,Rule)

com.waveset.adapter.ResourceAdapterProxy#isExcluded
Account(String,Map,ResourceOperation,Rule)

com.waveset.adapter.ResourceAdapterBase
#isExcludedAccount(String)

com.waveset.adapter.ResourceAdapterProxy#isExcluded
Account(String,Map,ResourceOperation,Rule)

com.waveset.adapter.ResourceAdapterBase.
SimpleAccountIterator

Users of this class should switch to using the supplier model for
account iteration. A direct replacement for this class would be:
new BufferedAccountQueue(new
SimpleAccountSupplier(accounts));

com.waveset.adapter.ResourceAdapterProxy
#getAccountAttributes(String)

com.waveset.adapter.ResourceAdapterProxy
#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapterProxy#getBase
Contexts()

com.waveset.adapter.ResourceManager#getResourceTypes() com.waveset.adapter.ResourceManager#getResource
Prototypes()

com.waveset.adapter.ResourceManager#getResource
Prototypes(ObjectCache,boolean)

com.waveset.adapter.ResourceManager
#getResourceTypeStrings()

com.waveset.adapter.ResourceManager#getResource
PrototypeNames(ObjectCache)

com.waveset.adapter.SAPHRActiveSyncAdapter
#RA_NO_BAPI

To be removed when Before and After actions are available

com.waveset.adapter.SAPHRActiveSyncAdapter
#RA_PROCESS_NAME

com.waveset.adapter.ActiveSync#RA_PROCESS_RULE

com.waveset.adapter.SAPResourceAdapter#reverse
MapMultiAttr(String, Object, WSUser)

com.waveset.adapter.SAPResourceAdapter
#setUserField(JCO.Function, String)

Function#setUserField(String)

com.waveset.adapter.SAPResourceAdapter
#unexpirePassword(String,WavesetResult)

com.waveset.adapter.SAPResourceAdapter
#unexpirePassword(String,String,String,WavesetResult)

com.waveset.adapter.SAPResourceAdapter
#unexpirePassword(WSUser,WavesetResult)

com.waveset.adapter.SAPResourceAdapter
#unexpirePassword(String,String,String,WavesetResult)

com.waveset.adapter.SAPResourceAdapter
#AA_ACTIVITY_GROUP_OBJECTS_MAPNAME

AA_ACTIVITY_GROUPS_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_ACTIVITY_GROUPS_MAPNAME

AA_ACTIVITY_GROUPS_GENERIC_MAPNAME
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com.waveset.adapter.SAPResourceAdapter
#AA_ACTIVITY_GROUPS_SHADOW

AA_ACTIVITY_GROUPS_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_BAPI_CUA_SYSTEMS_SHADOW

AA_BAPI_CUA_SYSTEMS_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_DIRECT_ACTIVITY_GROUPS_SHADOW

com.waveset.adapter.SAPResourceAdapter
#AA_DIRECT_LOCAL_ACTIVITYGROUP_OBJECTS

AA_ACTIVITY_GROUPS_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_DIRECT_LOCAL_ACTIVITYGROUPS

AA_ACTIVITY_GROUPS_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_DIRECT_LOCAL_PROFILE_OBJECTS

AA_PROFILES_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_DIRECT_LOCAL_PROFILES

AA_PROFILES_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_DIRECT_PROFILES_SHADOW

com.waveset.adapter.SAPResourceAdapter
#AA_LOCAL_ACTIVITYGROUPS

AA_ACTIVITY_GROUPS_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_LOCAL_PROFILES

com.waveset.adapter.SAPResourceAdapter
#AA_PROFILES_MAPNAME

AA_PROFILES_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#AA_PROFILES_SHADOW

AA_PROFILES_GENERIC_MAPNAME

com.waveset.adapter.SAPResourceAdapter
#ACTIVITY_COMPOUND_NAME

com.waveset.adapter.SAPResourceAdapter
#ACTIVITY_GROUP_FROM_DATE

com.waveset.adapter.SAPResourceAdapter
#ACTIVITY_GROUP_NAME

com.waveset.adapter.SAPResourceAdapter
#ACTIVITY_GROUP_TO_DATE

com.waveset.adapter.SAPResourceAdapter
#PROFILE_COMPOUND_NAME
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com.waveset.adapter.SAPResourceAdapter
#PROFILE_FROM_DATE

com.waveset.adapter.SAPResourceAdapter
#PROFILE_NAME

com.waveset.adapter.SAPResourceAdapter
#PROFILE_TO_DATE

com.waveset.adapter.ScriptedConnection.Script
#hasNextToken()

com.waveset.adapter.ScriptedConnection.Script
#nextToken()

com.waveset.adapter.ScriptedConnection.Scripted
Connection#disConnect()

com.waveset.adapter.ResourceConnection#disconnect()

com.waveset.adapter.ScriptedConnection.Scripted
ConnectionFactory#getScriptedConnection
(String,HashMap)

com.waveset.adapter.ScriptedConnectionPool
#getConnection(HashMap,String,long,boolean)

com.waveset.adapter.ScriptedConnection.
SSHConnection#disConnect()

com.waveset.adapter.ScriptedConnection.
SSHConnection#disconnect()

com.waveset.adapter.ScriptedConnection.
TelnetConnection#disConnect()

com.waveset.adapter.ScriptedConnection.
TelnetConnection#disconnect()

com.waveset.adapter.ScriptedHostResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.SkeletonActiveSyncAdapter

com.waveset.adapter.SkeletonResourceAdapter

com.waveset.adapter.SkeletonResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.SMEResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.SQLServerResourceAdapter com.waveset.adapter.MSSQLServerResourceAdapter

com.waveset.adapter.SunAccessManager
ResourceAdapter#getAccountAttributes(String)

com.waveset.adapter.SunAccessManager
ResourceAdapter#getBaseContextAttrName()

com.waveset.adapter.ResourceAdapter#getBaseContexts()

com.waveset.adapter.SVIDResourceAdapter.BlockAcctIter References to this class should be replaced with an AccountIterator
based on the Supplier model. For example
BufferedAccountQueue(new SVIDAccountSupplier).
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com.waveset.adapter.SybaseResourceAdapter com.waveset.adapter.SybaseASEResourceAdapter

com.waveset.adapter.TestResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.TopSecretActiveSyncAdapter com.waveset.adapter.TopSecretResourceAdapter

com.waveset.adapter.TopSecretResourceAdapter
#hasError(String,String)

com.waveset.adapter.TopSecretResourceAdapter
#hasError(String,String,String)

com.waveset.adapter.TopSecretResourceAdapter
#login(HostAccess hostAccess)

com.waveset.adapter.TopSecretResourceAdapter
#login(HostAccess,ServerAffinity)

com.waveset.adapter.TopSecretResourceAdapter
#login(IHostAccess hostAccess)

com.waveset.adapter.TopSecretResourceAdapter
#login(IHostAccess hostAccess,ServerAffinity affinity)

com.waveset.adapter.VerityResourceAdapter
#getAccountAttributes(String)

com.waveset.adapter.XMLResourceAdapter
#getAccountAttributes(String)

com.waveset.exception.ConfigurationError com.waveset.util.ConfigurationError

com.waveset.exception.IOException com.waveset.util.IOException

com.waveset.exception.XmlParseException com.waveset.util.XmlParseException

com.waveset.extractor.CSVFormatter com.sun.idm.changelog.CSVFormatter

com.waveset.msgcat.Catalog#getMessage
(String,Object[],Locale)

com.waveset.msgcat.Catalog#format (Locale,String,Object[])

com.waveset.msgcat.Catalog#getMessage
(Locale,String,Object[])

com.waveset.msgcat.Catalog#format (Locale,String,Object[])

com.waveset.msgcat.Catalog#getMessage
(Locale,String)

fcom.waveset.msgcat.Catalog#format (Locale,String)

com.waveset.msgcat.Catalog#getMessage(String,Locale) com.waveset.msgcat.Catalog#format (Locale,String)

com.waveset.msgcat.Catalog#getMessage(String,Object[]) com.waveset.msgcat.Catalog#format (Locale,String,Object[])

com.waveset.object.Account#getUnowned() com.waveset.object.Account#hasOwner()

com.waveset.object.Account#setUnowned(boolean) com.waveset.object.Account#setOwner(WSUser)

com.waveset.object.AccountAttributeType#getAttrType() com.waveset.object.AccountAttributeType#getSyntax()

com.waveset.object.AccountAttributeType
#setAttrType(String)

com.waveset.object.AccountAttributeType
#setSyntax(String)

com.waveset.object.AccountAttributeType
#setSyntax(Syntax)
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com.waveset.object.Attribute#BLOCK_SIZE com.waveset.object.Attribute#BLOCK_ROWS_GET

com.waveset.object.Attribute#BLOCK_ROWS_LIST

com.waveset.object.Attribute#EVENTDATE com.waveset.object.Attribute#EVENT_DATETIME

com.waveset.object.Attribute#EVENTTIME com.waveset.object.Attribute#EVENT_DATETIME

com.waveset.object.Attribute#getDbColumnLength()

com.waveset.object.Attribute#getDbColumnName()

com.waveset.object.Attribute#STARTUP_TYPE_AUTO com.waveset.object.Resource#STARTUP_TYPE_AUTO

com.waveset.object.Attribute#STARTUP_TYPE_
AUTO_FAILOVER

com.waveset.object.Resource#STARTUP_TYPE_
AUTO_FAILOVER

com.waveset.object.Attribute#STARTUP_TYPE_
DISABLED

com.waveset.object.Resource#STARTUP_TYPE_
DISABLED

com.waveset.object.Attribute#STARTUP_TYPE_
MANUAL

com.waveset.object.Resource#STARTUP_TYPE_
MANUAL

com.waveset.object.Attribute#STARTUP_TYPES com.waveset.object.Resource#STARTUP_TYPES

com.waveset.object.Attribute#STARTUP_TYPES_
DISPLAY_NAMES

com.waveset.object.Resource#STARTUP_TYPES_
DISPLAY_NAMES

com.waveset.object.AttributeDefinition#Attribute
Definition(String,String)

com.waveset.object.AttributeDefinition#Attribute
Definition(String,Syntax)

com.waveset.object.AttributeDefinition
#setAttrType(String)

com.waveset.object.AttributeDefinition#setSyntax(Syntax)

com.waveset.object.AuditEvent#setAttributeMap(Map) com.waveset.object.AuditEvent#setAuditable
Attributes(Map)

com.waveset.object.AuditEvent#addAuditable
Attributes(AccountAttributeType[],WSAttributes)

com.waveset.object.AuditEvent#setAuditable
Attributes(Map)

com.waveset.object.AuditEvent#getAttributeMap() com.waveset.object.AuditEvent#getAuditableAttributes()

com.waveset.object.AuditEvent#getAttributeValue(String) com.waveset.object.AuditEvent#getAuditableAttributes()

com.waveset.object.AuditEvent#setAccountAttributes
Blob(Map)

com.waveset.object.AuditEvent#setAccountAttributes
Blob(Map,Map)

com.waveset.object.AuditEvent#setAccount
AttributesBlob(WSAttributes,List)

com.waveset.object.AuditEvent#setAccount
AttributesBlob(WSAttributes, WSAttributes, List)

com.waveset.object.AuditEvent.setAccount
AttributesBlob(List)

Use one of the other forms of setAccountAttributes
Blob (to allow for new, attempted, or old values).
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com.waveset.object.AuditEvent.setAccount
AttributesBlob(Map, Map)

Put the list of attributes into name=value;; format, which in turn
will be stored in a blob. The delimiter ;; will be filtered.

com.waveset.object.AuditEvent.setAccount
AttributesBlob(Map,Map,Set)

Use one of the other forms of setAccountAttributes Blob (to allow
for new, attempted, or old attribute values).

com.waveset.object.CacheManager#getAllObjects
(Type,AttributeCondition[])

com.waveset.object.CacheManager#listObjects
(Type,AttributeCondition[])

com.waveset.object.CacheManager#getAllObjects
(Type,WSAttributes)

com.waveset.object.CacheManager#listObjects
(Type,WSAttributes)

com.waveset.object.CacheManager#getAllObjects(Type) com.waveset.object.CacheManager#listObjects(Type)

com.waveset.object.Constants#MAX_SUMMARY_
STRING_LENGTH

com.waveset.object.EmailTemplate#setToAddress
(String)

com.waveset.object.EmailTemplate#setTo(String)

com.waveset.object.EmailTemplate#getFromAddress() com.waveset.object.EmailTemplate#getFrom()

com.waveset.object.EmailTemplate#getToAddress() com.waveset.object.EmailTemplate#getTo()

com.waveset.object.EmailTemplate#setFrom
Address(String)

com.waveset.object.EmailTemplate#setFrom(String)

com.waveset.object.EmailTemplate#VAR_FROM_
ADDRESS

com.waveset.object.EmailTemplate#VAR_FROM

com.waveset.object.EmailTemplate#VAR_TO_
ADDRESS

com.waveset.object.EmailTemplate#VAR_TO

com.waveset.object.Form#EL_HELP com.waveset.object.GenericObject#toMap(int)

com.waveset.object.Form#getDefaultDataType() com.waveset.object.Form#getDefaultSyntax()

com.waveset.object.Form#getType() com.waveset.object.Form#getSyntax()

com.waveset.object.Form#setType(String) com.waveset.object.Form#setSyntax(Syntax)

com.waveset.object.GenericObject.addAlias(String,String)

com.waveset.object.GenericObject#toMap(boolean) com.waveset.object.GenericObject#toMap(String,int)

com.waveset.object.GenericObject#toMap(String,boolean)

com.waveset.object.IAPI com.waveset.adapter.iapi.IAPI

com.waveset.object.IAPIProcess com.waveset.adapter.iapi.IAPIFactory

com.waveset.object.IAPIUser com.waveset.adapter.iapi.IAPIUser

com.waveset.object.LighthouseContext#OP_NO_RESULT
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com.waveset.object.LoginConfig#getApp(String) com.waveset.object.LoginConfig#getLoginApp(String)

com.waveset.object.MessageUtil#getAction
DisplayKey(String)

com.waveset.object.MessageUtil#getEventParm
DisplayKey(String)

com.waveset.object.MessageUtil#getResult
DisplayKey(String)

com.waveset.object.MessageUtil#getType
DisplayKey(String)

com.waveset.ui.FormUtil#getTypeDisplayName
(LighthouseContext,String)

com.waveset.object.PersistentObject() com.waveset.object.PersistentObject(ObjectClass)

com.waveset.object.PersistentObject.fakeId(Type,String) com.waveset.object.IDFactory.fakeID(type,name).
toString()

com.waveset.object.PersistentObject.isId(String) com.waveset.object.IDFactory.isValidID(id)

com.waveset.object.Principal() com.waveset.object.Principal(ObjectClass)

com.waveset.object.Principal(String) com.waveset.object.Principal(ObjectClass,String)

com.waveset.object.RemedyTemplate

com.waveset.object.ReportCounter

com.waveset.object.RepositoryProxy.sort
(RepositoryResult)

com.waveset.object.RepositoryResult#get(int)

com.waveset.object.RepositoryResult#getId(int)

com.waveset.object.RepositoryResult#getName(int)

com.waveset.object.RepositoryResult#getObject(int)

com.waveset.object.RepositoryResult#getRowCount()

com.waveset.object.RepositoryResult#getRows()

com.waveset.object.RepositoryResult#seek(int) com.waveset.object.RepositoryResult#hasNext()

com.waveset.object.RepositoryResult#next()

com.waveset.object.RepositoryResult#sort()

com.waveset.object.RepositoryResult.Row
#getSummaryAttributes()

com.waveset.object.RepositoryResult.Row#getAttributes()

com.waveset.object.ResourceAttribute#setType(String) com.waveset.object.ResourceAttribute#setSyntax(Syntax)
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com.waveset.object.Role() com.waveset.object.Role(ObjectClass)

com.waveset.object.Service() com.waveset.object.Service(ObjectClass)

com.waveset.object.SourceManager com.waveset.view.SourceAdapterManageView

com.waveset.object.Syntax.getDescription()

com.waveset.object.TaskInstance#DATE_FORMAT com.waveset.util.Util#stringToDate(String,String)

com.waveset.util.Util#getCanonicalDate(Date)

com.waveset.util.Util#getCanonicalDate(Date,TimeZone)

com.waveset.util.Util#getCanonicalDate(long)

com.waveset.object.TaskInstance#VAR_RESULT_LIMIT com.waveset.object.TaskInstance#setResultLimit(int)

com.waveset.object.TaskInstance#getResultLimit()

com.waveset.object.TaskInstance#VAR_TASK_STATUS

com.waveset.object.TaskTemplate#setMode(String) com.waveset.object.TaskTemplate#setExecMode(String)

com.waveset.object.TaskTemplate#setMode
(TaskDefinition.ExecMode)

com.waveset.object.TaskTemplate#setExecMode
(TaskDefinition,ExecMode)

com.waveset.object.Type#AUDIT_CONFIG

com.waveset.object.Type#AUDIT_PRUNER_TASK

com.waveset.object.Type#AUDIT_QUERY

com.waveset.object.Type#DISCOVERY

com.waveset.object.Type#getSubtypes() com.waveset.object.Type#getLegacyTypes()

com.waveset.object.Type#NOTIFY_CONFIG

com.waveset.object.Type#REPORT_COUNTER

com.waveset.object.Type#SUMMARY_REPORT_TASK

com.waveset.object.Type#USAGE_REPORT

com.waveset.object.Type#USAGE_REPORT_TASK

com.waveset.object.UserUIConfig.empty
QueryableAttributeNames()

com.waveset.object.UserUIConfig.empty
RepoIndexAttributes()

com.waveset.object.UserUIConfig.empty
SummaryAttributeNames()
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com.waveset.object.UserUIConfig#getAppletColumns() com.waveset.object.UserUIConfig#getAppletColumnDefs()

com.waveset.object.UserUIConfig
#getFindMatchOperatorDisplayNameKeys()

com.waveset.object.UserUIConfig#getFind
MatchOperators()

com.waveset.object.UserUIConfig#getFind
ResultsColumns()

com.waveset.object.UserUIConfig#getFind
ResultsSortColumn()

com.waveset.object.UserUIConfig#getFind
UserDefaultSearchAttribute()

com.waveset.object.UserUIConfig#getFind
UserSearchAttributes()

com.waveset.object.UserUIConfig#getFind
UserShowAttribute(int)

com.waveset.object.UserUIConfig#getFind
UserShowCapabilitiesSearch(int)

com.waveset.object.UserUIConfig#getFind
UserShowDisabled(int)

com.waveset.object.UserUIConfig#getFind
UserShowOrganizationSearch(int)

com.waveset.object.UserUIConfig#getFind
UserShowProvisioningSearch(int)

com.waveset.object.UserUIConfig#getFind
UserShowResourcesSearch(int)

com.waveset.object.UserUIConfig#getFind
UserShowRoleSearch(int)

com.waveset.object.UserUIConfig#getQueryable
AttributeNames

com.waveset.object.IDMSchema.getQueryable
AttributeNames(String ocName)

com.waveset.object.UserUIConfig.getRepoIndex
Attributes()

com.waveset.object.UserUIConfig.getSummary
AttributeNames()

com.waveset.object.IDMSchema#getSummaryAttributeNames(String
name)

com.waveset.object.UserUIConfig.getSummary
AttributeTypes()

com.waveset.object.WSUser#getSummaryAttributeTypes()
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com.waveset.object.UserUIConfig
#SUMMARY_ATTTR_TYPES_WRAPPER

com.waveset.object.ViewMaster()

com.waveset.object.ViewMaster.ViewMaster
(String,String)

com.waveset.object.ViewMaster.ViewMaster
(Subject,String)

com.waveset.object.WorkItem.getDelegator()

com.waveset.object.WorkItem.setDelegator(String)

com.waveset.object.WSUser.clearExtendedAttributes()

com.waveset.object.WSUser#getApproverDelegate() com.waveset.object.WSUser#getWorkItemDelegate
(String workItemType)

com.waveset.object.WSUser.getCurrentServiceRefs()

com.waveset.object.WSUser#getDelegateHistory() com.waveset.object.WSUser#getWorkItemDelegate
History()

com.waveset.object.WSUser.getRoleAttributeRefs()

com.waveset.object.WSUser#setApproverDelegate
(WSUser.Delegate)

com.waveset.object.WSUser#addWorkItemDelegate
(Delegate workItemDelegate)

com.waveset.object.WSUser#setDelegateHistory(List) com.waveset.object.WSUser#setWorkItemDelegate
History(ListworkItemDelegateHistory)

com.waveset.rpc.SimpleRpcHandler

com.waveset.security.authn.EncryptedData

com.waveset.security.authn.Encryptor

com.waveset.security.authn.LoginInfo com.waveset.object.LoginInfo

com.waveset.security.authn.SignedString com.waveset.util.SignedString

com.waveset.security.authn.Subject com.waveset.object.Subject

com.waveset.security.authz.Permission com.waveset.object.Permission

com.waveset.security.authz.Right com.waveset.object.Right

com.waveset.server.Server#getResourceObjectGetCache()

com.waveset.server.Server#getResourceObjectListCache()
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com.waveset.session.LocalSession#deleteAccount
Immediate()

com.waveset.session.LocalSession
#getAdministrators(Map)

com.waveset.view.WorkItemUtil#getAdministrators

com.waveset.session.Session#listApprovers() com.waveset.session.Session#getAdministrators(Map)

com.waveset.session#listControlledApprovers() com.waveset.session#getAdministrators(Map)

com.waveset.session#listSimilarApprovers
(String adminName)

com.waveset.session#getAdministrators(Map)

com.waveset.session.SessionFactory#getApp(String) com.waveset.session.SessionFactory#getLoginApp(String)

com.waveset.session#getApps() com.waveset.session#getLoginApps()

com.waveset.session.WorkflowServices
#ARG_TASK_DATE

com.waveset.object.Attribute#DATE

com.waveset.task.TaskContext#getAccessPolicy()

com.waveset.task.TaskContext#getRepository()

com.waveset.ui.SearchTableBase

com.waveset.ui.util.FormUtil#getAdministrators
(Session,List)

com.waveset.ui.util.FormUtil#getUsers
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getAdministrators
(Session,Map)

com.waveset.ui.util.FormUtil#getUsers
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getApplications
(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getApplications
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getApplications
(LighthouseContext)

com.waveset.ui.util.FormUtil#getApplications
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getApproverNames
(Session,List)

com.waveset.ui.util.FormUtil#getUsers
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getApproverNames
(Session)

com.waveset.ui.util.FormUtil#getUsers
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getApprovers(Session, List) com.waveset.ui.util.FormUtil#getUsers
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getApprovers(Session) com.waveset.ui.util.FormUtil#getUsers
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,List,Map)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,Map)
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com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,String,String)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext)

com.waveset.ui.util.FormUtil#getCapabilities
(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,List,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,List)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,String,String,List,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,String,String,List)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,Type,String,String,List,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,Map)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,Type,String,String,List)

com.waveset.ui.util.FormUtil#getObjectNames
(LighthouseContext,String,Map)

com.waveset.ui.util.FormUtil#getOrganizations
(LighthouseContext,boolean,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
(LighthouseContext,boolean)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,boolean,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,boolean)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNamesWithPrefixes(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)
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com.waveset.ui.util.FormUtil#getOrganizations
DisplayNamesWithPrefixes(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
WithPrefixes(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
WithPrefixes(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getSimilarApprover
Names(Session,String)

com.waveset.ui.util.FormUtil#getUsers(Lighthouse
Context,Map)

com.waveset.ui.util.FormUtil#getSimilarApprover
Names(Session)

com.waveset.ui.util.FormUtil#getUsers(Lighthouse
Context,Map)

com.waveset.ui.util.FormUtil#getUnassigned
Organizations(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
Organizations(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsDisplayNames(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsDisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsDisplayNames(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsDisplayNamesWithPrefixes(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsDisplayNamesWithPrefixes(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsWithPrefixes(LighthouseContext,List)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
OrganizationsWithPrefixes(LighthouseContext)

com.waveset.ui.util.FormUtil#getOrganizations
DisplayNames(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
Resources(LighthouseContext,List,List)

com.waveset.ui.util.FormUtil#getUnassigned
Resources(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
Resources(LighthouseContext,String)

com.waveset.ui.util.FormUtil#getUnassigned
Resources(LighthouseContext,Map)

com.waveset.ui.util.FormUtil#getUnassigned
Resources(LighthouseContext,String,List)

com.waveset.ui.util.FormUtil#getUnassigned
Resources(LighthouseContext,Map)

com.waveset.ui.util.html.Component#isNoWrap()
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com.waveset.ui.util.html.HtmlHeader#NORMAL_BODY

com.waveset.ui.util.html.MultiSelect#isLockhart()

com.waveset.ui.util.html#setHelpKey(String)

com.waveset.ui.util.html#setLockhart(boolean)

com.waveset.ui.util.html#setNoWrap(boolean)

com.waveset.ui.util.html.TransactionSigner.
getSupportedKeyStoreTypes()

com.waveset.ui.util.html.TransactionSigner.
getSupportedKeyStoreType

com.waveset.ui.util.html.TransactionSigner.
setSupportedKeyStoreTypes(String)

com.waveset.ui.util.html.TransactionSigner.
setSupportedKeyStoreType

com.waveset.ui.util.html.WizardPanel
#setPreviousLabel(String)

com.waveset.ui.util.html.WizardPanel
#setPrevLabel(String)

com.waveset.ui.web.account.SearchForm

com.waveset.ui.web.account.SearchTable

com.waveset.ui.web.account.UserAppletTable

com.waveset.ui.web.resources.ResourceAppletTable

com.waveset.ui.web.roles.SearchRoleForm

com.waveset.ui.web.roles.SearchRoleTable

com.waveset.util.ArgumentsParser.parse(String[]) com.waveset.util.ArgumentsParser.parse(String[] args,List
additionalArguments,boolean ignoreIncorrectUsage)

com.waveset.util.PdfReportRenderer.render
(Element, boolean, String)

#render(Element, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(Element, boolean, String, OutputStream)

#render(Element, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(Element, boolean, String, OutputStream, String, boolean)

#render(Element, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(Element, boolean, String, String, boolean)

#render(Element, Properties, boolean)

com.waveset.util.PdfReportRenderer.render
(Report, boolean, String)

#render(Report, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(Report, boolean, String, OutputStream)

#render(Report, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(Report, boolean, String, OutputStream, String, boolean)

#render(Report, Properties, OutputStream, boolean)
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com.waveset.util.PdfReportRenderer.render
(Report, boolean, String, String, boolean)

#render(Report, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(String, boolean, String)

#render(Element, Properties, OutputStream, boolean)

com.waveset.util.PdfReportRenderer.render
(String, boolean, String, String, boolean)

#render(Report, Properties, OutputStream, boolean)

com.waveset.util.Util.autoBox(int) java.lang.Integer.valueOf(int)

com.waveset.util.Util.autoBox(long) java.lang.Long.valueOf(long)

com.waveset.util.Util.autoBox(boolean) java.lang.Boolean.valueOf(boolean)

com.waveset.util.CaseInsensitiveStringComparator java.lang.String.CASE_INSENSITIVE_ORDER

com.waveset.util.ConnectionPool.getConnection
(String,String,String,boolean,String)

com.waveset.util.ConnectionPooll#getConnection
(String,String,String,boolean,String)

com.waveset.util.ConnectionPool.getConnection
(String,String,String,String)

com.waveset.util.ConnectionPooll#getConnection
(String,String,String,String)

com.waveset.util.ConnectionPool.getConnection
(String,String,String,String,String,boolean)

com.waveset.util.ConnectionPooll#getConnection
(String driverClass,String driverPrefix,String url,String user,String
password,boolean checkConnection,String validationSql)

com.waveset.util.CSVParser com.waveset.util.ConfigurableDelimitedFileParser

com.waveset.util.Debug com.sun.idm.logging.Trace

com.waveset.util.HtmlUtil com.waveset.ui.util.html.HtmlUtil

com.waveset.util.FileCounter.java

com.waveset.util.JSSE#installIfAvailable()

com.waveset.util.ITrace com.sun.idm.logging.Trace

com.waveset.util.PipeDelimitedParser com.waveset.util.ConfigurableDelimitedFileParser

com.waveset.util.PdfReportRenderer#render
(Element,boolean,String,OutputStream)

com.waveset.util.PdfReportRenderer#render
(Element,boolean,String,OutputStream,String,boolean)

com.waveset.util.PdfReportRenderer#render
(Element,boolean,String)

com.waveset.util.PdfReportRenderer#render
(Element,boolean,String,String,boolean)

com.waveset.util.PdfReportRenderer#render
(Report,boolean,String,OutputStream)

com.waveset.util.PdfReportRenderer#render
(Report,boolean,String,OutputStream,String,boolean)

com.waveset.util.PdfReportRenderer#render
(Report,boolean,String)

com.waveset.util.PdfReportRenderer#render
(String,boolean,String,String,boolean)

com.waveset.util.PooledConnection.isValid() isValid(String SQL)
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com.waveset.util.Quota#getQuota()

com.waveset.util.ReportRenderer#renderToPdf
(Report,boolean,String,OutputStream)

com.waveset.util.ReportRenderer#renderToPdf
(Report,boolean,String,OutputStream,String,boolean)

com.waveset.util.ReportRenderer#renderToPdf
(Report,boolean,String)

com.waveset.util.ReportRenderer#renderToPdf
(Report,boolean,String,String,boolean)

com.waveset.util.Trace#data(long,Object,String,byte[]) com.sun.idm.logging.trace.Trace#data(long,String,byte[])

com.waveset.util.Trace#entry(long,Object,String,Object[]) com.sun.idm.logging.trace.Trace#entry
(long,String,Object[])

com.waveset.util.Trace#entry(long,Object,String,String) com.sun.idm.logging.trace.Trace#entry(long,String)

com.waveset.util.Trace#entry(long,Object,String) com.sun.idm.logging.trace.Trace#entry(long,String)

com.waveset.util.Trace#exception(long,Object,String,t) com.sun.idm.logging.trace.Trace#throwing
(long,String,Throwable)

com.sun.idm.logging.trace.Trace#caught
(long,String,Throwable)

com.waveset.util.Trace#exit(long,Object,String,boolean) com.sun.idm.logging.trace.Trace#exit(long,String,boolean)

com.waveset.util.Trace#exit(long,Object,String,int) com.sun.idm.logging.trace.Trace#exit(long,String,int)

com.waveset.util.Trace#exit(long,Object,String,long) com.sun.idm.logging.trace.Trace#exit(long,String,long)

com.waveset.util.Trace#exit(long,Object,String,Object) com.sun.idm.logging.trace.Trace#exit(long,String,Object)

com.waveset.util.Trace#exit(long,Object,String) com.sun.idm.logging.trace.Trace#exit(long,String)

com.waveset.util.Trace#getTrace() com.sun.idm.logging.trace.TraceManager#getTrace(String)

com.waveset.util.Trace#getTrace(Class) com.sun.idm.logging.trace.TraceManager#getTrace(String)

com.waveset.util.Trace#getTrace(String) com.sun.idm.logging.trace.TraceManager#getTrace(String)

com.waveset.util.Trace#level1(Class,String) com.sun.idm.logging.trace.Trace#level1(String)

com.waveset.util.Trace#level1(Object,String) com.sun.idm.logging.trace.Trace#level1(String)

com.waveset.util.Trace#level2(Class,String) com.sun.idm.logging.trace.Trace#level2(String)

com.waveset.util.Trace#level2(Object,String) com.sun.idm.logging.trace.Trace#level2(String)

com.waveset.util.Trace#level3(Class,String) com.sun.idm.logging.trace.Trace#level3(String)

com.waveset.util.Trace#level3(Object,String) com.sun.idm.logging.trace.Trace#level3(String)

com.waveset.util.Trace#level4(Class,String) com.sun.idm.logging.trace.Trace#level4(String)

com.waveset.util.Trace#level4(Object,String) com.sun.idm.logging.trace.Trace#level4(String)
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com.waveset.util.Trace#variable(long,Object,
String,String,boolean)

com.sun.idm.logging.trace.Trace#variable
(long,String,String,boolean)

com.waveset.util.Trace#variable(long,Object,
String,String,int)

com.sun.idm.logging.trace.Trace#variable
(long,String,String,int)

com.waveset.util.Trace#variable(long,Object,
String,String,long)

com.sun.idm.logging.trace.Trace#variable
(long,String,String,long)

com.waveset.util.Trace#variable(long,Object,
String,String,Object)

com.sun.idm.logging.trace.Trace#variable
(long,String,String,Object)

com.waveset.util.Trace#void info(long,Object,String,String) com.sun.idm.logging.trace.Trace#info
(long,String,String)

com.waveset.util.Util#DATE_FORMAT_CANONICAL com.waveset.util.Util#stringToDate(String,String)

com.waveset.util.Util#getCanonicalDate(Date)

com.waveset.util.Util#getCanonicalDate(Date,TimeZone)

com.waveset.util.Util#getCanonicalDate(long)

com.waveset.util.Util#debug(Object)

com.waveset.util.Util#getCanonicalDateFormat() com.waveset.util.Util#stringToDate(String,String)

com.waveset.util.Util#getCanonicalDate(Date)

com.waveset.util.Util#getCanonicalDate(Date,TimeZone)

com.waveset.util.Util#getCanonicalDate(long)

com.waveset.util.Util#getLocalHostName() #getServerId() (to get a unique server identifier)

com.waveset.util.Util#getOldCanonicalDateString
(Date,boolean)

com.waveset.util.Util#getCanonicalDateString(Date)

com.waveset.util.Util.getUniqueId() com.waveset.util.Util.generateGUID()

com.waveset.util.Util#rfc2396URLPieceEncode(String) com.waveset.util.RFC2396URLPieceEncode#encode
(String)

com.waveset.util.Util#rfc2396URLPieceEncode
(String,String)

com.waveset.util.RFC2396URLPieceEncode#encode
(String,String)

com.waveset.view.ViewUtil.getExtendedAttributes
(LighthouseContext)

com.sun.idm.util.ObjectClasses.getExtendedAttributes
(ObjectClass)

com.waveset.view.ViewUtil.isExtendedAttribute
(ViewMaster vm, String name)

ObjectClasses.getExtendedAttributes(ObjectClass)

com.waveset.view.ViewUtil.reloadExtendedAttributes()
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com.waveset.view.ViewUtil.setExtendedAttributes
(LighthouseContext, List attributes)

IDMSchemaConfiguration

com.waveset.workflow.WorkflowContext
#VAR_CASE_TERMINATED

com.waveset.object.WFProcess
#VAR_CASE_TERMINATED

Deprecated JSP Files and URLs
The following table lists deprecated JSP files and URLs and their replacements, when available.

Deprecated Replacement

account/listapplet.jsp

resources/listapplet.jsp

resources/reconLinkAccountFilter.jsp

Deprecated Configuration Objects
The following table lists deprecated configuration objects and their replacements, when
available.

Deprecated Replacement

UserExtendedAttributes IDMSchemaConfiguration

UserUIConfig IDMSchemaConfiguration

Deprecated Views and Path Expressions
The following table lists the deprecated views and path expressions within views and their
replacements, when available.

Deprecated Replacement

DelegateApproversViewer DelegateWorkItemsViewer

Deprecated Views and Path Expressions
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Documentation Additions and Corrections

This section contains new and corrected information that was required after the Identity
Manager 8.1 documentation set was published.

This information is organized as follows:

■ “Identity Manager 8.1 Business Administrator's Guide” on page 105
■ “Identity Manager 8.1 System Administrator's Guide” on page 107
■ “Identity Manager 8.1 Deployment Guide” on page 107
■ “Identity Manager 8.1 Deployment Reference” on page 110
■ “Identity Manager 8.1 Resource Reference” on page 114
■ “Identity Manager 8.1 Service Provider Deployment Guide” on page 115
■ “Identity Manager IDE Frequently Asked Questions (FAQ)” on page 115
■ “Localization Scope” on page 120
■ “Working with the Identity Manager Profiler” on page 121
■ “Online Help” on page 140

Identity Manager 8.1 Business Administrator's Guide
This section contains new information and documentation corrections for the Sun Identity
Manager 8.1 Business Administrator’s Guide:
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The following information will be added to the Security chapter:

■ Identity Manager now provides a Login Recovery authentication as an alternative to the
Forgot Password security questions-based login. The Login Recovery authentication
implements a message obfuscation option that renders all errors and successes with the
same generic result message, which is done to resist account harvesting. Functionally, this
login recovery method uses the same system as the Forgot my User Id method and both
options share the same configuration attributes. However, the Login Recovery
authentication also resets the user's password and emails both the login and the password to
the user's email address. (ID-18052)

You can configure the Login Recovery method to replace the question-based login by
redirecting the Forgot Password button or you can enable a new Login Recovery button on
the login page. You configure both methods by modifying the System Configuration File.
■ To redirect the Forgot Password button to Login Recovery, configure the following:

ui.web.user.questionLogin.forceLoginRecovery = true

ui.web.admin.questionLogin.forceLoginRecovery = true

■ To use a Login Recovery button instead of the Forgot Password button, configure the
following:

ui.web.user.disableLoginRecovery = false

ui.web.admin.disableLoginRecovery = false

ui.web.user.disableForgotPassword = true

ui.web.admin.disableForgotPassword = true

ui.web.user.disableForgotUserId = true

ui.web.admin.disableForgotUserId = true

An obfuscate messages option that helps the Login Recovery system resist account
harvesting is enabled by default in the loginRecovery.jsp files. You can set this same
option in the lookupUserId.jsp files.
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Identity Manager 8.1 System Administrator's Guide
This section provides new information and documentation corrections for the Sun Identity
Manager 8.1 System Administrator’s Guide.

This information includes the following:

■ The following tasks were moved from the adapter to the task package in Identity Manager
version 8.0. You must update the paths if you have tracing enabled for any of these tasks, or
if you have customized task definitions referencing these packages.

Old Package Name New Package Name

com.waveset.adapter.ADSyncFailoverTask com.waveset.task.ADSyncFailoverTask

com.waveset.adapter.ADSyncRecovery
CollectorTask

com.waveset.task.ADSyncRecoveryCollectorTask

com.waveset.adapter.SARunner com.waveset.task.SARunner

com.waveset.adapter.SourceAdapterTask com.waveset.task.SourceAdapterTask

Identity Manager 8.1 Deployment Guide
This section contains new information and documentation corrections for the Sun Identity
Manager Deployment Guide.

■ The “Adding Localization Support for the WIC” in Sun Identity Manager Deployment Guide
describes how to display export schema strings on the Data Exporter Type Configuration
page in another language. However, these instructions should state that only customers who
do not use the officially supported languages must perform these steps. Officially supported
languages include Simplified Chinese, Traditional Chinese, Korean, Japanese, German,
Spanish, French, Italian, and Brazilian Portuguese. (ID-19264)
A localization jar file, containing a localized WICMessages.properties file, is co-packaged
with Identity Manager 8.1. If you are using a localized Identity Manager system, you can
view localized WICMessages.properties messages. For example, you can access the Identity
Manager Administrator interface URL in a browser with lang=ja.
In addition, the example used in this section is inappropriate. Because German is a
supported language, German customers are not required to perform the steps in this
section.

■ This guide is missing the following description of login error codes: (ID-5657)
Identity Manager provides the following error codes that custom code can check to
determine login status. The actual string values are the numeric values in parentheses (for
example, 101 or 102). The Constants.java file contains these error codes:
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LIGHTHOUSE_USER_NOT_FOUND = 101;

LIGHTHOUSE_AUTHN_FAILED = 102;

RESOURCE_AUTHN_SUCCESSFUL = 104;

RESOURCE_AUTHN_FAILED = 108;

X509_CERT_NOT_FOUND = 110;

END_USER_ATTEMPTED_LOGIN_TO_ADMIN_APP = 120;

LIGHTHOUSE_USER_DISABLED = 140;

LIGHTHOUSE_USER_LOCKED = 180;

System Configuration Object Documentation Changes
The description of the System Configuration object should contain the following information
about these attributes:

ProvisioningDisabledUserShouldThrow – When set to true, any attempt to provision a
disabled user to a resource will be prevented and will produce an error. When the attribute is
not set to true, then the provisioning will still be prevented, but it will not produce an error.
(ID-20064)

security.delegation.historyLength – Controls the number of previous delegations that are
recorded. (ID-13331)

runPasswordLoginOnSuccess – When set to true, Identity Manager will run the Password
Login workflow when a user logs in successfully by answering the authentication questions. By
default, the value of this property is false. (ID-10030)

PasswordSyncThreshold - If password sync is enabled for a resource for which Identity
Manager can also initiate password changes, you can use this setting to help prevent a loop-back
password change. (ID-7887) When you initiate a password change from Identity Manager, it
will set the password on the resource, and the PasswordSync library will notify Identity
Manager of the change. Identity Manager will then compare the lastPasswordDate on the user
object to the current time. If this difference is less than the PasswordSyncThreshold, Identity
Manager will ignore the password change. In this way, the extra or unnecessary password
change will be appropriately ignored.

PasswordSyncResourceExcludeList – Lists resource names that should always be excluded from
synchronization.(ID-3275)

process.handleNativeChangeToAccountAttributes – When set to true, enables attribute value
auditing. By default, this property is off. (Note: This enables attribute value auditing both for the
reconciliation process and for the provisioner.) (ID-3275)

sources.subject – Specifies the login name of administrator designated as the owner of the
source adapter task. (ID-19694

sources.host – Specifies the server on which the source adapter task runs.
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security.saveNoValidateAllowedFormsAndWorkflows – Lists the IDs of forms and workflows
that will be processed as a SaveNoValidate action. All other forms and workflows will be
processed as a Save. If this list is not present, the behavior remains the same for all forms and
workflows (all forms and workflows will be processed as SaveNoValidate.) (ID-19474)

Data Exporter Changes
Data Exporter provides the means to periodically export data that is managed or has been
processed by Identity Manager to a set of DBMS tables for further processing. The export
process is intentionally open to customizations, some of which may require manual
intervention for the proper behavior. The Identity Manager configuration objects that are
relevant to Data Exporter are preserved and updated appropriately. However, some exporter
customization is done to files within the web application, and these take special handling.

During the upgrade process, Identity Manager overwrites all unmodified Data Exporter files in
the $WSHOME and $WSHOME/exporter directories. If you made changes to any Data Exporter files,
then the upgrade process leaves your modified version in place and installs the newer version of
the file in $WSHOME/patches/Identity_Manager_8_1_0_0_Date/filesNotInstalled. If you
want to merge the new functionality with your customizations, you must do this manually.

Note that the following files in $WSHOME are often customized:

model-export.dtd

model-export.xml

model-export.xsl

exporter/exporter.jar

exporter/create_warehouse.*

exporter/drop_warehouse.*

exporter/hbm/*.hbm.xml

The upgrade steps you must perform vary depending on whether you customized Data
Exporter in 8.0 and your plans for Data Exporter in 8.1

■ If you customized Data Exporter for 8.0 and want to implement the 8.1 features:
1. Drop the warehouse schema.
2. Upgrade Identity Manager.
3. Recreate the schema with the new DDL in the $WSHOME/exporter directory.

There are no schema upgrade scripts that will allow the schema to be modified with data
in place. Therefore, if you need to preserve the data, you must export and then import
the data. The 8.1 warehouse schema is table and field compatible with the previous
version, although 8.1 added new tables and new fields to existing tables. The field order
was also changed. As a result, your export needs to be a data-only export, not a DDL and
data export.
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4. Merge customizations with the new 8.1 exporter files. If model-export.xml was
customized, rebuild the exporter.jar file.

5. Load the new warehouse schema.
■ If you customized Data Exporter for 8.0 and you do not want to implement the 8.1 features:

You can upgrade to 8.1 without performing any additional steps. However, if you upgrade
to 8.1 Exporter but do not upgrade the warehouse DDL, the Warehouse Configuration page
displays an error message that indicates the EXT_ADMINGROUP table is missing. This is
an indication that the new 8.1 objects are in place, but the old 8.0 warehouse DDL is still
loaded.

■ If you did not customize Data Exporter for 8.0 and do not plan to implement the 8.1
features:
1. Drop the warehouse schema.
2. Upgrade Identity Manager.
3. Load the new warehouse schema.

Note – Data in the warehouse is left untouched. You do not need to change the DDL if
model-export.xml was customized. If model-export.xml was not customized, then you
must load the new DDL.

After 8.1 is installed, if the 8.1 version of model-export.xml is in place, you can see the new data
types and attributes by looking at the schema file at
http://server:port/idm/model-export.xml. New types and attributes are flagged with the 8.1
release number.

Identity Manager 8.1 Deployment Reference
This section contains new information and documentation corrections for Sun Identity
Manager Deployment Reference.

Forms-Related Documentation Issues
The following description of adding a password confirmation challenge to forms is missing
from this chapter: (ID-7604)

You can use the RequiresChallenge form property to add a password confirmation challenge to
select forms. When this feature is enabled, Identity Manager will challenge the currently
logged-in administrator for his password before processing a request. The forms that
supporting this option include:

userForm (Tabbed User Form, Wizard User Form, Default User form)
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changePassword (by default, Change User Password form)

resetPassword (by default, Reset User Password form)

The property is specified different for each of the forms.

Setting the RequiresChallenge Property for User Forms
To add a password confirmation challenge to a user form, add the following RequiredElement
element as shown below, with substitutions for password, email, and fullname:

<Property name=’RequiredChallenge’>

<List>

<String>password</String>

<String>email</String>

<String>fullname</String>

</List>

</Property>

The value of the property is a list of one or more of the following User view attribute names:
applications, adminRoles, assignedLhPolicy, capabilities, controlledOrganizations, email,
firstname, fullname, lastname, organization, password, resources, roles.

Setting the RequiresChallenge Property for Change Password and
Reset Password Forms
To add a password confirmation challenge to either a changePassword or resetPassword form,
add the following <RequiresChallenge> element as shown below, with substitutions for
password, email, and fullname:

<Property name=’RequiresChallenge’ value=’true’/>

where the value of the property can be either "true" or "false".

If the property is set to "true" in the form, Identity Manager will challenge the current
administrator who is requesting the change to enter the password he used to log in to
Lighthouse. If the challenge is not successful (that is, the current administrator's password is not
entered), Identity Manager will not permit the change. If the challenge is successful, Identity
Manager will permit the change request to proceed. Both password management forms support
the use of the 'RequiresChallenge' form property. When this property is set to true, the user is
prompted to enter the old password after specifying the new password.

Overriding Version Information
You can create two custom message catalog keys that prevent Identity Manager from displaying
the version information when a user places the cursor over the help button. The
UI_END_USER_VERSION key hides the version information on the end user interface, while
the UI_VERSION key is used by the administrator interface.
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Setting the value of the key to the empty string prevents any version information from being
displayed.

The following example disables version information for both interfaces.

<Waveset>

<Configuration name="sampleCustomCatalog">
<Extension>

<CustomCatalog id="defaultCustomCatalog" enabled="true">
<MessageSet language="en" country="US">

<Msg id="UI_END_USER_VERSION"></Msg>
<Msg id="UI_VERSION"></Msg>

</MessageSet>

</CustomCatalog>

</Extension>

</Configuration>

</Waveset>

Other Forms-Related Issues
The "Forms" chapter is missing the following discussion: (ID-18869)

By default there are two implementations of the change password form:

The End User Password Change form is the default password change form. It presents a simple
set of fields with which the user can change their password. The password policies for all
resources that are assigned to the user are aggregated and summarized, and Identity Manager
applies the password change to all assigned resources.

The Basic Change Password Form is present in both the Administrator and User Interfaces. It
provides information about the resources that are assigned to the user and allows the user to
individually select on which resources Identity Manager will change the password.

Both password management forms support the use of the 'RequiresChallenge' form property.
When this property is set to true, the user is prompted to enter the old password after specifying
the new password.

Issues Common to Both Workflows and Forms
The Forms and Workflow chapters of this guide are missing the following discussion about
assigning scope to <Variable> elements: (ID-14915)

Identity Manager assigns a scope to all <Variable> elements when the element is declared. If
you do not assign a value to the scope attribute, Identity Manager assigns it a value of local,
which means that the variable can be accessed only within the XPRESS section that is declared
in.
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Additional Variable attributes that define scope include:

input -- Declares that the <Variable> element has local scope and that the value can be
initialized by the caller.

output -- Declares that the <Variable> element has local scope but can be returned to the
caller.

external -- Declares a <Variable> that has non-local scope - that is, assignments to this
variable will result in assignment to this variable in the scope it was first declared in.

The following discussion of the Identity Manager whitelist feature is missing from this chapter.
(ID-19474)

The Identity Manager whitelist feature makes it possible to check forms and workflows that use
the SaveNoValidate action against a list of IDs or form names. Identity Manager checks the
whitelist for either form names or form-owner IDs.) The list of IDs, called
saveNoValidateAllowedFormsAndWorkflows, is located in the security attribute in the System
Configuration object. If the form name or owner ID is on the whitelist, the form or workflow
can use the SaveNoValidate action. If the form name or the owner ID is not on the list, the form
or workflow is processed using a Save action. If the list is not present, all forms and workflows
can be processed as SaveNoValidate.

To implement this feature in your deployment, you must add any forms or workflows using
SaveNoValidate to the saveNoValidateAllowedFormsAndWorkflows list in the System
Configuration object. To see the IDs or form names that you must add, check the syslog or turn
trace level 4 on for com.waveset.ui.util.GenericEditForm and submit any custom forms or
workflows that use SaveNoValidate. A warning including the ID will be logged. If you are
getting "null" form names in the syslog, confirm that the form in the TaskDefinition that was
run has a name attribute.

Workflow-Related Issues
The Workflow chapter is missing the following discussion of the
handleNativeChangeToAccountAttributes workflow (ID-3275):

Whenever Identity Manager detects a native change (that is, a change not performed through
Identity Manager) to the values of an auditable attribute of a resource account, it responds by
running the handleNativeChangeToAccountAttributes workflow, which is associated with this
System Configuration object attribute:

<Attribute name=’process’>

<Object>

<Attribute name=’handleNativeChangeToAccountAttributes’ value=’Audit Native

Change To Account Attributes’/>

</Object>

</Attribute>
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This workflow logs the native change events to the event log if you have enabled the Changes
Outside Lighthouse audit filter. Otherwise, Identity Manager ignores the event. Warning: Be
careful which methods you call from any workflow that replaces the default workflow listed
above.

Because Identity Manager launches this workflow whenever a resource account fetch reveals a
native change, it must not invoke any method or workflow that would trigger another fetch of
the same resource account. For example, an infinite loop will result if you call any
WorkflowServices method that assembles the user view: getView(User),checkoutView(User)
and possibly checkinView(User).

The fact that Identity Manager handles each native change by running a workflow allows you to
hook the native change event, and to handle that native change however you see fit by replacing
or adding to the default native change workflow. For example, you might choose to send email
to an administrator or a user, to record the event in a database, to queue an update that would
back out the native change, or even to pull that native change into and push it back out to the
other resources.

The Workflow chapter of this guide is missing the following description of how to specify the
subject or administrator of a source adapter task. (ID-19694).

You can assign a subject or administrator to a Source adapter task and designate the server on
which it runs by editing the following attributes of the system configuration object.
source.subject specifies the login name of administrator designated as the owner of this task.
sources.host specifies the server on which the task runs. The new values in the configuration
object are by default:

<Attribute name=’sources’>

<Object>

<Attribute name=’hosts’/> <!-- any host is the default -->

<Attribute name=’subject’ value=’Configurator’/>

</Object>

</Attribute>

Identity Manager 8.1 Resource Reference
This section contains new information and documentation corrections for Sun Identity
Manager 8.1 Resources Reference.

The discussion of identity connectors is missing the following information about how
ConnectorAdapter implements the run() method: The arguments passed to the
runResourceAction service are passed to the script (defined in the ResourceAction) as direct
script variables. (ID-19856)
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Identity Manager 8.1 Service Provider Deployment Guide
This section contains new information and documentation corrections for Sun Identity
Manager Service Provider 8.1 Deployment.

Developing Customer Adapters
The ResourceAttribute element may contain a ValidationPolicy element. A validation policy
ensures the value a user specifies on the Resource Parameters page meets the requirements
defined in a separate policy object.

The following sample causes the adapter to use the Port Policy to ensure the specified value is
valid. The default Port Policy checks the value is an integer between 1 and 65536.

<ResourceAttribute name=.Port. value=.123.>

<ValidationPolicy>

<ObjectRef type=.Policy. id=.#ID#PortPolicy. name=.Port Policy./>

</ValidationPolicy>

</ResourceAttribute>

Identity Manager IDE Frequently Asked Questions (FAQ)
This FAQ answers some commonly asked questions related to using the Identity Manager IDE.

The information is organized into these categories:

■ “Using NetBeans” on page 115
■ “Working with Projects” on page 116
■ “Working with the Repository” on page 117
■ “Using the Identity Manager IDE Debugger” on page 118
■ “Working with Rules” on page 119

Using NetBeans
Question: Which version of Netbeans should I use?
Answer: Use the Netbeans version referenced in the Identity Manager product documentation
provided for the Netbeans plugin version you are using.

Note – Always use the exact version referenced because even patch releases can cause major
functionality to break.
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Question: The Netbeans plugin was working, I did something, and now it is no longer working.
What could be causing this problem?
Answer: This problem is commonly caused by a corrupt file in your .netbeans directory.
Generally, deleting your .netbeans directory and re-installing the NetBeans plugin resolves the
problem. (Deleting the .netbeans directory effectively uninstalls the NetBeans plugin. You lose
all of your user settings, but the contents of your project will be safe.)

The steps are as follows:

1. Shutdown NetBeans.
2. Delete the .netbeans directory.
3. Start NetBeans.
4. Install the NetBeans plugin.
5. Restart NetBeans.

Working with Projects
Question: Building and running a project is taking a very long time, and the Identity Manager
IDE seems to be copying a lot of files. What could be causing this problem?
Answer: This problem can occur for the following reasons:

■ You are using the Identity Manager IDE 7.0 or 7.1 plugin.

Use the Identity Manager IDE 8.0 plugin. Several adjustments were made to the Identity
Manager IDE 8.0 Configuration Build Environment (CBE) to improve performance.

■ You might be using the Clean commands unnecessarily.

When you use Clean Project or Clean And Build Project, the Identity Manager IDE
deletes the entire image directory, which contains several thousand files. Identity Manager
IDE must copy all of these files from idm-staging during the next build.

To use the Identity Manager IDE efficiently, you must understand when to use the Clean
commands. Refer to the “When to Use Clean” section in the Identity Manager IDE
README.txt file for more information.

Question: Now that I have created an Identity Manager project, what files should be checked into
source control?
Answer: See the “CVS Best Practices” section in the Identity Manager IDE README.txt for
information.

Question: What are the best practices for using project management in CVS?
Answer: See the “CVS Best Practices” section in the Identity Manager IDE README.txt for
information.
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Question: When are objects imported into the repository?
Answer: See “Working with the Repository” on page 117 for information.

Question: How do I add a new JAR to the project?
Answer: See the “How to add a new JAR dependency” section in the Identity Manager IDE
README.txt.

Working with the Repository
Question: Which repository should I use for my sandbox repository?
Answer: Use the embedded repository for your sandbox— particularly if you are using Identity
Manager 7.1 (or higher), which has an HsSQL repository available. You lose functionality if you
do not use the embedded repository.
Refer to the “Working with the Repository” section in the Identity Manager IDE README.txt

for more information.

Question: When are objects imported automatically?
Answer: You have to configure Identity Manager IDE to import objects automatically.
The steps are as follows:

1. Select Repository > Manage Embedded Repository from the IdM menu.
2. Enable the Automatically Publish Identity Manager Objects option on the Manage

Embedded Repository dialog.

Note – This option is not available for Identity Manager Project (Remote) or if you specify
your own repository.

3. Select Project > Run Project or Project > Debug Project.
The Identity Manager IDE automatically imports all objects that have changed since the last
time you ran the project.

Tip – Automatically publishing Identity Manager objects increases the time needed to start
the server. To minimize server start time, disable this option and explicitly upload objects to
the repository.

Question: What is the most effective way to upload objects?
Answer: Use one of the following methods to upload modified objects:
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■ Right-click one or more edited objects in the project tree and select Upload Object from the
pop-up menu.

Tip – To upload multiple objects, press and hold the Control key as you select objects from
the list.

■ Select one or more edited objects, and then select Repository > Upload Objects from the
IdM menu. A dialog is displayed so you can select the objects to upload.

Either method uploads the object(s) directly to the server, so there is no cache latency issue and
it is much faster than using Run Project or Debug Project. The Upload Objects feature is
available regardless of which repository you are using.

Using the Identity Manager IDE Debugger

Note – The Netbeans embedded application server automatically shuts down whenever you
perform any of the following project operations:

■ Clean Project
■ Create Delta Distribution
■ Create Jar
■ Debug Project
■ Manage Embedded Repository
■ Profile Project
■ Run Project

Question: The Identity Manager IDE Debugger is sluggish. What could be causing this problem?
Answer: To improve the Debugger’s performance:

■ Always disable Tomcat’s HTTP Monitor, as follows:
■ Select the Identity Manager IDE Runtime Tab.
■ Expand the Servers node and right-click Bundled Tomcat > Properties.
■ Disable the Enable HTTP Monitor option, and then close the dialog.

The next time you start Tomcat, the HTTP Monitor will be disabled.
■ If you are not debugging Java, select Project > Run Project, and then select Attach Debugger

> Identity Manager XML Object Debugger to use just the XPRESS Debugger.
Selecting Project > Debug Project for a non-remote Identity Manager IDE project starts
both the XPRESS Debugger and Java Debugger, and the Java Debugger adds substantial
overhead.
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Question: I cannot set a breakpoint in the Debugger. What could be causing this problem?
Answer: The following conditions might prevent you from setting a breakpoint:

■ You just installed the NBM, but did not restart Netbeans.
■ Your XML contains a <Waveset> wrapper element.

The Identity Manager IDE basically ignores any file that starts with a <Waveset> wrapper
element because the Identity Manager IDE parses that element as a multi-object file.

The following features do not work on multi-object files:
■ Debugger
■ Rule Tester
■ Form Previewer
■ Any of the editors
■ Import file generator
■ Upload Object
■ Diff Object

Basically, all you can do with multi-object files is import them. The only files that should
contain <Waveset> wrapper elements are your project’s top-level import files.

Question: I set a breakpoint in the Debugger and it is not suspending on the breakpoint. What
could be causing this problem?
Answer: There are two things to check:

■ Be sure the object name does not contain a CBE replacement string (%%). CBE replacement
strings are not allowed in object names.

■ Verify that the code you think is being executed is actually being executed. Try adding a
trace and see if anything prints out.

Working with Rules
Question: When developing rules in Netbeans, why is design mode not available for a Rule
Library?
Answer: The design mode functionality is available from the explorer tree in Projects view. Use
the following steps:

1. Expand the library node and right-click a rule.
2. When the pop-up menu displays, select Properties and then click Body.
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Localization Scope
Historically, Identity Manager does not localize resource objects and functions, primarily
because they are mostly samples that get loaded (through init.xml) during initialization of
Identity Manager, and because the attributes of object types can vary between actual customer
deployments, depending on the level of customizations. Following is a list of areas where users
might encounter English: (ID-16349)

■ Default user forms and process mapping
■ Example: Edit User > Security > User Form pull-down menus
■ Example: Configure > Form and Process Mappings

Configuration object attribute names

Example: Configure > User Interface, concatenated names such as
displayPasswordExpirationWarning

■ Default tasks
■ Task templates

Example: Server Tasks > Configure Tasks > available task template names in table
■ Task type labels

Example: Server Tasks > Run Tasks > second column items from Available Tasks table
■ Task definitions

Example: Server Tasks > Find Tasks > second pull-down menu to select Task Definition

Default report names

Example: Report names found under Reports > Run Reports > Report Table
■ Default policy names

Example: Compliance > Manage Policies > audit policy names and descriptions
■ Default capability names

Example: Edit User > Security > Available Capabilities
■ Default report & graph names
■ Process/workflow diagram applets

Localization Scope
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Working with the Identity Manager Profiler
Identity Manager provides a Profiler utility to help you troubleshoot performance problems
with forms, Java, rules, workflows, and XPRESS in your deployment.

Forms, Java, rules, workflows, and XPRESS can all cause performance and scale problems. The
Profiler profiles how much time is spent in these different areas, enabling you to determine if
these forms, Java, rules, workflows, or XPRESS objects are contributing to performance and
scale problems and, if so, which parts of these objects are causing the problems.

This section explains how to use Identity Manager’s Profiler and provides a tutorial to help you
learn how to troubleshoot performance issues in your deployment.

The information is organized into the following topics:

■ “Overview” on page 121
■ “Getting Started” on page 125
■ “Using the Profiler” on page 126
■ “Tutorial: Troubleshooting Performance Problems” on page 135

Note – Identity Manager Profiler is only supported on version 7.1 Update 1 and later.

Overview
The section provides an overview of the Identity Manager’s Profiler’s features and functionality.
The information is organized as follows:

■ “Major Features” on page 121
■ “How the Profiler Locates and Manages Source” on page 122
■ “Statistics Caveats” on page 123

Major Features
You can use the Profiler utility to

■ Create “snapshots” of profiling data.
A snapshot is the cumulative result of profiling since the last time you reset all of your
collected profile results.

■ Display snapshot results in four, different data views:
■ Call Tree view provides a tree table showing the call timing and invocations counts

throughout the system.
■ Hotspots view provides a flattened list of nodes that shows the aggregate call timings

regardless of parent.
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■ Back Traces view provides an inverted call stack showing all the call chains from which
that node (known as the root node) was called.

■ Callees view provides an aggregate call tree of the root node, regardless of its parent
chain.

■ Specify what kinds of information to include in your snapshot:
■ You can include every element of form, workflow, and XPRESS or restrict the content to

a set of specific elements.
■ You can pick specific Java methods and constructors to include or exclude from the

instrumentation. Instrumentation of Identity Manager classes and custom classes is
supported.

■ Manage your project snapshots as follows.
■ Save the snapshot in your project’s nbproject/private/idm-profiler directory or to

an arbitrary location outside of your project.

Note – You can view a list of all saved snapshots in the Saved Snapshots section of the
IDM Profiler view.

■ Open snapshots from your project or load them from an arbitrary location outside your
project.

■ Delete snapshots.
■ Search for specific nodes, by name.

How the Profiler Locates and Manages Source
This section describes how the Profiler looks up and manages the source for the following
Identity Manager objects:

■ “For Forms, Rules, Workflows, and XPRESS Objects” on page 122
■ “For Java Source” on page 123

Tip – In Call Tree view or Hotspots view, you can double-click any node that corresponds to a
Java method, workflow, form, rule, or XPRESS to view the source for that node.

For Forms, Rules, Workflows, and XPRESS Objects

When you take a snapshot with the Profiler, the server evaluates all of the profiling data and
discovers on which sources the data depends. The server then fetches all of these sources from
the repository and includes them in the snapshot. Consequently, you can be sure that the
Identity Manager objects displayed in the snapshot are accurately reflecting the point at which
the snapshot was captured.
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This process adds to the size of the snapshot, but the source size is actually a relatively small
fraction of the total size. As a result, you can send a snapshot to Sun’s Customer Support
without having to send your source files separately.

For Java Source

When you take a snapshot of Java source, the client downloads the snapshot and then goes
through the snapshot to capture all referenced Java sources from the project. When you save the
snapshot, the client zips the sources and attaches them to the end of the snapshot.

Then, when you view the snapshot and go to the Java source, the client first checks the content
of the snapshot. If the client cannot find the content there, it checks the project’s content. This
process allows you to send a snapshot containing profiling data from both your custom Java
code and Identity Manager code.

Note – In a Java source snapshot, do not assume the source is up-to-date with the server or
always available.

Statistics Caveats
The following sections contain information to consider when you evaluate results provided by
the Profiler:

■ “Self Time Statistics” on page 123
■ “Constructor Calls” on page 124
■ “Daemon Threads” on page 124

Self Time Statistics

To compute a root node’s Self Time statistic, the Profiler subtracts the times of all children
nodes from the root node’s total time.

Consequently, an uninstrumented child node’s time is reflected in the root node’s self time. If a
root node has a significant self time, you should certainly investigate why. You might not have
the proper methods instrumented and so you are looking in the wrong place.

For example, assume method A calls method B.

Method A takes a total time of 10 seconds (where total time includes the call to B) and the call to
B takes a total time of 10 seconds.

If both A and B are instrumented, the call stack reflects that information. You will see that A has
a self-time of 0 seconds and that B has a self-time of 10 seconds (where 10 seconds was actually
spent in B). If, however, B is not instrumented, you only see that the call to A takes 10 seconds
and that A’s self-time is 10 seconds. Consequently, you might assume the problem lies directly
in A rather than in B.
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In particular, you might notice large self times on JSPs during their initial compile. If you reset
the collected results and then re-display the page, the self time value will be much less.

Constructor Calls

Because there are limitations in the Java instrumentation strategy, initial calls to this() or
super() will appear as a sibling to the constructor call, rather than as a child. See the following
example:

class A

{

public A()

{

this(0);

}

public A(int i)

{

}

}

and:

class B

{

public static void test()

{

new A();

}

}

The call tree will look like this:

B.test()

-A.<init>(int)

-A.<init>()

Rather than this:

B.test()

-A.<init>()

-A.<init>(int)

Daemon Threads

Do not be mislead by the seemingly large amount of time spent in a number of Identity
Manager’s daemon threads, such as ReconTask.WorkerThread.run() or
TaskThread.WorkerThread.run(). Most of this time is spent sleeping, while waiting for events.
You must explore these traces to see how much time is actually spent when they are processing
an event.
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Getting Started
This section describes how to start the Profiler and how to work with various features of the
Profiler’s graphical user interface. This information is organized as follows:

■ “Before You Begin” on page 125
■ “Starting the Profiler” on page 125
■ “Specifying the Profiler Options” on page 126

Before You Begin
Because the Profiler is very memory intensive, you should significantly increase the memory for
both your server and the Netbeans Java Virtual Machine (JVM).

To increase your server’s memory,

1. Open the Netbeans window and select the Runtime tab.
2. Expand the Servers node, right-click Bundled Tomcat, and select Properties from the menu.
3. When the Server Manager dialog displays, clear the Enable HTTP Monitor box on the

Connection tab.
4. Select the Platform tab, set VM Options to -Xmx1024M, and then click Close.

To increase the Netbeans JVM memory,

1. Open the netbeans-installation-dir \etc\netbeans.conff file and locate the following line:
netbeans_default_options="-J-Xms32m -J-Xmx ...

2. Change the -J-Xmx value to -J-Xmx 1024M.
3. Save, and then close the file.

When you are finished, you can start the Profiler as described in the next section.

Starting the Profiler
You can use any of the following methods to start the Profiler from the Identity Manager IDE
window:

■ Click the Start Identity Manager Profiler on Main Project icon located on the menu bar.

Note – The Start Identity Manager Profiler on Main Project icon is enabled when the main
Identity Manager project is version 7.1 Update 1 or later.

■ Select Window → IDM Profiler from the menu bar.
The Identity Manager Profiler window appears in the Explorer. From this window, select an
Identity Manager project from Current Project drop-down menu, and then click the Start
Identity Manager Profiler icon located in the Controls section.
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■ Right-click a project in the Projects window, and then select Start Identity Manager Profiler
from the pop-up menu.

■ Select a project in the Projects window, and then select IdM → Start Identity Manager
Profiler from the menu bar.

When you start the Profiler, the Profiler Options dialog displays so you can specify which
profiling options you want to use. Instructions for setting these options are provided in
“Specifying the Profiler Options” on page 126.

Using the Profiler
This section describes the features of the Profiler graphical user interface, and how to use these
features. The information is organized as follows:

■ “Specifying the Profiler Options” on page 126
■ “Working with the IDM Profiler View” on page 130
■ “Working with the Snapshot View” on page 132
■ “Using the Pop-Up Menu Options” on page 134
■ “Searching a Snapshot” on page 135
■ “Saving a Snapshot” on page 135

Specifying the Profiler Options
The Profiler Options dialog consists of the following tabs:

■ “Mode” on page 127
■ “IDM Object Filters” on page 127
■ “Java Filters” on page 128
■ “Miscellaneous” on page 130

Use the options on these tabs to indicate which objects to profile and which elements to display
in the profile.

After specifying the Profiler options, click OK to start the Profiler. Depending on your project
configuration, the Profiler does one of two things:

■ If you are using a regular Identity Manager project with an Embedded Identity Manager
Instance, the Profiler performs a full build, deploys into the NetBean’s application server,
and starts the Profiler.

■ If you are using a regular Identity Manager project with an External Identity Manager
Instance or the remote Identity Manager project, the Profiler attaches to the Identity
Manager instance configured for the project.
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Note – You can select IdM → Set Identity Manager Instance to control the Identity Manager
Instance action for the project.

Mode

The Mode tab provides the following options:

■ IDM Objects Only: Select to profile form, rule, workflow, and XPRESS objects. Excludes
Java objects from the profile.

■ Java and IDM Objects: Select to profile form, Java, rule, workflow, and XPRESS objects.

Note –

■ The Java and IDM Objects option is not available if you are using a regular Identity
Manager project with an external Identity Manager instance or using a remote Identity
Manager project.

■ You cannot change the Mode option while the Profiler is running. You must stop the
Profiler to change the option.

IDM Object Filters

The IDM Object Filters tab provides the following options:

■ Show IDM Object details
■ Select this box to include every executed form, workflow, and XPRESS element in the

snapshot.
■ Clear this box to include only the following elements in the snapshot:

■ <invoke>

■ <new>

■ <Rule>

■ <Form>

■ <WFProcess>

■ <ExScript>

■ <ExDefun>

■ <FieldRef>

■ <Action> (for workflow application callouts)
■ Include Anonymous Sources
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Note – Anonymous sources are forms (or portions of a form) that are generated on the fly
(such as Login forms and MissingFields forms) and do not correspond to a persistent form
that resides in the Identity Manager repository.

■ Select this box to include Anonymous sources in the snapshot.
■ Clear this box to exclude Anonymous sources from the snapshot.

Java Filters

Select the Java Filters tab to

■ Include or exclude Java filters
■ Create new filters
■ Delete existing filters
■ Restore the default filters

Java filters are given in terms of method patterns, and they are expressed in patterns that include
or exclude based on canonical method name. Where a canonical method name is:

fully-qualified-class-name.method-name(parameter-type-1, parameter-type-2, ...)

Note – For constructors, method-name is <init>.

Here are a few examples:

■ To exclude all constructors, enable the Exclude box and add the following filter:

*.<init>(*)

■ To exclude all constructors with a single org.w3c.dom.Element parameter, enable the
Exclude box and add the following filter:

*.<init>(org.w3c.dom.Element)

■ To exclude all Identity Manager classes, enable the Exclude box and add the following filters:

"com.waveset.*"
"com.sun.idm.*"

■ To instrument your custom code only, disable the Exclude box, remove the initial *
include filter, and then add the following filter:

"com.yourcompany.*"
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Note – The last two examples are currently equivalent because the filters are applied only to your
custom classes and Identity Manager classes.

If necessary, you can instrument other jars by modifying the following lines in build.xml as
appropriate. For example,

<instrument todir="${lighthouse-dir-profiler}/WEB-INF"
verbose="${instrumentor.verbose}" includeMethods="${profiler.includes}"
excludeMethods="${profiler.excludes}">

<fileset dir="${lighthouse-dir}/WEB-INF">
<include name="lib/idm*.jar"/>
<include name="classes/**/*.class"/>

</fileset>

</instrument>

By default, the configuration includes all your custom classes and most Identity Manager
classes. A number of Identity Manager classes are forcibly excluded— because enabling them
would break the Profiler.

For example, classes from the workflow, forms, and XPRESS engines are excluded or the
Profiler would produce an unintelligible snapshot when profiling Java and Identity Manager
objects.

Note that Java filters provide much more filtering granularity than IDM Object Filters. Java
instrumentation adds significant overhead to the execution time, which can drastically skew the
profiling results. Because Identity Manager objects are interpreted rather than compiled, the
instrumentation overhead is negligible. So for example, there is basically no reason to exclude
workflow A and include workflow B, and so forth.

Note – You cannot modify Java filters while the Profiler is running. You must stop the Profiler
before changing Java filters.
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Miscellaneous

The Miscellaneous tab provides the following options:

■ Prune snapshot nodes where execution time is 0:
■ Disable this option (default) if you want the snapshot to include invocation information

for all executed entities— even those whose execution time is zero.

It might be useful to have the number of invocations, even for nodes where there is no
execution time.

■ Enable this option to remove these nodes, which allows you to focus on the most
relevant profiling data. In addition, enabling this option can provide a large savings in
Profiler snapshot size.

■ Automatically Open Browser Upon Profiler Start:
■ Enable this option (default) when you launch the Profiler to automatically open a

browser that points to the Identity Manager instance being profiled.
■ Disable this option if you do not want to open a browser.

■ Include Java Sources in Snapshot:
■ Enable this option (default) to include Java sources for any Java methods referenced by

the profiling data in the Snapshot. You should always use this setting for snapshots in the
field. Custom Java is relatively small and it is very valuable to have for support.

■ Disable this option only if you are profiling Identity Manager and have the complete
Identity Manager source available.
In this situation, you do not want to include the Identity Manager source because it can
create extremely large snapshots. (See “How the Profiler Locates and Manages Source”
on page 122 for more information.)

Working with the IDM Profiler View
The IDM Profiler view consists of the following areas:

■ “Current Project Area” on page 130
■ “Controls Area” on page 131
■ “Status Area” on page 131
■ “Profiling Results Area” on page 131
■ “Saved Snapshots Area” on page 131

Current Project Area

The Current Project area consists of a drop-down menu that lists all of your current projects.
Use this menu to select the project you want to profile.
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Controls Area

The Controls area contains four icons, as described in the following table:

Icon Name Purpose

Start Identity Manager Profiler Starts the Profiler and opens the Profiler
Options dialog.

Stop Identity Manager Profiler Stops the Profiler.

Reset Collected Results Resets all of the profile results you
collected to this point.

Modify Profiling Reopens the Profiler Options dialog so
you can change any of the settings to
modify your current profile results.

Status Area

The Status area reports whether you are connected to the Host and provides Status information
as the Profiler is starting up, running, and stopping.

Profiling Results Area

The Profiling Results area contains two icons, which are described in the following table:

Icon Name Purpose

Start Identity Manager
Profiler

Starts the Profiler and opens the Profiler Options dialog.

Reset Collected Results Resets all of the profile results you collected to this point.

Saved Snapshots Area

The Saved Snapshots area provides a list of all saved snapshots.

Note – Instructions for saving snapshots are provided in “Saving a Snapshot” on page 135.

In addition, you can use the following buttons to manage these snapshots:

■ Open: Click to open saved snapshots in the Snapshot View window.
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Tip – You can also double-click a snapshot in the Saved Snapshots list to open that snapshot.

■ Delete: Select a snapshot in the Saved Snapshots list, and then click this button to delete the
selected snapshot.

■ Save As: Select a snapshot in the list and then click this button to save that snapshot
externally to an arbitrary location.

■ Load: Click to open a snapshot from an arbitrary location into the Snapshot View window.

Working with the Snapshot View
When you open a snapshot, the results display in the Snapshot View window, located on the
upper right side of Identity Manager IDE.

A snapshot provides several views of your data, which are described in the following sections:

■ “Call Tree View” on page 132
■ “Hotspots View” on page 133
■ “Back Traces View” on page 133
■ “Callees View” on page 133

Call Tree View

Call Tree view consists of a tree table showing the call timing and invocation counts throughout
your system.

This tree table contains three columns:

■ Call Tree column: Lists all nodes.

Top-level nodes are one of the following:
■ Thread.run() methods for various background threads in the system

For example, if you enabled Java profiling, you will see the
ReconTask.WorkerThread.run() method.

■ Request timings

For example, if you viewed the idm/login.jsp URL, you will see a top-level entry for
idm/login.jsp. The data displayed in the Time column for this entry represents the
total time for that request (or requests). The data displayed in the Invocations column
represents the total number of invocations to that page. You can then explore further
into that data to see what calls contributed to its time.
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Note – The Call Tree also contains Self Time nodes. Self Time values represent how much
time was spent in the node itself. (For more information, see “Statistics Caveats” on
page 123.)

■ Time column: Lists the time spent in each node when that node was called from its parent.
The percentages are given relative to parent time.

■ Invocations column: Lists how many times each node was invoked from its parent.

Hotspots View

Hotspots view provides a flattened list of nodes that shows aggregate call timings regardless of
parent.

This view contains the following columns:

■ Self Time: Lists the total amount of time spent in each node.
■ Invocations: Lists the total number of times each node was invoked from its parent.
■ Time: Lists the total amount of time spent in each node and in all of its children.

Back Traces View

Back Traces view provides an inverted call stack showing all the call chains from where each
node was called.

You can use these statistics to answer the question— How much time would I save if I
eliminated this particular call chain from this node?

You can access the Back Traces view from any of the other snapshot views by right-clicking a
node (known as the root node) and selecting Show Back Traces from the pop-up menu.

Note –

The Time and Invocations data values mean something different in Back Traces view:

■ Time: The values in this column represent the time spent in the root node when it is called
from a given call chain.

■ Invocations: The values in this column represent how many times the root node was
invoked from a given call chain.

Callees View

Callees view provides an aggregate call tree for a node (known as the root node), regardless of its
parent chain.
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These statistics are helpful if you have a problem area that is called from many places
throughout the master call tree and you want to see the overall profile for that node.

You can access the Callees view from any of the other snapshot views by right-clicking a node
(known as the root node) and selecting Show Callees from the pop-up menu.

Note – The Time and Invocations data values used in Callees view have the same meaning as
those used in Call Tree view.

Using the Pop-Up Menu Options
Right-click any node in Call Tree view or in Hotspots view and a pop-up menu displays with the
options described the following table:

Menu Options Description

GoTo Source Select this option to view the XML source for a node that corresponds
to a Java method, workflow, form, rule, or XPRESS. For detailed
information about this view, see “How the Profiler Locates and
Manages Source” on page 122.

Show Back Traces Select this option to access the Back Traces view. For detailed
information about this view, see “Back Traces View” on page 133.

Show Callees Select this option to access the Callees view. For detailed information
about this view, see “Callees View” on page 133.

Find In Hotspots Select this option to find a node in the Hotspots view. For detailed
information about this view, see “Hotspots View” on page 133.

List Options → Sort → Select this option to
■ None
■ Call Tree
■ Time
■ Invocations
■ Ascending
■ Descending

List Options → Change Visible
Columns

Select this option to change the columns displayed in the Call Tree or
Hotspots list.

When the Change Visible Columns dialog displays, you can select one
or more of the following options:
■ Call Tree: Call Tree
■ Invocations: Invocations
■ Time: Time

Working with the Identity Manager Profiler

Sun Identity Manager 8.1 Release Notes •134



Searching a Snapshot
Use the Search icon , located at the top of the Snapshot View window to search for nodes by
name the Call Tree view or Hotspots tree.

Alternatively, right-click any node in Call Tree view or Hotspots view and select Find in Call
Tree or Find in Hotspots (respectively) from the pop-up menu to search for a node.

Saving a Snapshot
The Profiler provides several options for saving a snapshot. See the following table for a
description of these options:

Icon Name Purpose

Save the Snapshot in the Project icon
(located at the top of the Snapshot View
window)

Saves the snapshot in the nbproject/private/idm-profiler directory of
your project. Snapshots saved in your project are listed in the Saved
Snapshots section of the Profiler view.

Save the Snapshot Externally icon
(located at the top of the Snapshot View
window)

Saves a snapshot to an external, arbitrary location.

Save As button (located in the Saved
Snapshots area)

Saves a snapshot to an external, arbitrary location.

Tutorial: Troubleshooting Performance Problems
Identity Manager provides a tutorial (profiler-tutorial.zip) to help you learn how to use
the Profiler to troubleshoot forms, Java rules, workflows, and XPRESS.

Use the following steps to complete the tutorial.

▼ Step 1: Create an Identity Manager Project

Select File → New Project.

When the New Project wizard displays, specify the following, and then click Next:

a. In the Categories list, select Web to indicate what type of project you are creating.

b. In the Projects list, select Identity Manager Project.

1
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Note – You must create a regular Identity Manager project for a fully featured development
environment. Do not select the Identity Manager Project (Remote) option.

Complete the following fields on the Name and Location panel, and then click Next:

■ Project Name: Enter Idm80 as the project name.
■ Project Location: Use the default location or specify a different location.
■ Project Folder: Use the default folder or specify a different folder.

When the Identity Manager WAR File Location panel displays, enter the location of the Identity
Manager 8.1 warfile. Typically, unzipping this file creates an idm.warfile in the same directory.

Click Next to continue to the Repository Setup panel.
You should not have to change the default settings on this panel, just click Finish. When you see
the BUILD SUCCESSFUL message in the Identity Manager IDE Output window, you can extract
the Profiler tutorial files. See “Step 2: Unzip the Profiler Tutorial” on page 136 for instructions.

▼ Step 2: Unzip the Profiler Tutorial

Unzip profiler-tutorial.zip in the project root. The extracted files include:
<project root>/custom/WEB-INF/config/ProfilerTutorial1.xml
<project root>/custom/WEB-INF/config/ProfilerTutorial2.xml
<project root>/src/org/example/ProfilerTutorialExample.java
<project root>/PROFILER_TUTORIAL_README.txt

Start the Profiler. Proceed to “Step 3: Start the Profiler”on page 136.

▼ Step 3: Start the Profiler

Use the instructions provided in “Before You Begin”on page 125 to increase the memory for
your server and Netbeans JVM.

Use any of the methods described in “Overview”on page 121 to start the Profiler.

When the Profiler Options dialog displays, you can specify profiling options.

Continue to “Step 4: Set the Profiler Options”on page 137

Note – For detailed information about all of the different Profiler options, see “Specifying the
Profiler Options” on page 126.
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▼ Step 4: Set the Profiler Options
For the purposes of this tutorial, specify the following Profiler options:

On the Mode tab, select Java and IDM Objects to profile form, Java, rule, workflow, and XPRESS
objects.

Select the Java Filters tab.

Use the following steps to disable all Identity Manager Java classes except your custom Java
classes (in this case, org.example.ProfilerTutorialExample):

a. Click New and a new, blank field appears at the bottom of the Filter column.

b. Enter com.waveset.* into the new field, and then select the Exclude box.

c. Click New again.

d. Enter com.sun.idm.* into the new field, and then select the Exclude box.

Click OK to run the Profiler.

Note – The Profiler takes a few minutes to complete the first time you run it on a project or if you
have recently performed a Clean Project action.

When the Profiler finishes processing, you are prompted to Log In.

Enter the password configurator, select the Remember Password box, and then click OK to
continue.

When the Identity Manager window displays, log in.

Note – Typically, you should log in to Identity Manager as a different user instead of logging in as
configurator again. You are already logged into the Profiler as configurator, and the Identity
Manager session pool only allows one entry per user. Using multiple entries can result in the
appearance of a broken session pool and might skew your profiling results for finer-grained
performance problems.

However, for this simple example the session pool is of no consequence so you can login as
configurator/configurator.

In Identity Manager, select Server Tasks → Run Tasks, and then click ProfilerTutorialWorkflow1.

The tutorial might take a few moments to respond.
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Although you could take a snapshot now; you are going to reset your results instead, run the
Profiler, run it again, and then take a snapshot.

Note – It is a best practice to run the Profiler a couple of times before taking a snapshot to be sure
all the caches are primed, all the JSPs are compiled, and so forth.

Running the Profiler several times enables you to focus on actual performance problems. The
only exception to this practice is if you are having a problem populating the caches themselves.

a. Return to the IDM Profiler view in the Identity Manager IDE. Click the Reset Collected Results
icon in the Profiling Results section (or in the Controls section) to reset all of the results
collected so far.

b. In Identity Manager, select Server Tasks → Run Tasks again, and click
ProfilerTutorialWorkflow1.

c. When the Process Diagram displays, return to the Identity Manager IDE and click Take
Snapshot in the Profiling Results section.

The Identity Manager IDE downloads your snapshot and displays the results on the right side of
the window.

This area is the Call Tree view. At the top of the Call Tree, you should see a
/idm/task/taskLaunch.jsp with a time listed in the Time column. The time should indicate
that the entire request took six+ seconds.

Expand the /idm/task/taskLaunch.jsp node, and you can see that ProfilerTutorialWorkflow1
took six seconds.

Expand the ProfilerTutorialWorkflow1 node. Note that activity2 took four seconds and
activity1 took two seconds.

Expand activity2.

Note that action1 took two seconds and action2 took two seconds.

Expand action1 and note that the <invoke> also took two seconds.

Double-click the <invoke> to open ProfilerTutorialWorkflow1.xml and highlight the
following line:
<invoke name=’example’ class=’org.example.ProfilerTutorialExample’/>

You should see that a call to the ProfilerTutorialExample method took two seconds.
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Note – You are actually browsing XML source that was captured in the snapshot, rather than
source in the project. Snapshots are completely self-contained. (For more information, see
“How the Profiler Locates and Manages Source” on page 122.)

Select the CPU:<date><time> tab to return to your snapshot.

Expand the <invoke>node, and note that the Profiler spent two seconds in the Java
ProfilerTutorialExample.example() method.

Double-click the method name to open the ProfilerTutorialExample.java source and
highlight the following line:
Thread.sleep(2000);

There’s the problem! This method contains a two-second thread sleep.

If you return to the Call Tree, you can see that all of the two second paths lead to this method.
(You should see three paths; for a total of six seconds.)

Select the Hotspots tab (located at the bottom of the Call Tree area) to open the Hotspots view.
Notice that ProfilerTutorialExample.example() has a total self time of six seconds.
(For more information about Hotspots, see “Working with the Snapshot View” on page 132.)

Right-click ProfilerTutorialExample.example() and select Show Back Traces from the
pop-up menu.
A new Back Traces tab displays at the bottom of the area.

Expand the ProfilerTutorialExample.example() node on the Back Traces tab to see that this
method was called from three places, and that the method took two seconds when it was called
from each place.
(For more information about Back Traces, see “Working with the Snapshot View” on
page 132.)

Click the Save the snapshot in the project icon to save your snapshot and close it.
If you check the Saved Snapshots section on the IDM Profiler tab, you should see your snapshot.
(You might have to scroll down.)

Select the saved snapshot, and then click Open to re-open it.

Note – You can use the Save As button to save your snapshots externally and use the Load button
to load a snapshot from outside your project.

Close the snapshot again.
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▼ Step 5: Profile a ManualAction Workflow
The next part of this tutorial illustrates how to profile a workflow ManualAction.

In Identity Manager, select Server Tasks → Run Tasks, and then click ProfilerTutorialWorkflow2.
After a few moments, an empty form displays.

Click Save and the process diagram displays.

Select Server Tasks → Run Tasks again.

Return to the Identity Manager IDE IDM Profiler view and click the Reset Collected Results icon
in the Profiling Results section.

Now click ProfilerTutorialWorkflow2 in Identity Manager.

When the blank form displays again, click Save.

In the IDM Profiler view, click Take Snapshot.
After a few seconds, a snapshot should display in the Call Tree area. You should see that
/idm/task/workItemEdit.jsp took six+seconds. (This result corresponds to the manual
action in the workflow.)

Expand the /idm/task/workItemEdit.jsp node and note that running all Derivations in the
ManualAction form took a total of six seconds.

Expand the Derivation, displayNameForm, variables.dummy, and <block>nodes.
You should see that the <block> took six seconds and, of that time, the Profiler spent two
seconds in each of the three invokes to the ProfilerTutorialExample.example(). method.

You can double-click <block> to view the source.

Online Help
This section contains documentation corrections for online help.

■ The “Configure Reports” help page contains the following sentence, which should be
disregarded:
Fonts should also be added to the JVM in order for graphs to display properly.
The sentence is incorrect. Adding fonts to the JVM is not necessary in order to properly
render text in the PDF report.
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